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Legal disclaimer

Alibaba Cloud reminds you to carefully read and fully understand the terms and conditions of this legal
disclaimer before you read or use this document. If you have read or used this document, it shall be deemed
as your total acceptance of this legal disclaimer.

1.

You shall download and obt ain this document from the Alibaba Cloud website or other Alibaba Cloud-
aut horized channels, and use this document for your own legal business activities only. The content of
this document is considered confidential information of Alibaba Cloud. You shall strictly abide by the
confidentiality obligations. No part of this document shall be disclosed or provided to any third party for
use wit hout the prior written consent of Alibaba Cloud.

. No part of this document shall be excerpted, translated, reproduced, transmitted, or disseminated by

any organization, company or individual in any form or by any means without the prior written consent of
Alibaba Cloud.

. The content of this document may be changed because of product version upgrade, adjustment, or

other reasons. Alibaba Cloud reserves the right to modify the content of this document without notice
and an updated version of this document will be released through Alibaba Cloud-aut horized channels
from time to time. You should pay attention to the version changes of this document as they occur and
download and obt ain the most up-to-date version of this document from Alibaba Cloud-aut horized
channels.

. This document serves only as a reference guide for your use of Alibaba Cloud products and services.

Alibaba Cloud provides this document based onthe "status quo", "being defective", and "existing
functions" of its products and services. Alibaba Cloud makes every effort to provide relevant operational
guidance based on existing technologies. However, Alibaba Cloud hereby makes a clear statement that
it in no way guarantees the accuracy, integrity, applicability, and reliability of the content of this
document, either explicitly or implicitly. Alibaba Cloud shall not take legal responsibility for any errors or
lost profits incurred by any organization, company, or individual arising from download, use, or trust in
this document. Alibaba Cloud shall not, under any circumstances, take responsibility for any indirect,
consequential, punitive, contingent, special, or punitive damages, including lost profits arising from t he
use or trust inthis document (evenif Alibaba Cloud has been notified of the possibility of such a loss).

. By law, allthe contents in Alibaba Cloud documents, including but not limited to pictures, architecture

design, page layout, and text description, are intellectual property of Alibaba Cloud and/or its
affiliates. This intellect ual property includes, but is not limited to, trademark rights, patent rights,
copyrights, and trade secrets. No part of this document shall be used, modified, reproduced, publicly
transmitted, changed, disseminated, distributed, or published wit hout the prior written consent of
Alibaba Cloud and/or its affiliates. The names owned by Alibaba Cloud shall not be used, published, or
reproduced for marketing, advertising, promotion, or ot her purposes wit hout the prior written consent of
Alibaba Cloud. The names owned by Alibaba Cloud include, but are not limited to, "Alibaba Cloud",
"Aliyun", "HiChina", and other brands of Alibaba Cloud and/or its affiliates, which appear separately or in
combination, as well as the auxiliary signs and patterns of the preceding brands, or anyt hing similar to
the company names, trade names, trademarks, product or service names, domain names, patterns,
logos, marks, signs, or special descriptions that third parties identify as Alibaba Cloud and/or its
affiliates.

. Please directly contact Alibaba Cloud for any errors of this document.
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Document conventions

Style

/\ Danger

warning

) Notice

@ Note

Bold

Courier font

Italic

(1 or [alb]

{} or {a|b}

Description

A danger notice indicates a situation that
will cause major system changes, faults,
physical injuries, and other adverse
results.

A warning notice indicates a situation
that may cause major system changes,
faults, physical injuries, and other adverse
results.

A caution notice indicates warning
information, supplementary instructions,
and other content that the user must
understand.

A note indicates supplemental
instructions, best practices, tips, and
other content.

Closing angle brackets are used to
indicate a multi-level menu cascade.

Bold formatting is used for buttons ,
menus, page names, and other Ul
elements.

Courier font is used for commands

ltalic formatting is used for parameters
and variables.

This format is used for an optional value,
where only one item can be selected.

This format is used for a required value,
where only one item can be selected.

Example

& Danger:

Resetting will result in the loss of user
configuration data.

warning:

Restarting will cause business
interruption. About 10 minutes are
required to restart an instance.

p Notice:

If the weight is set to 0, the server no
longer receives new requests.

@ Note:

You can use Ctrl + A to select all files.

Click Settings> Network> Set network
type.

Click OK.

Runthe cd /d C:/window command to
enter the Windows system folder.

bae log list --instanceid

Instance_ID

ipconfig [-all|-t]

switch {active|stand}
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1.Device access

1.1. Access loT Platform by using
Paho

1.1.1. Use the Paho MQTT C client

This article describes how to use the open source Paho MQTT project for embedded Cto connect and
communicate with loT Platform.
Prerequisites

A product and a device are created inthe loT Platform console.The device certificate information
including ProductKey, DeviceName, and DeviceSecret is obtained. For more information, see the
following articles:

e View the endpoint of aninstance,
e (reate a product

e (Create a device

Prepare the development environment

In this example, Ubuntu 16.04-LTS is used to build the development environment. Run the following
commands to build the development environment:

sudo apt-get update
sudo apt-get install build-essential git sed cmake

Download the Paho MQTT library for C

Run the following command to clone the Paho MQTT library for C:

git clone https://github.com/eclipse/paho.mgtt.embedded-c.git

@ Note The master branch is used to develop the sample code in this article. The commit ID is
29ab2aa29c5e47794284376d7£8386cfd54c3eed .

The Paho MQTT project for embedded Cincludes three sub-projects:

e MQTTPacket: provides serialization and deserialization of MQTT data packets and some helper
functions.

e MQTTClient: encapsulates the high-level C++ client program generated by MQT T Packet.
e MQTTClient-C: encapsulates the high-level C client program generated by MQOT TPacket.

The MQTT Client-C project includes the following directories and files:
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o The samples directory provides sample code for FreeRTOS and Linux systems.

o The srcdirectory provides the code for MQT T Client and network drivers for porting to FreeRTOS,
CC3200, and Linux.

For more information about the Paho MQTT API, see MOT T Client.h.

Connect the client to IoT Platform

1. Clickaiot_maqgtt_sign.c and copy the source code that is provided by Alibaba Cloud to obtain the
MQTT connection parameters. Then, create the aiot_mgqtt_sign.cfile on premises and paste the
code to the file.

The aiot_maqtt_signal.cfile defines the aiotMqttSign() function.

o Syntax

int aiotMgttSign (const char *productKey, const char *deviceName, const char *deviceSe
cret,

char clientId[150], char username[65], char password[65]);

o Description

This class is used to obtain the following MQTT connection parameters: username, password,
and clientid.

o Input parameters
Parameter Type Description

The ProductKey of the product to which the device

productKey const char * belongs. This parameter is used to identify the device in
loT Platform.
deviceName const char * The DeviceName of the device. This parameter is used to

identify the device in IoT Platform.

The DeviceSecret of the device. This parameter is used to

deviceSecret const char * . . -
identify the device in IoT Platform.

o Output parameters
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Parameter Type Description

The username that is used to establish the MQTT

username char * )

connection.

. The password that is used to establish the MQTT

password char .

connection.
clientld char * The ID of the MQTT client.

o Response codes

Response code Description
0 The function is implemented.
-1 The function failed to be implemented.

2. Add a programfile that can connect a device to IoT Platform.

You must write a programto call the aiotMqgttSign() function in the aiot_maqtt_sign.cfile to obtain
the parameters that are used to establish an MQTT connection with IoT Platform.

This section provides the development instructions and sample code.

o Callthe aiotMqttSign() function to obtain the clientld, username, and password parameters.

#define EXAMPLE PRODUCT KEY "allxsSIWr***"
#define EXAMPLE DEVICE NAME "paho ****"
#define EXAMPLE DEVICE SECRET "Y877Bgo8X50wd31cB5wIiD ryNPOB* * ** !

extern int aiotMgttSign (const char *productKey, const char *deviceName, const char *d

eviceSecret,
char clientId[150], char username[65], char password[65]);

/* invoke aiotMgttSign to generate mgtt connect parameters */

char clientId[150] = {0};
char username[65] = {0};
char password[65] = {0};

if ((rc = aiotMgttSign (EXAMPLE PRODUCT KEY, EXAMPLE DEVICE NAME, EXAMPLE DEVICE SECRE
T, clientId, username, password) < 0)) {
printf ("aiotMgttSign -%0x4x\n", -rc);
return -1;
}
printf ("clientid: %s\n", clientId);
printf ("username: %$s\n", username) ;

printf ("password: %s\n", password) ;
o Connect the client to IoT Platform.
Performthe following operations:
m Call the Networkinit() and NetworkConnect() functions to establish a TCP connection.

m Call the MQTTClientInit() function to initialize the MQTT client.

m Configure the MQTTPacket_connectData structure that contains the MQTT connection
parameters.
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Sample code:

/* network init and establish network to aliyun IoT platform */
NetworkInit (&n) ;

rc = NetworkConnect (&n, host, port);

printf ("NetworkConnect %d\n", rc);

/* init mgtt client */

MQOTTClientInit (&c, &n, 1000, buf, sizeof (buf), readbuf, sizeof (readbuf));
/* set the default message handler */

c.defaultMessageHandler = messageArrived;

/* set mgtt connect parameter */

MQTTPacket connectData data = MQTTPacket connectData initializer;
data.willFlag = O;

data.MQTTVersion = 3;

data.clientID.cstring = clientId;

data.username.cstring = username;

data.password.cstring = password;

data.keepAliveInterval = 60;

data.cleansession = 1;

printf ("Connecting to %s %d\n", host, port);

rc = MQTTConnect (&c, &data);

printf ("MQTTConnect %d, Connect aliyun IoT Cloud Success!\n", rc);

o Publish messages.

Call the MQTTPublish() function to publish messages in the custom format to the specified
customtopic.

For more information about topics, see what is a topic?.

char *pubTopic = "/"EXAMPLE PRODUCT KEY"/"EXAMPLE DEVICE NAME"/user/update";
int cnt = 0;
unsigned int msgid = 0;
while (!toStop)
{
MQTTYield (&c, 1000);
if (++cnt % 5 == 0) {
MQTTMessage msg = {
Q0S1,
0,
0,
0,
"Hello world",
strlen("Hello world"),
bi
msg.id = ++msgid;
rc = MQTTPublish(&c, pubTopic, &msg);
printf ("MQTTPublish %d, msgid %d\n", rc, msgid);

o Subscribe to atopic to receive messages fromloT Platform.
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void messageArrived (MessageData* md)

{
MQOTTMessage* message = md->message;
printf ("%.*s\t", md->topicName->lenstring.len, md->topicName->lenstring.data) ;
printf ("$.*s\n", (int)message->payloadlen, (char*)message->payload);

}
char *subTopic = "/"EXAMPLE PRODUCT KEY"/"EXAMPLE DEVICE NAME"/user/get";

printf ("Subscribing to %s\n", subTopic);
rc = MQTTSubscribe (&c, subTopic, 1, messageArrived);
printf ("MQTTSubscribe %d\n", rc);

For more information about the communication methods of devices, servers, and IoT Platform, see
Overview.

3. Copythe aiot_maqtt_signal.cfile and the file that is edited in Step 2 to ../paho.mqgtt.embedded-c/
MQTT Client -C/samples/linux and then compile the project.

Sample code
You can use the sample code to connect with IoT Platform.

1. Download the demo package and decompress it.

The following files are obtained:
File Description

This file contains the code that is used to obtain the MQTT connection
aiot_maqtt_sign.c parameters. When you run the aiot ¢ demo.cfile, the aiotMqttSign() function
is called to obtain the username, password, and clientld parameters.

This file contains the logic code that is used to connect and communicate

aiot_c_demo.c .
- with loT Platform.

2. Inthe aiot_c_demo.cfile, replace the device information with your device information.

o Replace the values of the EXAMPLE_PRODUCT _KEY, EXAMPLE_DEVICE_NAME, and
EXAMPLE_DEVICE_SECRET parameters with your device certificate information.

#define EXAMPLE PRODUCT KEY "The ProductKey of the product”
#define EXAMPLE DEVICE NAME "The DeviceName of the device"
#define EXAMPLE DEVICE SECRET "The DeviceSecret of the device"

o Modify the endpoint in  char *host = EXAMPLE PRODUCT KEY".iot-as-mgtt.cn-shanghai.aliyunc

s.com"

Replace cn-shanghaiin the code with the ID of the region where your device resides. For more
information about region IDs, see Regions and zones.

3. Move the aiot_maqtt_signal.c and aiot_c_demo.cfiles to the ../paho.mqtt.embedded-c/MQTT Client
-C/samples/linux directory of the Paho project.

4. Compile the project and run the program.
You can compile the project by using one of the following methods:

o Use the CMake tool.
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a. Add aiot_c demo.c and aiot_maqtt_signal.cto the CMakelLists.txt file in the /paho.mqgtt.emb
edded-c/MQT T Client-C/samples/linux directory.

The following code shows how to modify the CMakeLists.txt file.

add executable (
stdoutsubc
stdoutsub.c
)
add executable (
aiot c demo
aiot ¢ demo.c
alot mgtt sign.c
)
target link libraries (stdoutsubc paho-embed-mgtt3cc paho-embed-mgtt3c)

target include directories(stdoutsubc PRIVATE "../../src" "../../src/linux")
target compile definitions (stdoutsubc PRIVATE MQTTCLIENT PLATFORM HEADER=MQTTLinu
x.h)

target link libraries(aiot c demo paho-embed-mgtt3cc paho-embed-mgtt3c)
target include directories(aiot c demo PRIVATE "../../src" "../../src/linux")
target compile definitions(aiot ¢ demo PRIVATE MQTTCLIENT PLATFORM HEADER=MQTTLin

ux.h)

b. Go backto the /paho.mgtt.embedded-c directory and run the following command to
compile the project.

mkdir build.paho
cd build.paho
cmake ..

make

c. Goto the /paho.mqtt.embedded-c/build.paho directory and run the following command to
run the program:

./MQTTClient-C/samples/linux/aiot c demo

o Use the build.sh file.

a. Openthe build.shfile inthe /paho.mqtt.embedded-c/MQTT Client -C/samples/linux
directory.

b. Inthe build.shfile, replace stdoutsub.c Wwith aiot mgtt sign.c aiot c demo.c ,and -
o stdoutsub With -o aiot c demo .Then, save the buid.shfile.

c. Go to the /paho.mqtt.embedded-c/MQTT Client-C/samples/linux directory runthe . /build
.sh command.

Afterthe compilation, the aiot ¢ demo executable file is generated.
d. Runthe ./aiot c demo command to runthe file.

Afteryou runthe file, the following local logs are generated:
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clientid: paho mgtté&allxsrW****|timestamp=2524608000000, v=sdk-c-1.0.0,securemode=3,sig
nmethod=hmacsha256, lan=C|

username: paho mgtt&allxsrW****

password: 36E955DC3DID012EF62C80657A29328B1CFAE6186C611A17DCT7939FABG37****
NetworkConnect 0

Connecting to allxsrW**** iot-as-mgtt.cn-shanghai.aliyuncs.com 443

MQTTConnect 0, Connect aliyun IoT Cloud Success!

Subscribing to /allxsrW****/paho mgtt/user/get

MQTTSubscribe 0

MQTTPublish 0, msgid 1

MQTTPublish
MQTTPublish
MQTTPublish
MQTTPublish

, msgid 2
, msgid 3
, msgid 4
, msgid 5

Log onto the loT Platform console.View device status and logs.
o Choose Devices > Devices. You can find that the status of the device is Online.

o Choose Maintenance > Device Log. Then, clickthe Cloud run log orDevice local log tabto
view logs. For more information, see loT Platform logs and Local device logs.
Error codes

If a device fails to establish an MQTT connection to loT Platform, you can troubleshoot the issue based
onthe error code. For more information, see Troubleshooting.

1.1.2. Use the Paho MQTT Java client

This article describes how to use the Paho Message Queuing Telemetry Transport (MQTT) library for Java
to connect to loT Platform and exchange messages with IoT Platform.
Prerequisites

A product and a device are created inthe IoT Platform console. The LightSwitch property is defined on
the Define Feature tab of the Product Details page.

For more information, see Create a product, Create a device, and Add a TSL feature.

Prepare the development environment
In this example, the development environment consists of the following components:

e QOperating system: macQOS
e Java Development Kit (JDK): JDK 8
e Integrated development environment (IDE): Intelli] IDEA Community Edition

Download the Paho MQTT library for Java
Add dependencies to the Maven project based on the version of the MQTT protocol.

e MQTT 3.1and 3.1.1
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<dependencies>
<dependency>
<groupld>org.eclipse.paho</groupId>
<artifactId>org.eclipse.paho.client.mgttv3</artifactId>
<version>1.2.0</version>
</dependency>

</dependencies>

e MQTT 5.0

<dependency>
<groupld>org.eclipse.paho</groupId>
<artifactId>org.eclipse.paho.mgttv5.client</artifactId>
<version>1.2.5</version>

</dependency>

Connect to IoT Platform

1. Click MgttSign.java to obtain the source code provided by Alibaba Cloud to calculate the MQTT
connection parameters.

The MgttSign.javafile defines the MqttSign class.
o Prototype
class MgttSign

o Description

This class is used to obtain the following MQTT connection parameters: username, password,

and clientid.
o Members
Type Method
calculate (String productKey, String deviceName, String device
Secret)
public void You can call this method to calculate the username, password, and clientid
parameters based on the productKey, deviceName, and deviceSecret of
the device.
getUsername ()
public String You can call this method to obtain the MQTT connection parameter
username.
getPassword ()
public String You can call this method to obtain the MQTT connection parameter
password.
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Type Method
getClientid ()
public String You can call this method to obtain the MQTT connection parameter
clientid.

2. Openintellij IDEA and create a project.
3. Import the MgttSign.javafile into the project.
4. Inthe project, add a programfile that can connect a device to IoT Platform.

You must write a programto use the MqttSign class in the MgttSign.javafile to calculate the
parameters that are used to establish an MQTT connectionto loT Platform.

This section provides the development instructions and sample code.

o Use the MqttSign class to calculate the MQTT connection parameters.

String productKey = "alX2bEn****";
String deviceName = "examplel";
String deviceSecret = "ga7XA6KdlEeiPXQPpRLAJOZXWG8y****";
// Calculate the MQTT connection parameters.
MgttSign sign = new MgttSign();

sign.calculate (productKey, deviceName, deviceSecret)

System.out.println ("username: " + sign.getUsername());
System.out.println ("password: " + sign.getPassword());
System.out.println ("clientid: " + sign.getClientid()):;

o Create a Paho MQTT client to connect to loT Platform.

// Specify the domain name for connecting to IoT Platform.

String port = "443";

String broker = "ssl://" + productKey + ".iot-as-mgtt.cn-shanghai.aliyuncs.com" + ":"
+ port;

// Create a Paho MQTT client.

MgttClient sampleClient = new MgttClient (broker, sign.getClientid(), persistence) ;
// Set the MQTT connection parameters.

MgttConnectOptions connOpts = new MgttConnectOptions();
connOpts.setCleanSession (true) ;

connOpts.setKeepAliveInterval (180) ;

connOpts.setUserName (sign.getUsername ()) ;

connOpts.setPassword (sign.getPassword () .toCharArray()) ;

sampleClient.connect (connOpts) ;

System.out.println ("Broker: " + broker + " Connected");

@ Note

o Publish messages.

The following sample code is used to report the LightSwitch property of a TSL model.
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// Publish messages by using Paho MQTT.

String topic = "/sys/" + productKey + "/" + deviceName + "/thing/event/property/post"
String content = "{\"id\":\"1\",\"version\":\"1.0\", \"params\": {\"LightSwitch\":1}}";
MgttMessage message = new MgttMessage (content.getBytes());

message.setQos (0) ;

sampleClient.publish (topic, message);

If you use MQTT 5.0, you can add the following sample code to publish messages that contain
custom properties.

// MQTT 5.0 new feature: Report custom properties.

MgttProperties properties = new MgttProperties();

List<UserProperty> userPropertys = new ArrayList<>();

userPropertys.add (new UserProperty("keyl","valuel"));
properties.setUserProperties (userPropertys) ;

// MQTT 5.0 new feature: Set the request and response mode.
properties.setCorrelationData ("requestIdl2345".getBytes());
properties.setResponseTopic ("/" + productKey + "/" + deviceName + "/user/get");
message.setProperties (properties) ;

// By default, Paho SDK that supports MQTT 5.0 uses topic aliases.

sampleClient.publish (topic, message);
For more information about the TSL data format, see Device properties, events, and services.
For more information about how to use customtopics for communication, see what is a topic?

o Subscribe to atopic to obtain messages fromloT Platform.

In this example, you subscribe to the topic to which IoT Platform returns response messages
after the property values are reported.

class MgttPostPropertyMessagelistener implements IMgttMessagelistener {
@Override
public void messageArrived(String varl, MgttMessage var2) throws Exception ({
System.out.println ("reply topic : " + varl);
System.out.println ("reply payload: " + var2.toString()):;

// Subscribe to a message topic by using Paho MQTT.

String topicReply = "/sys/" + productKey + "/" + deviceName + "/thing/event/property/
post reply";

sampleClient.subscribe (topicReply, new MgttPostPropertyMessagelistener()) ;

For more information about the communication methods of devices, servers, and IoT Platform, see
Overview.

5. Compile the project.

Demo
The demo code demonstrates how to connect a device to loT Platform.

1. Download the demo package and decompress it.

2. Open Intellij IDEA and import the sample project aiot-java-demo in the demo package.
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3. Inthe src/main/java/com.aliyun.iot directory, replace the device information with your device
information in the App or Mgtt5Appfile.

@ Note If you use MQTT 3.1 or 3.1.1, replace the device information in the Appfile. If you
use MQTT 5.0, replace the device information in the Mgtt5App file.

o Replace the values of the productKey, deviceName, and deviceSecret parameters with your
device certificate information.

String productKey = "${ProductKey}";
String deviceName = "${DeviceName}";

String deviceSecret = "${DeviceSecret}";

o Modifythe domain name in  string broker = "ssl://" + productKey + ".iot-as-mgtt.cn-shan
ghai.aliyuncs.com" + ":" + port; .Formore information, see Step 4 inthe "Connect to loT

Platform" section.

4. Runthe App or Mgtt5App program.
The following figure shows the success logs.

Log onto the loT Platform console.View device status and logs.
o Choose Devices > Devices. You can find that the status of the device is Online.

o Choose Maintenance > Device Log to view logs onthe Cloud run log and Device local log
tabs. For more information, see 0T Platform logs and Local device logs.

If the Mgtt5App programis run, you can view the reported custom properties in the log details.

1.1.3. Use the Paho MQTT Go client

This article describes how to use the Paho MQTT library for Go to connect to and communicate with loT
Platform.

Prerequisites

A product and a device are created inthe loT Platform console. The device certificate is obtained. The
certificate information includes the ProductKey, DeviceName, and DeviceSecret. For more information,

see the following topics:

e View the endpoint of aninstance.
e (reate a product

e (Create a device

Prepare the development environment

Install the Go language package.
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e On macOSs, run the following command:

brew install go

e On Ubuntu, run the following command:

sudo apt-get install golang-go

e On Windows, download the installation package fromthe Go official website and install the Go
language package.

@ Note If you are in the Chinese mainland, you must use a virtual private network (VPN) to
access the Go official website.

Download the Paho MQTT library for Go

For more information about the Paho project and supported programming languages, see Eclipse Paho
Downloads.

Run the following commands to download the Paho MQTT library for Go and the related
dependencies:

go get github.com/eclipse/paho.mgtt.golang
go get github.com/gorilla/websocket
go get golang.org/x/net/proxy

Connect the client to 10T Platform

1. Click MgttSign.go and copy the source code that is provided by Alibaba Cloud to obtainthe MQTT
connection parameters. Then, create the MgttSign.go file on premises and paste the code to the
file.

The MgttSign.go file defines the function to obtain the MQTT connection parameters. You must
call this function to connect your client with lIoT Platform.

o Definition:

type AuthInfo struct ({
password, username, mgttClientId string;
}
func calculate sign(clientId, productKey, deviceName, deviceSecret, timeStamp string)
AuthInfo;

o Description:

This function is used to obtain the following MQTT connection parameters: username, password,
and mgttClientid.

o Input parameters:
Parameter Type Description
The ProductKey of the product to which the device

productKey String belongs. This parameter is used to identify the device in
IoT Platform.
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Parameter Type Description

The DeviceName of the device. This parameter is used to

deviceName Strin
9 identify the device in IoT Platform.

The DeviceSecret of the device. This parameter is used to

deviceSecret Strin
v ng identify the device in IoT Platform.

The ID of the device. The ID can contain up to 64 characters
clientld String in length. We recommend that you use the MAC address or
serial number (SN) of the device as the ID.

The timestamp that indicates the current time, in

timeSt Stri
imeStamp rng milliseconds.

o OQOutput parameters:

This function returns an authinfo Structure that contains the parameters that are described in
the following table.

Parameter Type Description

The username that is used to establish the MQTT

username String .
connection.
. The password that is used to establish the MQTT
password String .
connection.
mqttClientld String The ID of the MQTT client.

2. Add a programfile that can connect a device to IoT Platform.

To obtain MQTT connection parameters, you must write a programto call the function in the Mgtt
Sign.gofile.

This section provides the development instructions and sample code.

o Specify the device information.

// set the device info, include product key, device name, and device secret
var productKey string = "alzZd7n5***"
var deviceName string = "testdevice"
var deviceSecret string = "UrwclDV33NaFSmk0JaBxNTqgSrJW****"
// set timestamp, clientid, subscribe topic and publish topic
var timeStamp string = "1528018257135"
var clientId string = "192.168.x**x"
var subTopic string = "/" + productKey + "/" + deviceName + "/user/get";

var pubTopic string = "/" + productKey + "/" + deviceName + "/user/update";

o Specify the MQTT connection information.

Call the calculate_sign() function in MgttSign.gofile. This function returns the username,
password, and mgttClientld parameters based on the clientld, productKey, deviceName,
deviceSecret, and timeStamp input parameters. Then, add the result to the opts structure.
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// set the login broker url

var raw_broker bytes.Buffer

raw_broker.WriteString("tls://")

raw_broker.WriteString (productKey)
raw_broker.WriteString(".iot-as-mgtt.cn-shanghai.aliyuncs.com:1883")
opts := MQTT.NewClientOptions () .AddBroker (raw broker.String());

// calculate the login auth info, and set it into the connection options
auth := calculate sign(clientId, productKey, deviceName, deviceSecret, timeStamp)
opts.SetClientID(auth.mgttClientId)

opts.SetUsername (auth.username)

opts.SetPassword (auth.password)

opts.SetKeepAlive (60 * 2 * time.Second)

opts.SetDefaultPublishHandler (f)

) Notice

m [f you are using public instances, replace cn-shanghaiin  raw broker.WriteString(".i
ot-as-mgtt.cn-shanghai.aliyuncs.com:1883") withthe ID of the region in which
your device resides. For more information about region IDs, see Regions and zones.

m [f you are using Enterprise Edition instances, replace raw broker.String() iN opts
:= MQTT.NewClientOptions () .AddBroker (raw broker.String()); with <Endpoint of
MQTT>:1833 .Exarnple: opts := MQTT.NewClientOptions () .AddBroker ("iot-***.mgtt

.iothub.aliyuncs.com:1883") ;

To obtain the MQTT endpoint, perform the following steps: Log onto the loT
Platform. On the Overview page, clickthe card of the instance that you want to
manage. The MQTT endpoint is displayed on the Instance Details page. For more
information, see View the endpoint of an instance.

For more information about instances, see Overview.

o Callthe Connect() function to connect the MQTT client with loT Platform.

// create and start a client using the above ClientOptions

c := MQTT.NewClient (opts)

if token := c.Connect(); token.Wait() && token.Error() != nil {
panic (token.Error())

}
fmt.Print ("Connect aliyun IoT Cloud Success\n");

o Callthe Publish() function to publish messages. You must specify the topic to which messages
are published and the payloads of the messages.

// publish 5 messages to pubTopic ("/alZd7n5****/deng/user/update")
for i := 0; i < 5; i++ {

fmt.Println ("publish msg:", 1)

text := fmt.Sprintf ("ABC #%d", 1)

token := c.Publish (pubTopic, 0, false, text)

fmt.Println ("publish msg: ", text)

token.Wait ()

time.Sleep (2 * time.Second)
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For more information about topics, see What is a topic?.

o Callthe Subscribe() function to subscribe to the topic and receive messages from loT Platform.

// subscribe to subTopic("/alzd7n5***/deng/user/get") and request messages to be
delivered
if token := c.Subscribe (subTopic, 0, nil); token.Wait() && token.Error() != nil {
fmt.Println (token.Error())
os.Exit (1)
}

fmt.Print ("Subscribe topic " + subTopic + " success\n");

For more information about the communication methods of devices, servers, and IoT Platform, see

Overview.

3. Compile the project.

Sample code
You can use the sample code to connect to loT Platform.

1. Download and decompress the demo package.

The following table describes the files that are contained in the aiot-go-demo package.
File Description

This file contains the code that is used to obtain the MQTT connection
MqttSign.go parameters. When you execute the /ot.go file, the calculate_sign() function is
called to obtain the username, password, and mqttClientld parameters.

This file contains the logic code that is used to connect to and communicate

iot.go
9 with loT Platform.

The root certificate of 10T Platform. This certificate is required to connect

X509 devices with IoT Platform.

2. Inthe jot.gofile, replace the device information with your device information.
You can use tools such as Linux vito modify the jot.gofile.

o Replace the values of the productKey, deviceName, and deviceSecret parameters with your
device certificate information.

o Optional. Configure the timeStamp and clientld parameters. You can replace the value of the
clientld parameter with the MAC address or SN of your device.

If you do not configure the two parameters, you can still connect to loT Platform. However, we
recommend that you replace the values of the parameters with actual values.

o m If you are using public instances, replace cn-shanghaiin raw broker.WriteString (".iot-as-mgq
tt.cn-shanghai.aliyuncs.com:1883") with the ID of the region in which your device resides.

m If you are using Enterprise Edition instances, replace raw broker.String() 1IN opts := MQTT
.NewClientOptions () .AddBroker (raw broker.String()); with <Endpoint of MQTT>:1833

For more information, see Step 2 in the Connect the client to loT Platform section.

3. Runthe following command in the Command Prompt to execute the jot.gofile:
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go run iot.go MgttSign.go

Afteryou execute the file, the following local logs are generated:

clientIdl192.168.****deviceNametestdeviceproductKeyalZd7n5****timestampl528018257135
1b865320£c183cc747041c9faffc9055fcab5*+**

Connect aliyun IoT Cloud Sucess

Subscribe topic /alZd7n5****/testdevice/user/get success
publish msg: 0O

publish msg: ABC #0

publish msg: 1

publish msg: ABC #1

publish msg: 2

publish msg: ABC #2

publish msg: 3

publish msg: ABC #3

publish msg: 4

publish msg: ABC #4

publish msg: 5

publish msg: ABC #5

Log onto the loT Platform console.View device status and logs.

1.1.4. Use the Paho MQTT C# client

This article describes how to use the Paho Message Queuing Telemetry Transport (MQTT) library for G#
to connect to loT Platform and communicate with loT Platform.
Prerequisites

A product and a device are created inthe IoT Platform console. The LightSwitch property is defined on
the Define Feature tab of the Product Details page.

For more information, see Create a product, Create a device, and Add a TSL feature.

Context

The open source code of Paho MQTT for G# includes a Visual Studio solution. Each project inthe
solution can be used to generate the library for the specified .NET platform.

In this example, a console application project is created in the solution. The application uses the Paho
MQTT library to connect with loT Platform.

Prepare the development environment

In this example, the development environment consists of the following components:

e QOperating system: Windows 10
e Integrated development environment (IDE): Visual Studio 2019

To install the IDE, performthe following steps:
1. Download Visual Studio Community 2019 and decompress the package.

2. Open Visual Studio Installer, click .NET desktop development, and then clickInstall.

Download the Paho MQTT C# client
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Download the Paho MQTT for C# source code. The code includes a Visual Studio solution file named
M2MMagtt.sin. You can use this project file to develop your devices. For more information, see Connect
the client to loT Platform.

To view more instructions on the Paho source code, visit the Git Hub.

The master branch is used to develop the sample code in this article. The commit ID is
b2e64bc4485721a0bd5ae805d9£4917e8d040e81

Connect the client to IoT Platform

1. Click MgttSign.cs to view the source code that is provided by Alibaba Cloud to obtain the MQTT
connection parameters.

The MgttSign.csfile definesthe wMgttsign class.
o Syntax

class MgttSign

o Description

This class is used to obtain the following MQTT connection parameters: username, password,

and clientid.
o Members
Type Method
calculate (String productKey, String deviceName, String device
Secret)
public bool o
Calculates the username, password, and clientid parameters based on the
productKey, deviceName, and deviceSecret parameters.
getUsername ()
ublic Strin
P 9 Obtains the username parameter.
getPassword ()
public String .
Obtains the password parameter.
getClientid ()
public String

Obtains the clientid parameter.

2. Open Visual Studio. Import the Visual Studio solution file M2Mqtt.sinand create an application
project.

3. Import the MgttSign.csfile downloaded in Step 1 into the application project.

4. Inthe application project, add a programfile that can connect a device to IoT Platform.

You must write a programto use the MqttSign class inthe MgttSign.csfile to obtainthe
parameters that are used to establish an MQTT connection with IoT Platform.

This section provides the development instructions and sample code.

o Obtainthe MQTT connection parameters.
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Use the MqttSign class in the MgttSign.csfile to obtain the MQTT connection parameters.

String productKey = "alX2bEn****";

String deviceName = "examplel";

String deviceSecret = "ga7XA6KdlEeiPXQPpRDLAJOZXWG8y****";
// Obtain the MQTT connection parameters.

MgttSign sign = new MgttSign();

’

sign.calculate (productKey, deviceName, deviceSecret

)
Console.WriteLine ("username: " + sign.getUsername());
Console.WriteLine ("password: " + sign.getPassword());
Console.WriteLine ("clientid: " + sign.getClientid());

o Create a Paho MQTT client to connect with loT Platform.

// Use the Paho MQTT C# client to connect with IoT Platform.

int port = 443;

String broker = productKey + ".iot-as-mgtt.cn-shanghai.aliyuncs.com";

MgttClient mgttClient = new MgttClient (broker, port, true, MgttSslProtocols.TLSvl 2,
null, null);

mgttClient.Connect (sign.getClientid (), sign.getUsername (), sign.getPassword());

Console.WriteLine ("Broker: " + broker + " Connected");

@ Note

Replace cn-shanghaiin the code with the ID of the region where your device resides. For
more information about region IDs, see Regions and zones.

o Submit datato loT Platform.

The following sample code is used to submit the LightSwitch property.

// Publish messages by using Paho MQTT.

String topic = "/sys/" + productKey + "/" + deviceName + "/thing/event/property/post"
String message = "{\"id\":\"1\",\"version\":\"1.0\", \"params\": {\"LightSwitch\":0}}";
mgttClient.Publish (topic, Encoding.UTF8.GetBytes (message));

For more information about TSL data formats, see Device properties, events, and services.
For more information about how to use customtopics for communication, see What is a topic?.

o Subscribe to atopic to receive the messages fromIoT Platform.

The following example shows how to subscribe to the topic to which IoT Platformreturns a
response message after the property is submitted.

24
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// Subscribe to a topic by using Paho MQTT.

String topicReply = "/sys/" + productKey + "/" + deviceName + "/thing/event/property/
post reply";

mgttClient.MgttMsgPublishReceived += MgttPostProperty MgttMsgPublishReceived;
mgttClient.Subscribe (new string[] { topicReply }, new byte[] { MgttMsgBase.QO0S LEVEL
AT MOST ONCE });

private static void MgttPostProperty MgttMsgPublishReceived (object sender, uPLibrary.
Networking.M2Mgtt.Messages.MgttMsgPublishEventArgs e)

{
Console.WritelLine ("reply topic :" + e.Topic);
Console.WriteLine ("reply payload:" + e.Message.ToString()):;

For more information about the communication methods of devices, servers, and IoT Platform, see

Overview.

5. Compile the project.

Sample code
You can use the sample code to connect with lIoT Platform.
1. Download the demo package and decompress it to the aiot-csharp-demo directory.

The aiot-csharp-demo\paho.mqgtt.m2maqtt-master\aiot-csharp-demo directory contains a
complete programthat is used to connect with IoT Platform and submit properties.

File Description

This file contains the code that is used to obtain the MQTT connection
MqgttSign.cs parameters. When you run the Program.cs file, the MqttSign() function is
called to obtain the username, password, and clientld parameters.

This file contains the logic code that is used to connect with IoT Platform

Program.cs . .
o and submit properties.

2. Open Visual Studio Community 2019, click Open a project or solution, and then open the aiot-cs
harpo-demo\paho.mqgtt.m2maqgtt-master\M2Mgtt.sinfile.

The aiot-csharp-demo project is imported into Visual Studio.
3. Inthe Program.csfile, replace the device information with your device information.
o Replace the values of the productKey, deviceName, and deviceSecret parameters with your
device certificate information.

String productKey = "${ProductKey}";
String deviceName = "${DeviceName}";

String deviceSecret = "${DeviceSecret}";

o Modify the endpoint in  string broker = productKey + ".iot-as-mqtt.cn-shanghai.aliyuncs.c
om"; .Formore information, see Step 4 inthe "Connect the client to IoT Platform" section.

4. Set the aiot-cshanp-demo file as the startup item, and then run it to connect the client with loT
Platform.

> Document Version: 20220624 25


https://www.alibabacloud.com/help/doc-detail/146382.htm#concept-2358399
https://linkkit-export.oss-cn-shanghai.aliyuncs.com/paho/aiot-csharp-demo.zip

Best Practices- MEMFES

uremode=2, s1izgnmethod=hmac

Afterthe connection is established, you can view the information about the connection, data
submission, and message subscription in local logs.

broker: alX2bEn****_ iot-as-mgtt.cn-shanghai.aliyuncs.com Connected
publish: {"id":"1","version":"1.0","params":{"LightSwitch":0}}

subscribe: /sys/alX2bEn****/examplel/thing/event/property/post reply

Logontothe View device status and logs.

1.1.5. Use the Paho MQTT Android client

This article describes how to use Paho Android Service to connect to loT Platform and exchange
messages with loT Platform.

Prerequisites

Context

Paho Android Service is a Message Queuing Telemetry Transport (MQTT) client that is developed based
onthe Paho MQTT library for Java.

Prepare the development environment
In this example, Android Studio of version 3.5.1 and Gradle of version 3.5.1 are used.

Visit the to download Android Studio. For more information about
Android development, see the Android Studio official documentation.

Install Paho Android Client

1. Create an Android project.
2. Inthe Gradle file, add the Paho Android Client dependencies. In this example, Paho Android Client
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1.1.1 is used. You need to add the following dependencies.

o Inthe build.gradlefile, add the address of the Paho repository. In this example, the release
repository is used.

repositories {
maven {

url "https://repo.eclipse.org/content/repositories/paho-releases/"

}

o Inthe build.gradlefile, add the Paho Android Service dependencies. In this example, Paho
Android Service 1.1.1 is used. It is based on paho.client.mgttv3-1.1.0.

dependencies {
implementation 'org.eclipse.paho:org.eclipse.paho.client.mgttv3:1.1.0"'
implementation 'org.eclipse.paho:org.eclipse.paho.android.service:1.1.1"

}

3. To bind an app to Paho Android Service, add the following information to the AndroidManifest.xml
file.

o Declare the following service:

<! —- Mgtt Service -->
<service android:name="org.eclipse.paho.android.service.MgttService">

</service>

o Add the permissions required by Paho MQTT Service.

<uses-permission android:name="android.permission.WAKE LOCK" />
<uses-permission android:name="android.permission.ACCESS NETWORK STATE" />
<uses-permission android:name="android.permission.INTERNET" />

<uses-permission android:name="android.permission.READ PHONE STATE" />

Connect to IoT Platform

1. Click AiotMgttOption.java to obtain the source code provided by Alibaba Cloud to calculate the
MQTT connection parameters.

The AlotMgttOption.javafile defines the AiotMqttOption class.
o Prototype

class AiotMgttOption

o Description

This class is used to obtain the following MQTT connection parameters: username, password,
and clientid.

o Members

Type Method
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Type Method

getMgttOption (String productKey, String deviceName, String de

viceSecret)

public AiotMqgttOption You can call this method to calculate the username, password, and clientid
parameters based on the productKey, deviceName, and deviceSecret of
the device.

getUsername ()

public String You can call this method to obtain the MQTT connection parameter
username.

getPassword ()

public String You can call this method to obtain the MQTT connection parameter
password.

getClientid()

public String You can call this method to obtain the MQTT connection parameter
clientid.

2. Import the AjotMgttOption.javafile into the Android project.

3. Inthe Android project, add a programfile that can connect a device to loT Platform.

You must write a programto use the AiotMqttOption class in the AiotMgttOption.javafile to
calculate the parameters that are used to establish an MQTT connection to IoT Platform.

This section provides the development instructions and sample code.

o Calculate the MQTT connection parameters clientld, username, and password. Configure the
username and password parameters in the MqgttConnect Options object.

final private String PRODUCTKEY = "allxsrW****";
final private String DEVICENAME = "paho android";
final private String DEVICESECRET = "tLMTIQWD36U2SArglGqcHCDKOrK9****";
/* Obtain the MQTT connection parameters clientId, username, and password. */
AilotMgttOption aiotMgttOption = new AiotMgttOption () .getMgttOption (PRODUCTKEY, DEVICE
NAME, DEVICESECRET) ;
if (aiotMgttOption == null) {

Log.e (TAG, "device info error");
} else {

clientId = aiotMgttOption.getClientId() ;

userName = aiotMgttOption.getUsername () ;

passWord = aiotMgttOption.getPassword () ;
}
/* Create an MgttConnectOptions object and configure the username and password. */
MgttConnectOptions mgttConnectOptions = new MgttConnectOptions () ;
mgttConnectOptions.setUserName (userName) ;

mgttConnectOptions.setPassword (passWord.toCharArray()) ;

o Connect to loT Platform.
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Create an MgttAndroidClient object and configure the callback. Use the mgttConnectOptions
object to call the connect() method to establish the connection.

/* Create an MgttAndroidClient object and configure the callback. */
mgttAndroidClient = new MgttAndroidClient (getApplicationContext (), host, clientId);
mgttAndroidClient.setCallback (new MgttCallback () {
@Override
public void connectionLost (Throwable cause) {
Log.i (TAG, "connection lost");
}
@QOverride
public void messageArrived(String topic, MgttMessage message) throws Exception {
Log.i(TAG, "topic: " + topic + ", msg: " + new String(message.getPayload()));
}
@Override
public void deliveryComplete (IMgttDeliveryToken token) {
Log.i(TAG, "msg delivered");

1)
/* Establish a connection to IoT Platform by using MQTT. */
try {
magttAndroidClient.connect (mgttConnectOptions, null, new IMgttActionListener () {
@Override
public void onSuccess (IMgttToken asyncActionToken) {
Log.i (TAG, "connect succeed");
subscribeTopic (SUB_TOPIC) ;
}
@Override
public void onFailure (IMgttToken asyncActionToken, Throwable exception) {

Log.1i (TAG, "connect failed");

)i
} catch (MgttException e) {
e.printStackTrace () ;

o Publish messages. Write the publishMessage() method to publish messages with the specified
payload tothe /${prodcutKey}/${deviceName} /user/update topic.
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public void publishMessage (String payload) {

try {
if (mgttAndroidClient.isConnected() == false) {

mgttAndroidClient.connect () ;

}
MgttMessage message = new MgttMessage();

message.setPayload (payload.getBytes());

message.setQos (0) ;
mgttAndroidClient.publish (PUB TOPIC, message,null, new IMgttActionListener ()

@Override
public void onSuccess (IMgttToken asyncActionToken) {

Log.i(TAG, "publish succeed!")
}

@Override
public void onFailure (IMgttToken asyncActionToken, Throwable exception) {

Log.i (TAG, "publish failed!")

P i

} catch (MgttException e) {
Log.e (TAG, e.toString()):
e.printStackTrace () ;

For more information about communication topics, see what is a topic?

o Write the subscribeT opic() method to subscribe to a specified topic and obtain messages from
loT Platform.

public void subscribeTopic (String topic) {

try {
mgttAndroidClient.subscribe (topic, 0, null, new IMgttActionListener() {

@Override
public void onSuccess (IMgttToken asyncActionToken) {

Log.i (TAG, "subscribed succeed");

}
@Override
public void onFailure (IMgttToken asyncActionToken, Throwable exception) {

Log.1i(TAG, "subscribed failed");

}) s
} catch (MgttException e) {
e.printStackTrace () ;

For more information about the communication methods of devices, servers, and IoT Platform, see

Overview.

4. Compile the project.

Demo

The demo code demonstrates how to connect a device to loT Platform.
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1. Download the demo package and decompress it.
2. Import aiot-android-demo into Android Studio.

3. Inthe app/src/main/java/com.linkkit.aiot_android_demo directory, replace the device information
with your device information in the MainActivityfile.

o Replace the values of the productKey, deviceName, and deviceSecret parameters with your
device certificate information.

o Replace cn-shanghaiin  final String host = "tcp://" + PRODUCTKEY + ".iot-as-mgtt.cn-shan
ghai.aliyuncs.com:443"; Wwiththe ID of the region where your device resides. For more
information about region IDs, see Regions and zones.

4. Build and run the demo.
Afterthe demo is run, you can view the local logs in Logcat.

2019-12-04 19:44:01.824 5952-5987/com.linkkit.aiot android demo W/OpenGLRenderer: Faile
d to choose config with EGL SWAP BEHAVIOR PRESERVED, retrying without...

2019-12-04 19:44:01.829 5952-5987/com.linkkit.aiot android demo D/EGL emulation: eglCre
ateContext: 0xec073240: maj 3 min 0 rcv 3

2019-12-04 19:44:01.830 5952-5987/com.linkkit.aiot android demo D/EGL emulation: eglMak
eCurrent: 0xec073240: ver 3 0 (tinfo Oxec090470)

2019-12-04 19:44:01.852 5952-5987/com.linkkit.aiot android demo W/Gralloc3: mapper 3.x
is not supported

2019-12-04 19:44:01.854 5952-5987/com.linkkit.aiot android demo D/HostConnection: creat

eUnique: call

2019-12-04 19:44:01.860 5952-5987/com.linkkit.aiot android demo D/eglCodecCommon: alloc
ate: Ask for block of size 0x1000

2019-12-04 19:44:01.861 5952-5987/com.linkkit.aiot android demo D/eglCodecCommon: alloc
ate: ioctl allocate returned offset 0x3f£f706000 size 0x2000

2019-12-04 19:44:01.897 5952-5987/com.linkkit.aiot android demo D/EGL emulation: eglMak
eCurrent: Oxec073240: ver 3 0 (tinfo 0xec09b470)

2019-12-04 19:44:02.245 5952-6023/com.linkkit.aiot android demo D/AlarmPingSender: Regi
ster alarmreceiver to MgttServiceMgttService.pingSender.allxsrW**** paho android|timest
amp=1575459841629, v=sdk-android-1.0.0, securemode=2, signmethod=hmacsha256 |

2019-12-04 19:44:02.256 5952-6023/com.linkkit.aiot android demo D/AlarmPingSender: Sche
dule next alarm at 1575459902256

2019-12-04 19:44:02.256 5952-6023/com.linkkit.aiot android demo D/AlarmPingSender: Alar
m scheule using setExactAndAllowWhileIdle, next: 60000

2019-12-04 19:44:02.272 5952-5952/com.linkkit.aiot android demo I/AiotMgtt: connect suc
ceed

2019-12-04 19:44:02.301 5952-5952/com.linkkit.aiot android demo I/AiotMgtt: subscribed

succeed

Log onto the loT Platform console.View device status and logs.
o Choose Devices > Devices. You can find that the status of the device is Online.

o Choose Maintenance > Device Log to view logs onthe Cloud run log and Device local log
tabs. For more information, see IoT Platformlogs and Local device logs.

If the Mgtt5App programis run, you can view the reported custom properties in the log details.

1.1.6. Troubleshooting

> Document Version: 20220624 31


http://code.aliyun.com/edward.yangx/public-docs/wikis/user-guide/linkkit/Paho_MQTT_Guide/aiot-android-demo.zip
https://www.alibabacloud.com/help/doc-detail/40654.htm#concept-2459516
http://iot.console.aliyun.com/
https://www.alibabacloud.com/help/doc-detail/44542.htm#concept-a32-x4w-f2b
https://www.alibabacloud.com/help/doc-detail/159427.htm#task-2454897

Best Practices-Device access MIBEMTE

If a device fails to establish a Message Queuing Telemetry Transport (MQTT) connectionto loT
Platform, you can troubleshoot the issue based on the error code.

loT Platform uses the standard MQTT protocol. For more information about the MQTT protocol, see the
MQTT 3.1 or 3.1.1 documentation and MQTT 5.0 documentation.

The following tables describe the codes that may be returned by IoT Platform.

e MQTT 3.1 and 3.1.1
Return code Return message Description

0 0x00 Connection Accepted The mes.sag.e returngd when the
connection is established.
The error message returned because
0x01 Connection Refused, unacceptable the server does not support the MQTT
protocol version protocol version that is used by the
device.

The error message returned because
0x02 Connection Refused, identifier 9 Y Y
2 the server does not support the UTF-8

rejected
) encoded client ID.
The error message returned because
3 0x03 Connection Refused, Server the MQTT service is unavailable even
unavailable though the network connection has

been established.

. The error message returned because
0x04 Connection Refused, bad user 9
4 the format of the username or

name or password L .
password parameter is invalid.

5 0x05 Connection Refused, not The error message returned because
authorized the device is not authorized.
e MQTT 5.0
Return code Return message Description
The message returned when the
0 0x00 Success . g .
connection is established.
. The error message returned because an
128 0x80 Unspecified error . 9
unspecified error occurred.
The error message returned because a
129 0x81 Malformed Packet 9 .
malformed packet was received.
The error message returned because a
130 0x82 Protocol Error 9
protocol error occurred.
. The error message returned because
132 0x84 Unsupported Protocol Version 9

the protocol version is not supported.
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Return code

136

137

138

140

141

144

147

148

149

150

151

152

153

154

155

156

157

Return message

0x88 Server unavailable

0x89 Server busy

0x8A Banned

0x8C Bad authentication method

0x8D Keep Alive timeout

0x90 Topic Name invalid

0x93 Receive Maximum exceeded

0x94 Topic Alias invalid

0x95 Packet too large

0x96 Message rate too high

0x97 Quota exceeded

0x98 Administrative action

0x99 Payload format invalid

0X9A Retain not supported

0x9B QoS not supported

0x9C Use another server

0x9D Server moved

Description

The error message returned because
the server is unavailable.

The error message returned because
the server is busy.

The error message returned because
the access is prohibited.

The error message returned because
the authentication method is invalid.

The error message returned because a
keep-alive timeout occurred.

The error message returned because
the topic name is invalid.

The error message returned because
the number of received messages
exceeds the limit.

The error message returned because
the topic alias is invalid.

The error message returned because
the packet length exceeds the limit.

The error message returned because
the message transmission rate is too
high.

The error message returned because
the quota is exceeded.

The error message returned because of
an administrative action.

The error message returned because
the payload format is invalid.

The error message returned because
messages cannot be retained.

The error message returned because
the QoS is not supported.

The error message returned because
another server needs to be used.

The error message returned because
the server is removed.

> Document Version: 20220624

33



Best Practices-Device access MIBEMTE

Return code Return message Description

. The error message returned because
158 OX9E Shared Subscription not supported . g .

shared subscription is not supported.
The error message returned because

159 0x9F Connection rate exceeded . o
the connection rate exceeds the limit.

1.2. Access loT Platform by using
CoAP

This topic describes how to connect a device to loT Platform by using Constrained Application Protocol
(CoAP).

CoAP is suitable for devices such as NB-loT devices that have constrained resources and run at low
power. For more information about how to connect a device to loT Platform by using CoAP, see Connect
devices to 0T Platform over CoAP.

@ Note The feature is available only in the China (Shanghai) region.

When you connect a device to loT Platform by using CoAP, you must specify the required parameters,
generate a signature for the device, and perform other operations. Eclipse Calif ornium-based sample
code is used as an example to describe the configuration process. To ensure data security, symmetric
encryption is applied.

pom.xml

Add the following dependencies to the pom.xmifile to import the Calif ornium open-source framework,
Apache Commons toolkit, and Alibaba fastjson package.

<dependency>
<groupId>org.eclipse.californium</groupId>
<artifactId>californium-core</artifactId>
<version>2.0.0-M17</version>

</dependency>

<dependency>
<groupId>org.apache.commons</groupId>
<artifactId>commons-lang3</artifactId>
<version>3.5</version>

</dependency>

<dependency>
<groupId>commons-codec</groupld>
<artifactId>commons-codec</artifactId>
<version>1.13</version>

</dependency>

<dependency>
<groupId>com.alibaba</groupId>
<artifactId>fastjson</artifactId>
<version>1.2.61</version>

</dependency>
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Sample code

/*

* Copyright © 2019 Alibaba.

*/

package com.

import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
/**

* The

java.
java.
java.
java.
java.
java.

java.

Jjava
java
java
java
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.

com.

following Eclipse Californium-based code shows how to connect a device to IoT Platfo

aliyun

X
X.
X

X.

.crypto
crypto

.lot.demo;

io.IOException;

util.TreeMap;
.crypto.Cipher;
crypto.Mac;

All rights reserved.

nio.charset.StandardCharsets;
security.MessageDigest;
security.NoSuchAlgorithmException;
util.Set;
util.SortedMap;

.spec.IvParameterSpec;

.spec.SecretKeySpec;

apache.commons.codec.DecoderException;

apache.commons.codec.binary.Hex;

apache.commons.lang3.RandomUtils;

eclipse

eclipse

eclipse.
eclipse.
eclipse.
eclipse.
eclipse.
eclipse.
eclipse.
eclipse.
eclipse.
eclipse.
alibaba.

rm by using CoAP.

* For more information about how to develop custom code and specify the required parameter

s, see the Use the symmetric encryption method Section in Establish connections over CoAP.

*/

.californium

.californium

californium.
californium.
californium.
californium.
californium.
californium.
californium.
californium.
californium.
californium.
fastjson.JSONObject;

.core.CoapClient;
.core.CoapResponse;
core.Utils;

core.coap.CoAP;
core.coap.CoAP.Code;
core.coap.CoAP.Type;
core.coap.MediaTypeRegistry;
core.coap.Option;
core.coap.OptionNumberRegistry;
core.coap.OptionSet;
core.coap.Request;

elements.exception.ConnectorException;

public class IotCoapClientWithAes {

//

The start of the section where you can specify the required param

eters

// The ID of the region. Only the China (Shanghai)

region is available.

private static String regionId = "cn-shanghai";
// The key of the product.

private static String productKey = "The productKey of your device";

// The name of the device.

private static String deviceName = "The deviceName of your device";
// The key of the device.

private static String deviceSecret = "The deviceSecret of your device";

//

SIS

// Set the HMAC ALGORITHM parameter to hmacshal or hmacmd5. The value that you set must

The end of the section where you can specify the required paramet

be the same as that of the signmethod parameter.

> Document Version: 20220624

35



Best Practices-Device access MIBEMTE

private static

final String HMAC ALGORITHM = "hmacshal";

// The endpoint that is used to authenticate CoAP clients. The port number of the endpo

int is 5682 if you

private static

use symmetric encryption.

String serverURI = "coap://" + productKey + ".coap." + regionId + ".link

.aliyuncs.com:5682";

// The topic to which messages are sent. In the IoT Platform console, you can create a

custom topic and grant the publish permission to devices.

private static

// token option

private static
// seq option
private static
// Specify the
private static
private static

private static

String updateTopic = "/" + productKey + "/" + deviceName + "/user/update

final int COAP2 OPTION TOKEN = 2088;

final int COAP2 OPTION SEQ = 2089;
SHA-256 encryption algorithm.
final String SHA 256 = "SHA-256";
final int DIGITAL 16 = 16;

final int DIGITAL 48 = 48;

// Create a CoAP client.

private CoapClient coapClient = new CoapClient();

// The validity period of a token is seven days. After a token expires, you must obtain

a new token.
private String

private String

token = null;

random = null;

@SuppressWarnings ("unused")

private long seqgqOffset = 0;

/**

* Initialize a CoAP client

*

* @param productKey The key of the product

* @param deviceName The name of the device

* @param deviceSecret The key of the device

*/

public void connect (String productKey, String deviceName, String deviceSecret) {

try {

// The endpoint for authentication.

String uri = serverURI + "/auth";
// Only the POST method is available.
Request request = new Request (Code.POST, Type.CON) ;

// Specify options

OptionSet optionSet = new OptionSet () ;
optionSet.addOption (new Option (OptionNumberRegistry.CONTENT FORMAT, MediaTypeRe

gistry.APPLICATION

JSON) ) ;

optionSet.addOption (new Option (OptionNumberRegistry.ACCEPT, MediaTypeRegistry.A

PPLICATION JSON)) ;

request.setOptions (optionSet) ;

// Specify the endpoint that you can use to authenticate the device

request.setURI (uri) ;

// Specify the required parmeters for an authentication request

request.setPayload (authBody (productKey, deviceName, deviceSecret));

// Send the authentication request

CoapResponse response = coapClient.advanced (request) ;

System.
System.

out.println (Utils.prettyPrint (response)) ;

out.println();

// Parse the response

36
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JSONObject json = JSONObject.parseObject (response.getResponseText ()) ;
token = json.getString("token");
random = json.getString ("random") ;
seqOffset = json.getLongValue ("seqOffset");

} catch (ClientException e) {
e.printStackTrace () ;
} catch (IOException e) {
e.printStackTrace () ;
}
}
/**

* Send messages

*

@param topic The topic to which messages are sent.
* @param payload The contents of messages.

*/

public void publish(String topic, byte[] payload) {
try {
// The endponit of the topic. The syntax of a topic is /topic/S${topic}.
String uri = serverURI + "/topic" + topic;
// Use seg=RandomUtils.nextInt() to encrypt the seq option by using the AES en

cryption algorithm.

String shaKey = encod(deviceSecret + "," + random);

byte[] keys = Hex.decodeHex (shaKey.substring (DIGITAL 16, DIGITAL 48));

byte[] segBytes = encrypt (String.valueOf (RandomUtils.nextInt ()) .getBytes (Standa
rdCharsets.UTF 8), keys);

// Only the POST method is available
Request request =
// Specify options

OptionSet optionSet = new OptionSet () ;

new Request (CoAP.Code.POST, CoAP.Type.CON) ;

optionSet.addOption (new Option (OptionNumberRegistry.CONTENT FORMAT, MediaTypeRe

gistry.APPLICATION JSON)) ;

optionSet.addOption (new Option (OptionNumberRegistry.ACCEPT, MediaTypeRegistry.A

PPLICATION JSON)) ;

optionSet.addOption (new Option (COAP2 OPTION TOKEN, token));
optionSet.addOption (new Option (COAP2 OPTION SEQ, segBytes));

request.setOptions (optionSet) ;

// Specify the endpoint of the topic.
request.setURI (uri) ;

// Specify the payload parmameter.
request.setPayload (encrypt (payload, keys)):;
// Send messages.
CoapResponse response = coapClient.advanced (request) ;
System.out.println (Utils.prettyPrint (response)) ;

// Parse the result.

String result = null;
if '= null) {

new String(decrypt (response.getPayload(),

(response.getPayload ()
result =

}

System.out.println ("Received: " + result);

System.out.println();

} catch (ConnectorException e) {
e.printStackTrace () ;
} catch

(IOException e) {

keys));
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}
/**

*
*
*/

pri

}
/**

*
*
*
*
*
*/

pri

/* %

e.printstacklrace () ;
} catch (DecoderException e) {

e.printStackTrace () ;

Generate the required parameters for authentication

@param productKey The name of the product
@param deviceName The name of the device
@param deviceSecret The key of the device

@return An authentication request

vate String authBody (String productKey, String deviceName, String deviceSecret) {
// Create an authentication request

JSONObject body = new JSONObject () ;

body.put ("productKey", productKey) ;

body.put ("deviceName", deviceName) ;

body.put ("clientId", productKey + "." + deviceName) ;

//signMap.put ("timestamp", String.valueOf (System.currentTimeMillis()));
body.put ("signmethod", HMAC ALGORITHM) ;

body.put ("seq", DIGITAL 16);

body.put ("sign", sign(body, deviceSecret));

System.out.println ("-—---—- auth body ----- ")

System.out.println (body.toJSONString()) ;

return body.toJSONString () ;

Generate a signature for a device

@param params The required parameters that you can use to generate a signature.
@param deviceSecret The key of the device.

@return The signature in the hexadecimal format.

vate String sign (JSONObject params, String deviceSecret) {
// Sort request parameters in the alphabetical order
Set<String> keys = getSortedKeys (params) ;
// Remove the sign, signmethod, version, and resources parameters.
keys.remove ("sign") ;
keys.remove ("signmethod") ;
(

keys.remove ("version") ;
keys.remove ("resources") ;
// Obtain the plaintext of the signature.
StringBuffer content = new StringBuffer():;
for (String key : keys) {
content.append (key) ;
content.append (params.getString (key)) ;
}
// Generate a signature.
String sign = encrypt (content.toString(), deviceSecret);
System.out.println ("sign content=" + content);
System.out.println("sign result=" + sign);

return sign;

38
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*
*
*

*

*/

Convert a JSON object to a set of key-value pairs.

@param json The JSON object to be converted.
@return A set of key-value pairs that are converted from a JSON object.

private Set<String> getSortedKeys (JSONObject json) {

}
/

* x

*

*

*/

SortedMap<String, String> map = new TreeMap<String, String>();

(String key : json.keySet()) {
String vlaue = json.getString (key) ;

map.put (key, vlaue);

return map.keySet ();

Specify an encryption algorithm in the HMAC ALGORITHM parameter.

@param content Plaintext.
@param secret An encryption key.

@return Ciphertext.

private String encrypt (String content, String secret) {

}
/

* Kk

try {

byte[] text = content.getBytes (StandardCharsets.UTF 8);

byte[] key = secret.getBytes (StandardCharsets.UTF 8);
SecretKeySpec secretKey = new SecretKeySpec (key, HMAC ALGORITHM) ;
Mac mac = Mac.getInstance (secretKey.getAlgorithm()) ;

mac.init (secretKey) ;

return Hex.encodeHexString (mac.doFinal (text));

} catch (Exception e) {

e.printStackTrace () ;

return null;

* SHA-256

*

* @param str A message to be encrypted.

*/

private String encod(String str) {

}

MessageDigest messageDigest;
String encdeStr = "";

try {

messageDigest = MessageDigest.getInstance (SHA 256);

byte[] hash = messageDigest.digest (str.getBytes (StandardCharsets.UTF 8));

encdeStr = Hex.encodeHexString (hash) ;

} catch (NoSuchAlgorithmException e) {

System.out.println (String. format ("Exception@encod: str=%s;", str));

e.printStackTrace () ;

return null;

return encdeStr;

// Encrypt and decrypt data based on the AES algorithm.

private static final String IV = "543vhiv97ae7fvig";
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private static final String TRANSFORM = "AES/CBC/PKCS5Padding";
private static final String ALGORITHM = "AES";
/**
* key length = 16 bits
2
private byte[] encrypt (byte[] content, byte[] key) {
return encrypt (content, key, IV);
}
/**
* key length = 16 bits
*/
private byte[] decrypt (byte[] content, bytel[] key) {
return decrypt (content, key, IV);
}
/**
* aes 128 cbc key length = 16 bits
Y
private byte[] encrypt (byte[] content, byte[] key, String ivContent) {
try {
SecretKeySpec keySpec = new SecretKeySpec (key, ALGORITHM) ;
Cipher cipher = Cipher.getInstance (TRANSFORM) ;
IvParameterSpec iv = new IvParameterSpec (ivContent.getBytes (StandardCharsets.UT
F 8));
cipher.init (Cipher.ENCRYPT MODE, keySpec, 1iv);
return cipher.doFinal (content) ;
} catch (Exception ex) {
System.out.println (
String.format ("AES encrypt error, %s, %s, %s", content, Hex.encodeHex (k
ey), ex.getMessage()));

return null;

}
/**
* aes 128 cbc key length = 16 bits
*/
private byte[] decrypt (byte[] content, byte[] key, String ivContent) {
try {
SecretKeySpec keySpec = new SecretKeySpec (key, ALGORITHM) ;
Cipher cipher = Cipher.getInstance (TRANSFORM) ;
IvParameterSpec iv = new IvParameterSpec (ivContent.getBytes (StandardCharsets.UT

F_8));
cipher.init (Cipher.DECRYPT MODE, keySpec, 1iv);
return cipher.doFinal (content) ;
} catch (Exception ex) {
System.out.println (String.format ("AES decrypt error, %s, %s, %s", Hex.encodeHex
(content) ,

Hex.encodeHex (key), ex.getMessage()));

return null;

}

public static void main(String[] args) throws InterruptedException {
IotCoapClientWithAes client = new IotCoapClientWithAes() ;
client.connect (productKey, deviceName, deviceSecret);
client.publish (updateTopic, "hello coap".getBytes (StandardCharsets.UTF 8));
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client.publish (updateTopic, new byte[] { 0x01, 0x02, 0x03, 0x05 });

1.3. Access loT Platform by using
HTTP

This topic describes how to connect a device to loT Platform by using HTTP.

You can connect a device to IoT Platform by using HTTP. For more information, see Establish connections
over HTTPS.

This topic uses a sample code developed based on the device SDK forJava to connect a device with loT
Platform. Before you can establish the connectioin, you must specify the required parameters, such as
request parameters and certificate information of the device.

@ Note Thisfeature is available only in the China (Shanghai) region.

Configure the pom.xml file

Add the following dependency to the pom.xmifile to import the Alibaba fastjson package.

<dependency>
<groupld>com.alibaba</groupId>
<artifactId>fastjson</artifactId>
<version>1.2.61</version>

</dependency>

Sample code

The following code shows how to connect a device to loT Platform and enable data communication.

/*
* Copyright ©® 2019 Alibaba. All rights reserved.
Y

package com.aliyun.iot.demo;

import java.io.BufferedOutputStream;

import java.io.BufferedReader;

import java.io.InputStreamReader;

import java.io.PrintWriter;

import java.net.URL;

import java.nio.charset.StandardCharsets;

import java.util.Set;

import java.util.SortedMap;

import java.util.TreeMap;

import javax.crypto.Mac;

import javax.crypto.spec.SecretKeySpec;

import javax.net.ssl.HttpsURLConnection;

import com.alibaba.fastjson.JSONObject;

/**

* Connect a device to IoT Platform by using HTTP.
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* For more information about the HTTP protocol, see HTTP standard.
* For more information about the data format, see Establish connections over HTTP.
*/
public class IotHttpClient ({
// The ID of the region. Only the China (Shanghai) region is available.
private static String regionId = "cn-shanghai";
// Specify an encryption algorithm. Set the HMAC ALGORITHM parameter to hmacshal or hma
cmd5. The value that you set must be the same as that of the signmethod parameter.
private static final String HMAC ALGORITHM = "hmacshal";
// The validity period of a token is seven days. After a token expires, you must obtain
a new token.
private String token = null;
/**
* Initialize an HTTP client.
*
* @param productKey The key of the product.
* @param deviceName The name of the device.
* @param deviceSecret The key of the device.
*/
public void conenct (String productKey, String deviceName, String deviceSecret) {
try {
// The endpoint for authentication.
URL url = new URL("https://iot-as-http." + regionId + ".aliyuncs.com/auth");
HttpsURLConnection conn = (HttpsURLConnection) url.openConnection() ;
conn.setRequestMethod ("POST") ;
conn.setRequestProperty ("Content-type", "application/json");
conn.setDoOutput (true) ;
conn.setDoInput (true);
// Obtain the output stream of the URLConnection object.
PrintWriter out = new PrintWriter (conn.getOutputStream()) ;
// Send request parameters.
out.print (authBody (productKey, deviceName, deviceSecret));
// Print out the contents of the cache.
out.flush();
// Obtain the input stream of the URLConnection object.

BufferedReader in = new BufferedReader (new InputStreamReader (conn.getInputStrea

// Obtain responses from the endpoint.
String result = "";
String line = "";
while ((line = in.readLine()) != null) {
result += line;
}
System.out.println ("-—---- auth result ---——- W) g
System.out.println (result) ;
// Close input and output streams.
in.close();
out.close();
conn.disconnect () ;
// Obtain a token.
JSONObject json = JSONObject.parseObject (result) ;
if (json.getIntValue ("code") == 0) {
token = json.getJSONObject ("info") .getString ("token") ;

D N, N - NSOy (R S e N
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} CdlCIl (mXCepLlioll ) {

e.printStackTrace () ;

}
/**
* Send messages.
*
@param topic The topic to which messages are sent.
* @param payload The contents of messages.
*/
public void publish(String topic, byte[] payload) {
try {

// Specify the endpoint of a topic to which messages are sent.

URL url = new URL("https://iot-as-http." + regionId + ".aliyuncs.com/topic" + t

opic) ;

HttpsURLConnection conn = (HttpsURLConnection) url.openConnection();

conn.setRequestMethod ("POST") ;

conn.setRequestProperty ("Content-type", "application/octet-stream");

conn.setRequestProperty ("password", token);
conn.setDoOutput (true) ;
conn.setDoInput (true) ;

// Obtain the output stream of the URLConnection object.

BufferedOutputStream out = new BufferedOutputStream (conn.getOutputStream());

out.write (payload) ;
out.flush();
// Obtain the input stream of the URLConnection object.

BufferedReader in = new BufferedReader (new InputStreamReader (conn.getInputStrea

// Obtain responses from the endpoint.
String result = "";
String line = "";
while ((line = in.readLine()) != null) {
result += line;
}
System.out.println ("-—---- publish result ----- ")
System.out.println (result) ;
// Close input and output streams.
in.close();
out.close();
conn.disconnect () ;
} catch (Exception e) {

e.printStackTrace () ;

}
/**
* Generate the required parameters for authentication.
*
* @param params The required parameters for authentication.
* @return A message that includes an authentication request.

*/

private String authBody (String productKey, String deviceName, String deviceSecret)

// Create a authentication request.
JSONObject body = new JSONObject () ;
body.put ("productKey", productKey) ;

bodv.ont ("deviceName". deviceName) :
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body.put ("clientId", productKey + "." + deviceName) ;

body.put ("timestamp", String.valueOf (System.currentTimeMillis()));

(
(
body.put ("signmethod", HMAC ALGORITHM) ;
body.put ("version", "default");

body.put ("sign", sign(body, deviceSecret));
System.out.println ("-———- auth body ----- ) 2
System.out.println (body.toJSONString()) ;

return body.toJSONString() ;

/**
* Generate a signature for the device

*

* @param params The required parameters that you can use to generate a signature

* @param deviceSecret The key of a device
* @return The signature in the hexadecimal format.
2
private String sign (JSONObject params, String deviceSecret) {
// Sort request parameters in alphbetical order.
Set<String> keys = getSortedKeys (params) ;
// Remove the sign, signmethod, and version parameters.
keys.remove ("sign") ;
keys.remove ("signmethod") ;
keys.remove ("version") ;
// Obtain the plaintext of the signature
StringBuffer content = new StringBuffer();
for (String key : keys) {
content.append (key) ;
content.append (params.getString (key)) ;
}
// Generate a signature
String sign = encrypt (content.toString(), deviceSecret);
System.out.println ("sign content=" + content);
System.out.println("sign result=" + sign);
return sign;
}
/**
* Convert a JSON object to a set of key-value pairs.

*

* @param json The JSON object to be converted.

* @return A set of key-value pairs that are converted from the JSON object.

w2y
private Set<String> getSortedKeys (JSONObject json) {
SortedMap<String, String> map = new TreeMap<String, String>();
for (String key : json.keySet()) {
String vlaue = json.getString (key) ;
map.put (key, vlaue);
}
return map.keySet ();
}
/**
* Specify an encryption method in the HMAC ALGORITHM parameter.

* @param content Plaintext.

* (@param secret An encryption key.

44
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* @return Ciphertext.
*/
private String encrypt (String content, String secret) {
try {
byte[] text = content.getBytes (StandardCharsets.UTF 8);
byte[] key = secret.getBytes (StandardCharsets.UTF 8);
SecretKeySpec secretKey = new SecretKeySpec (key, HMAC ALGORITHM) ;
Mac mac = Mac.getInstance (secretKey.getAlgorithm()) ;
mac.init (secretKey) ;
return byte2hex (mac.doFinal (text)) ;
} catch (Exception e) {
e.printStackTrace () ;

return null;

}
/**
* Convert a binary array to a hexadecimal string.
*
* @param b The binary array.
* @return A hexadecimal string.
w2y
private String byte2hex (byte[] b) {
StringBuffer sb = new StringBuffer();
for (int n = 0; b != null && n < b.length; nt+) {
String stmp = Integer.toHexString(b[n] & OXFF);
if (ss.length == 1) {
sb.append ('0") ;
}
sb.append (stmp) ;
}
return sb.toString() .toUpperCase() ;
}
public static void main(String[] args) {
String productKey = "The productKey of your device";
String deviceName = "The deviceName of your device";
String deviceSecret = "The deviceSecret of your device";
IotHttpClient client = new IotHttpClient ()
client.conenct (productKey, deviceName, deviceSecret);
// The topic to which messages are sent. In the IoT Platform console, you can creat
e a custom topic and grant the publish permission to devices.
String updateTopic = "/" + productKey + "/" + deviceName + "/user/update";
client.publish (updateTopic, "hello http".getBytes (StandardCharsets.UTF 8));
client.publish (updateTopic, new byte[] { 0x01, 0x02, 0x03 });

1.4. Access loT Platform by using
MQTT over WebSocket connections
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This topic describes how to connect a device to loT Platform by using Message Queuing Telemetry
Transport (MQTT) protocol over WebSocket connections. This topic also provides the corresponding
sample code for Node.js.

Context

For more information about how to connect a device to loT platform by using the WebSocket protocol,
see Establish MQTT over WebSocket connections.

This topic describes how to use the device Link SDK provided by IoT Platformto connect a device and
perform upstream and downstream messaging. A device of a previous public instance is used in the
following example.

@ Note The device Link SDK integrates the Transport Layer Security (TLS) encryption feature.
No manual configurations are required.

Procedure

1. Download and install Node.js on the Windows or Linux operating system. In this example, Windows
10 (64-bit) is used. Download the node-v14.15.1-x64.msi installation package.

2. Open a Command Prompt window and run the following command to view the node version:

node --version
If the package is decompressed, the following version number appears:
v14.15.1

3. Create aJavaScript file such as jot_device.js on your computer to store the Node.js sample code.

The following Node.js sample code is used:
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const iot = require('alibabacloud-iot-device-sdk');

// Specify the device certificate information.

const productKey = 'alWx**';
const deviceName = 'device2';
const deviceSecret = 'ff0le59dla***"';

// Specify the instance ID for a new public instance or Enterprise Edition instance. Yo
u do not need to specify this parameter if you are using a previous public instance.
const instancelId = '';
// Specify the ID of the region to which the product and device belong.
const region = 'cn-shanghai';
const brokerUrl = instanceId
? ‘wss://${instanceId}.mgtt.iothub.aliyuncs.com:443"
‘wss://${productKey}.iot-as-mgtt.${region}.aliyuncs.com:443";
const device = iot.device ({
productKey: °${productKey} ",
deviceName: °${deviceName} ",
deviceSecret: ‘${deviceSecret}’,
brokerUrl,
tls: true,
1) i
// Listen to connect events: Connect the device to IoT Platform over an MQTT connection
, enable the device to subscribe to a custom topic, and use the custom topic to send me
ssages to IoT Platform.
device.on('connect', () => {
device.subscribe (" /${productKey}/${deviceName} /user/get"’) ;
console.log ('connect successfully!');
device.publish (" /${productKey}/${deviceName}/user/update’, 'hello world!"');
1) i
// Listen to message events.
device.on ('message', (topic, payload) => ({
console.log(topic, payload.toString());
}) i
// Listen to error events.
device.on ('error', (error) => {
console.error (error) ;
1)
// To disconnect the device from IoT Platform, delete the double slashes (//) at the be
ginning of the following code, and call the end function.

//device.end() ;

You must specify parameters in the following table based on the actual use case such as the
device information.

Parameter Example Description

productKey aTw***

deviceName device2 The device certificate that is saved after you add
the device. For more information, see Create a
device.

deviceSecret ff01e59d1a***

You can obtain the certificate information of
device2 on the Device Details page inthe loT
Platform console.
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Parameter Example Description

The ID of the instance. You can view the ID of the
instance on the Overview page in the loT
Platform console.

o If you have an ID value, you must specify the ID
for this parameter.

instanceld

o If no Overview or ID is generated for your
instance, specify an empty string ( iotInstan
celd = '' )forthe parameter.

The ID of the region where your loT Platform
region cn-shanghai instance resides. For more information about
region IDs, see Regions and zones.

4. Open Command Prompt and run the cd command to go to the directory where the iot_device.jsfile
resides. In this directory, run the npm command to download the device Link SDK library. The
following figure shows the downloaded library.

npm install alibabacloud-iot-device-sdk —--save

node_modules
(8] iot_device
| package-lock.json 2020/

5. In Command Prompt, enter the following command to run the jot_device.jsfile. This way, the device
is started.

node iot device.js

The following response indicates that the device is connected to loT Platform and messages are
published.

View logs and test downstream messaging

1. Logontothe loT Platformconsole.

2. Inthe upper-left corner of the IoT Platform console, select the region where the IoT Platform
instance resides.

3. OntheInstance Overview page, find the instance and click the instance name to go to the
Instance Details page.

) Notice IoT Platform provides instances only in the Japan (T okyo) region. For other
regions, please skip this step.

4. Inthe left-side navigation pane, choose Devices > Devices.

device2 is displayed on the Device List tab, and the device is in the Online state.
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loT Platform Devices Devices
Devices
" . Total Devices ® Activated Devices @ Onli
4 3 1
Device List Batch Management Advanced Search
Batch Add DeviceName v Enter DeviceName Q Search by Device Tag v
DeviceName/Alias Product Node Type State/Enabled Y4 Last Online Actions

Device2 Devices May 11,2022, 16:08:19.663 View | Delete

5. Inthe Actions column of device2, click View. On the Device Details page, clickthe Device Log
tab, and then click View.

View the device logs on the Cloud run log tab of the Device Log page.

Device Log

Product: v
Cloudrunlog  Device locallog  Message Trajectory  loT Platform Log Dump  Local Log Dump
Q Enter a Traceld Q Search by keywords or Messageld Q Al v 1 Hour v
Search Reset
TracelD Messageld Message Content DeviceName Warkload Typefall) y JDevicezusersger | Content
Device2 Subscription /Deviceduser. “Params":null“ResultD.. 200
Device? Subscription WDfDeviced/t..  ["Params"null"ResultD. 200
Device2 Subseription JFDffDevice/t..  ["Paramsnull ResultD. 200
Device2 Subseription o fDeviced/t... “Params"inull"ResuitD.. 200
Device? Subscription Jshadow/get/g . “Params"null"ResultD.. 200
| Device? Device behavior online “Params"null"ResultD.. 200 |

6. Inthe log list, find the message whose Workload Type is Device-to-cloud Messages and click
View in the Message Content column to view the message content.

View Details X

Top ffDeviceZ/user/update

5]
&}

Time May 11, 2022, 16:08:19.743

(]
8]
=]

Content Text (UTF-8) | helloworld!

Off

7. Test downstream messaging by sending a message from loT Platformto the device.

i. Choose Devices > Devices. Onthe Device List tab of the Devices page, find device2 and
clickView in the Actions column.

ii. Onthe Device Details page, clickthe Topic List tab, find the /alw***/device2/user/get
topic in Subscribed Topics, and click Publish.
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iii. Enter a message and click OK.

Publish

Exercise caution if this topic is being used. The messages published
here will not be subscribed by the server.

Topic
I /Device2/user/get

Notification Cantent

test

471000

iv. Returnto Command Prompt and check whether the device has received the message. If
downstream messaging works properly, the message is received.

You can also return to the Cloud run log tab to view messaging logs.

Device Log

Product:  homeThermostat ~

Cloudrunlog  Devicelocallog |~ Message Trajectory | loT Platform Log Dump | Local Log Dump

Enter a Device Name. Q|| EnteraTaceld Q|| Search by keywords or Messageld Q| oan ~ | THour v

Time Traceld Messageld Message Content Devicellame Workdoad Type(al) 7 Actions Content Status

= Here Device2 AP Calls Pub {*Params"“[productKe. 200

w5, e e LR e i TR Here Device2 Cloud-to-device Message 1 VDevice2/user... {"Params"null"ResultD. 200

1.5. MQTT-based dynamic registration

This article describes how to dynamically register the devices that use the MQTT protocol and obtain
the DeviceSecrets. The DeviceSecrets are required for authentication when you connect the devices to
loT Platform. In this example, the sample Java code is used for pre-registration unique-certificate-per-
product authentication.

Prerequisites

The following steps that are specified in the Unique-certificate-per-product authentication topic are
performed:

Background information

loT Platform supports multiple authentication methods for devices. For more information, see
Authenticate a device.

You can establish MQTT connections to perform pre-registration unique-certificate-per-product
authentication or preregistration-free unique-certificate-per-product authentication. For more
information about the procedure and parameters of MQTT-based dynamic registration, see MQTT-based
dynamic registration.
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Procedure

1. Open Intelli IDEA and create a Maven project. In this example, the MQTT dynamic registration
project is created.

2. Inthe pom.xmlfile, add the following Maven dependencies and click Load Maven Changes to
download the packages.

<dependency>
<groupld>org.eclipse.paho</groupId>
<artifactId>org.eclipse.paho.client.mgttv3</artifactId>
<version>1.2.1</version>

</dependency>

<dependency>
<groupld>com.alibaba</groupId>
<artifactId>fastjson</artifactId>
<version>1.2.61</version>

</dependency>

3. Gotothe \MQTT dynamic registration \src\main\java directory and create a Java class. In this
example, the DynamicRegisterByMqtt class is created. Enter the following code.

® Note

o If the device is not activated, dynamic registration can be performed multiple times. In
this case, only the latest DeviceSecret is valid. Make sure that the latest DeviceSecret is
persisted on the device.

o If the device is activated, you must call the ResetThing operation to reset the device
statusin loT Platformto inactive. Then, you can dynamically register the device.

/*
* Copyright © 2019 Alibaba. All rights reserved.
*/
package com.aliyun.iot.demo;
import java.nio.charset.StandardCharsets;
import java.util.Random;
import java.util.Set;
import java.util.SortedMap;
import java.util.TreeMap;
import javax.crypto.Mac;
import javax.crypto.spec.SecretKeySpec;
import org.eclipse.paho.client.mgttv3.IMgttDeliveryToken;
import org.eclipse.paho.client.mgttv3.MgttCallback;
import org.eclipse.paho.client.mgttv3.MgttClient;
import org.eclipse.paho.client.mgttv3.MgttConnectOptions;
import org.eclipse.paho.client.mgttv3.MgttException;
import org.eclipse.paho.client.mgttv3.MgttMessage;
import org.eclipse.paho.client.mgttv3.persist.MemoryPersistence;
import com.alibaba.fastjson.JSONObject;
/**
* Perform dynamic registration for a device.
=
public class DynamicRegisterByMagtt {

// The ID of the region where your product resides.
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private static String regionId = "cn-shanghai";

// Specify an encryption algorithm. Valid values: hmacmd5, hmacshal, and hmacsha256

The value that you specify must be the same as the value of the signmethod parameter.

private static final String HMAC ALGORITHM = "hmacshal";

// The topic that receives device certificates from IoT Platform. Use the topic wit

hout any changes. You do not need to create or subscribe to the topic.

private static final String REGISTER TOPIC = "/ext/register";
/**

* Dynamic registration.

*

* @ param productKey: the ProductKey of the product.

* @param productSecret: the ProductSecret of the device.

* @param deviceName: the DeviceName of the device.

* @throws Exception

*/

public void register (String productKey, String productSecret, String deviceName) th

rows Exception ({
// The endpoint of the authentication service. You must use

Security (TLS) protocol.

the Transport Layer

String broker = "ssl://" + productKey + ".iot-as-mgtt." + regionId + ".aliyuncs

.com:1883";
// The client ID. We recommend that you use the MAC address
The client ID can be a maximum of 64 characters in length.
String clientId = productKey + "." + deviceName;
// Obtain a random value.
Random r = new Random() ;
int random = r.nextInt (1000000) ;
// The value of the securemode parameter is 2 and cannot be

2 indicates that TLS is applied. The signmethod parameter specifies

or SN of the device

changed. The value

an encryption algor

ithm.
String clientOpts = "|securemode=2, authType=register, signmethod=" + HMAC ALGORI
THM + ", random=" + random + "|";
// The ID of the MQTT client.
String mgttClientId = clientId + clientOpts;
// The usename of the MQTT client.
String mgttUsername = deviceName + "&" + productKey;
// The signature that the MQTT client uses to connect to the endpoint.
JSONObject params = new JSONObject () ;
params.put ("productKey", productKey);
params.put ("deviceName", deviceName) ;
params.put ("random", random) ;
String mgttPassword = sign(params, productSecret);
// Send an MQTT CONNECT message for dynamic registration.
connect (broker, mgttClientId, mgttUsername, mgttPassword) ;
}
/**

* Send an MQTT CONNECT message for dynamic registration.

* @param serverURL: the endpoint for dynamic registration.
* @param clientId: the ID of the client.

* @param username: the username of the MQTT client.

* @param password: the password of the MQTT client.

*/

@SuppressWarnings ("resource")
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private void connect (String serverURL, String clientId, String username, String pas
sword) {
try {
MemoryPersistence persistence = new MemoryPersistence () ;
MgttClient sampleClient = new MgttClient (serverURL, clientId, persistence);
MgttConnectOptions connOpts = new MgttConnectOptions() ;
connOpts.setMgttVersion (4);// MQTT 3.1.1
connOpts.setUserName (username) ; // The username.
connOpts.setPassword (password.toCharArray());// The password.
connOpts.setAutomaticReconnect (false); // Disable the automatic reconnectio
n feature based on MQTT rules that are set for dynamic registration.
System.out.println ("-—---- register params ----- ")
System.out.print ("server=" + serverURL + ",clientId=" + clientId);
System.out.println (",username=" + username + ",password=" + password) ;
sampleClient.setCallback (new MgttCallback() {
@Override
public void messageArrived (String topic, MgttMessage message) throws Ex
ception {
// Print out only the response of dynamic registration.
if (REGISTER TOPIC.equals (topic)) {
String payload = new String(message.getPayload(), StandardChars
ets.UTF_8);
System.out.println ("----- register result ----- ")
System.out.println (payload) ;

sampleClient.disconnect () ;

}
@Override
public void deliveryComplete (IMgttDeliveryToken token) {
}
@Override
public void connectionLost (Throwable cause) {
}
1) i
sampleClient.connect (connOpts) ;
} catch (MgttException e) {
System.out.print ("register failed: clientId=" + clientId);
System.out.println (",username=" + username + ",password=" + password) ;
System.out.println ("reason " + e.getReasonCode()) ;
+

System.out.println ("msg .getMessage () ) ;

(

( " e
System.out.println("loc " + e.getLocalizedMessage());
System.out.println("cause " + e.getCause()):;
System.out.println ("excep " + e);

e.printStackTrace () ;

/**

* Generate a signature for dynamic registration.

* @param params: the required parameters that you can use to generate a signature.
* @param productSecret: the ProductSecret of the device.
* @return: a hexadecimal signature string.
*/
private String sign (JSONObject params, String productSecret) {
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// Sort request parameters in alphabetical order.
Set<String> keys = getSortedKeys (params) ;
// Remove the sign and signMethod parameters.
keys.remove ("sign") ;
keys.remove ("signMethod") ;
// Obtain the plaintext of the signature.
StringBuffer content = new StringBuffer();
for (String key : keys) {

content.append (key) ;

content.append (params.getString (key)) ;
}
// Generate a signature.
String sign = encrypt (content.toString (), productSecret) ;
System.out.println ("sign content=" + content);
System.out.println("sign result=" + sign);

return sign;

/**
* Convert a JSON object to a set of key-value pairs.
*
* @param json: the JSON object to be converted.
* @return: a set of key-value pairs that are converted from the JSON object.
Y
private Set<String> getSortedKeys (JSONObject json) {
SortedMap<String, String> map = new TreeMap<String, String>();
for (String key : json.keySet()) {
String vlaue = json.getString (key) ;
map.put (key, vlaue);
}

return map.keySet ();

/**

* Specify an encryption algorithm for the HMAC ALGORITHM parameter.

* @param content: the plaintext.
* @param secret: the encryption key.
* @return: the ciphertext.
*/
private String encrypt (String content, String secret) {
try {
byte[] text = content.getBytes (StandardCharsets.UTF 8);
byte[] key = secret.getBytes (StandardCharsets.UTF 8);
SecretKeySpec secretKey = new SecretKeySpec (key, HMAC ALGORITHM) ;
Mac mac = Mac.getInstance (secretKey.getAlgorithm()) ;
mac.init (secretKey) ;
return byte2hex (mac.doFinal (text)) ;
} catch (Exception e) {
e.printStackTrace () ;

return null;

}
/**
* Convert a binary array to a hexadecimal string.
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CpaLldill U. LIS WLLGLY alLidy .
* @return: a hexadecimal string.
Y
private String byte2hex (byte[] b) {
StringBuffer sb = new StringBuffer();
for (int n = 0; b != null && n < b.length; n+t+) {
String stmp = Integer.toHexString(b[n] & OXFF);
if (stmp.length() == 1) {
sb.append ('0") ;
}
sb.append (stmp) ;
}
return sb.toString() .toUpperCase() ;
}

public static void main(String[] args) throws Exception {

String productKey = "alIoK****x*xx";
String productSecret = "6VEUS5QLlj5S**xkxxxmy
String deviceName = "OvenDeviceOl";

// Perform dynamic registration.
DynamicRegisterByMgtt client = new DynamicRegisterByMgtt () ;
client.register (productKey, productSecret, deviceName) ;

// After dynamic registration is successful, persist the DeviceSecret on premis

es.
}
}
Parameter Example Description
regionlid cn-shanghai

The ProductKey that is burned to the device. You can log on
productKey aTlloK****** to the IoT Platform console and view the ProductKey on the
Product Details page.

The ProductSecret that is burned to the device. You can log

productSecret 6VEUSQLj5S****** onto the loT Platform console and view the ProductSecret
on the Product Details page.

deviceName OvenDevice01 The name of the device.

4. Runthe DynamicRegisterByMqtt.java file so that the device can send an authentication request to
loT Platform. The DeviceName, ProductKey, and ProductSecret are included in the request.

The following figure shows the result. After the device passes the authentication, the device
receives a DeviceSecret that is issued by IoT Platform. In this example, the DeviceSecret is 8d1f0cd

ab49dd229cf3D75* * Ak xx KAk

What to do next
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After the device obtains the device certificate (ProductKey, DeviceName, and DeviceSecret), you can
use the MQTT client to connect the device with IoT Platform for data communication.

For more information, see Use the Paho MQTT Java client.

1.6. HTTPS-based dynamic
registration

This article describes how to dynamically register the devices that use the HTTPS protocol and obtain
the DeviceSecrets. The DeviceSecrets are required for authentication when you connect the devices to
loT Platform. In this example, the sample code for Java is used.

Prerequisites

The following steps that are specified in the Unique-certificate-per-product authentication topic are
performed:

Background information

loT Platform supports multiple authentication methods for devices. For more information, see
Authenticate a device.

You can establish HTTPS connections to perf orm pre-registration unique-certificate-per-product
authentication. For more information about the topics and parameters that are used for HTTPS-based
dynamic registration, see HTTPS-based dynamic registration of directly connected devices.

Procedure

1. Open Intellij IDEA and create a Maven project. In this example, the HTTPS dynamic registration
project is created.

2. Inthe pom.xmlfile, add the following Maven dependencies and click Load Maven Changes to
download the packages.

<dependency>
<groupId>com.alibaba</groupId>
<artifactId>fastjson</artifactId>
<version>1.2.61</version>

</dependency>

3. Go to the \HTTPS dynamic registration \src\main\java directory and create a Java class. In this
example, the DynamicRegisterByMqtt class is created. Enter the following code.

® Note

o If the device is not activated, dynamic registration can be performed multiple times. In
this case, only the latest DeviceSecret is valid. Make sure that the latest DeviceSecret is
persisted on the device.

o If the device is activated, you must call the ResetThing operation to reset the device
status in IoT Platformto inactive. Then, you can dynamically register the device.

/*
* Copyright © 2019 Alibaba. All rights reserved.
*/

56 > Document Version: 20220624


https://www.alibabacloud.com/help/doc-detail/146631.htm#task-2362406
https://www.alibabacloud.com/help/doc-detail/74006.htm#task-m1l-zqq-wfb
https://www.alibabacloud.com/help/doc-detail/42649.htm#concept-fqy-pjl-vdb
https://www.alibabacloud.com/help/doc-detail/89298.htm#concept-gm3-jtw-y2b/section-efq-cxw-y2b
https://www.alibabacloud.com/help/doc-detail/155680.htm#doc-api-Iot-ResetThing

MBS & Best Practices- Device access

package com.aliyun.iot.demo;
import java.io.BufferedReader;
import java.io.InputStreamReader;
import java.io.PrintWriter;
import java.net.URL;
import java.nio.charset.StandardCharsets;
import java.util.Random;
import java.util.Set;
import java.util.SortedMap;
import java.util.TreeMap;
import javax.crypto.Mac;
import javax.crypto.spec.SecretKeySpec;
import javax.net.ssl.HttpsURLConnection;
import com.alibaba.fastjson.JSONObject;
/**
* Perform dynamic registration for a device.
*/
public class DynamicRegisterByHttps {
// The ID of the region where your product resides.
private static String regionId = "cn-shanghai";
// Specify an encryption algorithm. Valid values: hmacmd5, hmacshal, and hmacsha256
The value that you specify must be the same as the value of the signmethod parameter.
private static final String HMAC ALGORITHM = "hmacshal";
/**
* Dynamic registration.
*
* @param productKey: the ProductKey of the device.
* @param productSecret: the ProductSecret of the device.
* @param deviceName: the DeviceName of the device.
* @throws Exception
Y
public void register (String productKey, String productSecret, String deviceName) th
rows Exception ({
// The requested URL.
URL url = new URL("https://iot-auth." + regionId + ".aliyuncs.com/auth/register
/device") ;
HttpsURLConnection conn = (HttpsURLConnection) url.openConnection() ;
conn.setRequestMethod ("POST") ;
conn.setRequestProperty ("Content-type", "application/x-www-form-urlencoded") ;
conn.setDoOutput (true) ;
conn.setDoInput (true) ;
// Obtain the output stream of the URLConnection object.
PrintWriter out = new PrintWriter (conn.getOutputStream()) ;
// Send request parameters.
out.print (registerdBody (productKey, productSecret, deviceName)) ;
// Clear the content of the cache.
out.flush();
// Obtain the input stream of the URLConnection object.

BufferedReader in = new BufferedReader (new InputStreamReader (conn.getInputStrea

// Obtain a response from the endpoint.
String result = "";
String line = "";

while ((line = in.readLine()) != null) {

> Document Version: 20220624 57



Best Practices-Device access MIBEMTE

result += line;
}
System.out.println ("-———- register result ----- ")
System.out.println (result) ;
// Close input and output streams.
in.close () ;
out.close () ;

conn.disconnect () ;

/**

* Generate a request for dynamic registration.

* @param productKey: the ProductKey of the device.
* @param productSecret: the ProductSecret of the device.
* @param deviceName: the DeviceName of the device.
* @return: the response payloads.
w
private String registerdBody (String productKey, String productSecret, String device
Name) {
// Obtain a random value.
Random r = new Random() ;
int random = r.nextInt (1000000) ;
// The required parameters for dynamic registration.
JSONObject params = new JSONObject () ;
params.put ("productKey", productKey) ;

params.put ("deviceName", deviceName) ;

(
(
params.put ("random", random) ;
params.put ("signMethod", HMAC ALGORITHM) ;
params.put ("sign", sign(params, productSecret)) ;
// Concatenate the payloads.
StringBuffer payload = new StringBuffer();
for (String key : params.keySet()) {
payload.append (key) ;
payload.append ("=") ;
payload.append (params.getString (key) ) ;
payload.append ("&") ;
}
payload.deleteCharAt (payload.length() - 1);
System.out.println ("----- register payload —----- W) g
System.out.println (payload) ;
return payload.toString() ;
}
/**
* Generate a signature for dynamic registration.
*
* @param params: the required parameters that you can use to generate a signature.
* @param productSecret: the ProductSecret of the device.
* @return: the signature in the hexadecimal format.
Y
private String sign (JSONObject params, String productSecret) {
// Sort request parameters in alphabetical order.
Set<String> keys = getSortedKeys (params) ;
// Remove the sign and signMethod parameters

keys.remove ("sign") ;
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keys.remove ("signMethod") ;
// Obtain the plaintext of the signature.
StringBuffer content = new StringBuffer();
for (String key : keys) {

content.append (key) ;

content.append (params.getString (key)) ;
}
// Generate a signature.
String sign = encrypt (content.toString(), productSecret);
System.out.println("sign content=" + content);
System.out.println ("sign result=" + sign);

return sign;

/**
* Convert a JSON object to a set of key-value pairs.

*

* @param json: the JSON object to be converted.

* @return: a set of key-value pairs that are converted from the JSON object.

*/
private Set<String> getSortedKeys (JSONObject json) {
SortedMap<String, String> map = new TreeMap<String, String>();
for (String key : json.keySet()) {
String vlaue = json.getString (key) ;
map.put (key, vlaue);
}

return map.keySet ();

/**
* Specify an encryption algorithm for the HMAC ALGORITHM parameter.

* @param content: the plaintext.
* (@param secret: the encryption key.
* @return: the ciphertext.
*/
private String encrypt (String content, String secret) {
try {
byte[] text = content.getBytes (StandardCharsets.UTF 8);
byte[] key = secret.getBytes (StandardCharsets.UTF 8);
SecretKeySpec secretKey = new SecretKeySpec (key, HMAC ALGORITHM) ;
Mac mac = Mac.getInstance (secretKey.getAlgorithm()) ;
mac.init (secretKey) ;
return byte2hex (mac.doFinal (text)) ;
} catch (Exception e) {
e.printStackTrace () ;

return null;

}
/**
* Convert a binary array to a hexadecimal string.
*
* @param b: the binary array.
* @return: a hexadecimal string.
=y
private String byte2hex (byte[] b) {
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StringButrter sb = new StringButtfer();

for (int n = 0; b != null && n < b.length; n++) {
String stmp = Integer.toHexString(b[n] & OXFF);
if (stmp.length() == 1) {

sb.append ('0") ;
}
sb.append (stmp) ;
}
return sb.toString() .toUpperCase () ;
}

public static void main(String[] args) throws Exception ({

String productKey = "alIoK*****x*";
String productSecret = "6VEUS5QLlj5S**AkxAxN,
String deviceName = "OvenDeviceOl";

// Perform dynamic registration.
DynamicRegisterByHttps client = new DynamicRegisterByHttps () ;
client.register (productKey, productSecret, deviceName) ;

// After dynamic registration is successful, persist the DeviceSecret on premis

es.
}
}
Parameter Example Description
regionlid cn-shanghai

The ProductKey that is burned to the device. You can log on
productKey aTloK****** to the IoT Platform console and view the ProductKey on the
Product Details page.

The ProductSecret that is burned to the device. You can log
productSecret 6VEUSQIj5S****** onto the loT Platform console and view the ProductSecret
on the Product Details page.

deviceName OvenDevice01 The name of the device.

4. Runthe DynamicRegisterByMqtt.java file so that the device can send an authentication request to
loT Platform. The DeviceName, ProductKey, and ProductSecret are included in the request. The
following figure shows the result. After the device passes the authentication, the device receives a
DeviceSecret that is issued by IoT Platform. In this example, the DeviceSecret is 6b14088fa377e8£85

2d82f7f********

What to do next

After the device obtains the device certificate (ProductKey, DeviceName, and DeviceSecret), you can
use the MQTT client to connect the device with IoT Platform for data communication.

For more information, see Use the Paho MQTT Java client.
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1.7. Connect a device to IoT Platform
by using MQTT.fx

MQTT .fx is an Eclipse Paho-based Message Queuing Telemetry Transport (MQTT) client that is written in
Java. MQTT.fx supports Windows, macOS, and Linux operating systems. MQTT.fx can be used to verify
whether a device can connect to IoT Platform. MQTT.fx allows you to subscribe to and publish
messages by using topics. This article describes how to connect a simulated device to IoT Platform over
MQTT by using MQTT.fx on Windows.

Prerequisites

A product and a device are created inthe IoT Platform console. The device certificate and MQTT
connection parameters are obtained fromthe Device Details page. For more information, see the
following articles:

e (reate a product

e Create adevice

e How do | obtain MQTT parameters for authentication?

In this example, a public instance of the previous version is used. The following table describes the

device certificate and MQTT connection parameters. For more information about the parameters, see
Establish MQTT connections over TCP.

Parameter Value
ProductKey alxxx
DeviceName devicel
DeviceSecret f35***d9e

al*** . devicelsecuremode=2, signmethod=hmacsha256, timestamp=2524

clientid
608000000
username devicel&al***
passwd 86761***21d
mqttHostUrl al*** iot-as-mgtt.cn-shanghai.aliyuncs.com
port 1883

) Notice MQTT.fxis used to simulate an online device and allows you to transmit only non-
passthrough data. To transmit pass-through data, you can use an actual device or an SDK for
testing.

Configure MQTT.fx

1. Download and install the MQTT .fx tool.

For more information, visit the MQT T .fx.
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2. Start the MQTT.fx tool, click Extras in the menu bar, and then select Edit Connection Profiles.

@ MQTT.x-1.7.1

e e

n | Edit Co tion Profil Shift+Me -C B

Preferences... Shift+Meta+5

Import " or Status Log
Export... b

O X

3. Onthe Edit Connection Profiles page, configure the parameters.

i. Specify the basic information.

New Profile

test

Profile Name | iot connection

Profile Type  MQTT Broker -
MQTT Broker Profile Settings

Broker Port | 1883

User Credentials  SSL/TLS  Proxy  LWT

Connection Timeout | 50
Keep Alive Interval | 60

Clean Session v/
Auto Reconnect

Max Inflight | 10

MQTT Version v/ Use Default

Parameter Description

Profile Name

Profile Type Specify a connection mode. Select MQTT Broker.

MQTT Broker Profile Settings

Broker Address | 31| Liot-as-matt.cn-shanghai aliyuncs.cc

Client ID 5 device1|securemode=2 signmethoc

Enter a custom name. In this example, jot connectionis specified.

Enter an MQTT endpoint, which is the value of the mqgttHostUrl parameter that
you obtained in the "Prerequisites" section of this article. In this example, a7***/

Broker ot-as-maqtt.cn-shanghai.aliyuncs.comis specified.

Address = g7***indicates the ProductKey.

®  cn-shanghaiindicates the region ID.

Broker Port Enter a port number. Set this parameter to 7883.
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Parameter

Client ID

General

Description

Configure the parameters in the MQTT protocol.

Format: ${Clientld}securemode=$Mode}, signmethod=${SignMethod}timestamp
=${timestamp} .

Enter the value of the clientld parameter that you obtained in the " Prerequisites"
section of this article. In this example, a7***.device1securemode=2,signmethod=
hmacsha256,timestamp=2524608000000 is specified.

The following table describes the parameters.

m  ${Clientld}. the ID of the client, such as a device, an application, or a web
browser.

(]> Notice You can specify a client ID as needed. The client ID must be
1 to 64 characters in length. If the client ID is a device ID, we recommend
that you specify the MAC address or the serial number (SN) of the device
as the value of this parameter. This way, you can identify your devices in
an efficient manner.

= $/Mode}. the security mode. Valid values: 2 and 3. If you use a direct TLS
connection, specify securemode=2. In this case, you must configure the
SSL/TLS parameters. If you use a direct TCP connection, specify securemode
=3. In this case, you do not need to configure the SSL/TLS parameters.

m ${SignMethod}. the signature algorithm. Valid values: hmacmdz56, hmacmads>,
and hmacshal.

m  $ftimestampj. the timestamp of the request. Unit: milliseconds. This
parameter is optional.

In the connection parameters provided by IoT Platform, the value of the $/Client/
df parameter is a string inthe  $fProductkey} + '.' + ${DeviceName} format.
The default value of $fMode}is 2, and the default value of ${SignMethod}is hma
csha256. You can modify the parameters as needed.

2 Notice

= Do not confuse the Client ID parameter of the MQTT.fx client with
the ${Clientid} parameter of the device.

® Do not omit the vertical bars () between and at the end of the
parameters.

® When you configure the parameters, make sure that you remove all
spaces from the parameter values.

® After you configure the Client ID parameter, do not click Generate.

In this example, the default values of the parameters are used. You can
configure the parameters based on your business requirements.
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ii. Clickthe User Credentials tab. Configure the User Name and Password parameters.

Profile Name | jot connection

Profile Type  MQTT Broker - i§ m
MQTT Broker Profile Settings

Broker Address iot-as-matt.cn-shanghai.aliyunc
Broker Port | 1883

Client ID 7 devicel|securemode=2 signmet Generate

General BUEECEOENENIEIRN TLS/SSL  LWT  Proxy

Use Uisername/Password v/

User Name | devicel&s

Password

Parameter Description

The username consists of a DeviceName, an ampersand (&), and a ProductKey.
Format: $/DeviceNamejs ${ProductKey} .

Enter the value of the username parameter that you obtained in the "Prerequisites"

User
Name section of this article. In this example, device1&al***is specified.
B devicel indicates the DeviceName of the device.
m  a1*** jndicates the ProductKey of the device.
To generate a password, you must select a signature algorithm, use the
DeviceSecret of the device as a secret key, and then concatenate the required
parameters and the values of the parameters.
Enter the value of the passwd parameter that you obtained in the "Prerequisites"
section of this article. In this example, 86767***21d is specified.
) Notice
= Your MQTT.fx client may display a masked password. If a password is
pasted, the pointer moves to the end of the password. In this case, you
Password do not need to paste the password again.

® Make sure that you specify valid uppercase and lowercase letters in
parameter names and values.

= You may modify the ${clientid} and ${SignMethod} parameters when you
configure the Client ID parameter. In this case, make sure that the
specified signature algorithm is the same as the value of the
corresponding parameter in Client ID. Then, recalculate a password. For
more information about the parameters and the calculation method, see
Use the Node.js script.
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jii. If youuse aTLS connection (securemode=2), clickthe SSL/TLS tab, select Enable SSL/TLS,
and then set the Protocol parameterto TLSv1.2.

) Notice If you use a TCP connection ( securemode=3 ), use the default settings on
the SSL/TLS tab, and go to the next step.

B Edit Connection Profiles O X
lot connection
local mosquitto Profile Name | lot connection
PofieTe moTTEoker 2 MQTE
Broker Address | a10Gs iot-as-matt.cn-shanghai aliyuncs.c

Broker Port | 1383

client 1D | 12345fecuremode=3 signmethod=hmacshal| Generate
General  User Credentials [LIFAIES Proxy LWT

Ensble 55L/TLS [7] Protocol | TLSv1.2 -

CA. signed server certificate
CA certificate file

CA certificate keystore
Self signed certificates

= =3
4. Click OK inthe lower-right corner.

5. ClickConnect.
If the indicator on the right side turns green, the connection is established.

@ MQTTAx - 1.7.1 - o X

GO Exiras  Help

B Disconnect +

To view the status of the device, performthe following steps: Log onto the IoT Platform console.
Choose Devices > Devices, select the product, and then find the device. The device is in the

Online state.

loT Platform / Devices / Devices
Devices
Total Devices ® Activated Device @ Online
All e
303 132 1
Device List Batch Management Advanced Search
Add Device Batch Add DeviceMName A Enter DeviceName Q Search by DeviceTag ™V
DeviceName/Alias Product Node Type State/Enabled

devicel N
Devices ® Cnline (.

In the following sections, downstream messaging and upstream messaging are tested to check whether
the MQTT.fx client is connected to IoT Platform. If your test results are different fromthe following
sample results, the connection is not established. You must modify the settings based on the logs.

Test downstream messaging
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1. Logontothe loT Platform console. On the Product Details page, choose Topic Categories >
Custom Topics. Then, find a custom topic that has the Subscribe permission.

In this example, the /a1***/${deviceName}/user/get topicis used.You must replacethe ${dev
iceName} Vvariable with devicel

For more information, see Custom topics.

2. Inthe MQTT.fx tool, clickSubscribe. In the Subscribe field, enter the topic that you specified in
the previous step, and then click Subscribe.

If the subscription is successful, the customtopic appears on the Subscribe tab.

MQTT.fx  Extras  Help

‘ Disconnect vars & a@ l
Publishl LI EG I Sparkplug Explorer  Scripts  Broker Status  Log
[ /2 ¢/devicel/user/get -
r/devicel/user/get Topic Filter

Dump Messages USON)  Mute (LTI

3. Go to the Device Details page inthe loT Platform console. On the Topic List tab, find the topic
and click Publish Message.

« devicel o

Strestlamp View

Device Information Topic List TSL Data Device Shadow Manage Files Device Log Online Debug Groups

Subscribed Topics
Device Topic Actions

4. Enter a message and click OK.

Publish X

ﬂ Exercise caution if this topic is being used. The messages published
here will not be subscribed by the server.

Topic

‘deviceT/user/get
Motification Content

This is a test,

Cos
®ao

5. Inthe MQTT.fx tool, check whether the message is received.

66 > Document Version: 20220624


https://iot.console.aliyun.com
https://www.alibabacloud.com/help/doc-detail/85539.htm#concept-ppk-rz4-k2b

MBS & Best Practices- Device access

File Extras Help
‘ Disconnect ﬂ o
Publish m Scripts  Broker Status  Log
faloGs, /Light/user/get - [ Autoscroll JECA
fa10Gs4XHWX/ Light /user/get B | /aloGst fLight/user/get 1
Dump Messages Mute | (QEENESIES Qo50
Topics Collector (0) Scan [
faloGs /Light/user/get
1
11-11-2020 10:33:26.38006123 Qo50
This is a test.
Payload decoded by = Plain Text Decoder

6. Go to the Device Details page inthe loT Platform console. On the Device Log tab, click View. On
the Device Log page, view cloud-to-device messages.

View Details X

c Y/devicel/user/get

(]
=]
L&)

Content  Text (UTF-8) v This is a test

Lo

Test upstream messaging

1. Logontothe loT Platform console. On the Product Details page, choose Topic Categories >
Custom Topics. Then, find a customtopic that has the Subscribe permission.

Inthis example, the /a1***/${deviceName}/user/get topicis used.You must replacethe s${dev
iceName} Variable with devicel

For more information, see Custom topics.

2. Inthe MQTT.fx tool, click Publish. In the Publish field, enter the topic that you specified in the
previous step. In the editor, enter the message to be sent and click Publish.
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B fEa—

m Subscribe  Sparkplug Explorer  Scripts  Broker Status  Log
& | 7 //device1/user/update/eror ~
text/pla
Payload Editor - n Editor
This is a publish test.

3. Go to the Device Details page inthe loT Platform console. On the Device Log tab, click View. On

the Device Log page, view device-to-cloud messages.

View Details

Topic

Content

View logs

iser/get

Feb 23, 2021, 16:26:45.246

ot UTRg v | Thisisatest

Inthe MQTT.fx tool, clickthe Log tab. On the tab that appears, view the operation logs and error logs.

Broker Status

Publish ~ Subscribe  Scripts
INFO
INFO
INFO
INFO
INFO
INFO
INFO
INFO
INFO
INFO
INFO

: publis
attempt to
addPubl:

: sucessfully published me:

mpt to add PublishToj
MqTTFX Cl sfully published me:

Broker
scrd

with ID a1
false

INFO
INFO
INFO
INFO
INFO
INFO
pLL

MqTTEX Cl
MqTTEX C1 Y
MqreX Cl sfully published me: is a publish T

alk /devicel/user/update/error
ST, T

cel/user/d

cel/user/d

cel/user/d

topic /alKuch

1.8. Connect Android Things hardware

to loT Platform

68
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This article describes how to connect Google Android Things hardware to IoT Platform. Anindoor air
test project is used in this example.

Hardware
e Hardware list for the project

The following table describes the hardware used in the indoor air test project.

Hardware Picture Remarks

Based on Android
things 1.0.

For more information,
see the Developer
Guide for NXP Pico
i.MX7D.

NXP Pico i.MX7D
@ Note You
can also use
Raspberry Pi
instead. For more
information, see
Remotely control a
Raspberry Pi
server.

Development board

Supports the inter-
integrated circuit (12C)
data communication
method.

DHT12

Temperature and
humidity sensor
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Hardware Picture Remarks

Supports the universal
asynchronous receiver-
transmitter (UART)
data communication
method.

ZE08-CH20

Formaldehyde
detection sensor

e Hardware connection diagram

O

PWM

ZE08-CH20

o Connect the SCL (clock line) and SDA (data line) pins of the temperature and humidity sensor
(DHT12) to the I2C SCL and SDA pins of the development board.
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o Connect the TXD (transmit data) pin of the formaldehyde detection sensor (ZE08-CH20) to the
RXD (receive data) pin of the development board, and connect the RXD pin of ZE08-CH20 to the
TXD pin of the development board.

Create a product and a device in the 10T Platform console

1. Logontothe loT Platformconsole.
2. Create a product.
i.
ii. Inthe left-side navigation pane, choose Devices > Products.

ii. Onthe Products page, click Create Product to create a product. For more information, see
Create a product.

3. Create a TSL model.
i. Onthe page that appears afterthe product is created, click Create TSL.

ii. Onthe Product Details page, clickthe Define Feature tab. Click Edit Draft and then Add
Self-defined Feature.

ii. Add the properties described inthe following table.
Property Identifier Data Type Valid value Description

The temperature data
Temperature temperature float -50 to 100 collected by the temperature
and humidity sensor DHT 12.

The humidity data collected
Humidity humidity float 0to 100 by the temperature and
humidity sensor DHT 12.

Formaldehyd The formaldehyde

e ' ch20 double 0to 3 concentration collected by
concentratio the formaldehyde detection
n sensor ZE08-CH20.

iv. ClickRelease online to publish the TSL model.
4. Create a device.

On the Devices page, click Add Device to add a device to the product. For more information, see
Create a device.

Develop an Android Things device
1. Use Android Studio to create an Android Things project and add the network permission.
<uses-permission android:name="android.permission.INTERNET" />
2. Add eclipse.paho.mgtt to the Gradlefile.

implementation 'org.eclipse.paho:org.eclipse.paho.client.mgttv3:1.2.0"

3. Configure the device to read data fromthe temperature and humidity sensor DHT 12 by using 12C.
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private void readDataFromI2C () {
try {

byte[] data = new byte[5];

i2cDevice.readRegBuffer (0x00, data, data.length);

// check data

if ((data[0] + data[l] + data[2] + data[3]) % 256 != data[4]) {
humidity = temperature = 0;
return;

}

// humidity data

humidity = Double.valueOf (String.valueOf (data[0]) + "." + String.valueOf (da
taflll)):
Log.d(TAG, "humidity: " + humidity);
// temperature data
if (data[3] < 128) {
temperature = Double.valueOf (String.valueOf (data[2]) + "." + String.val
ueOf (data[3]));
} else {
temperature = Double.valueOf ("-" + String.valueOf (data[2]) + "." + Stri

ng.valueOf (data[3] - 128));
}
Log.d(TAG, "temperature: " + temperature);
} catch (IOException e) {
Log.e (TAG, "readDataFromI2C error " + e.getMessage(), e);

4. Configure the device to read data fromthe formaldehyde detection sensor ZEO8-CH20 by using
UART.

try {
// data buffer
byte[] buffer = new byte[9];
while (uartDevice.read (buffer, buffer.length) > 0) {
if (checkSum(buffer)) {
ppbCh20 = buffer[4] * 256 + buffer[5];
ch2o0 = ppbCh20 / 66.64 * 0.08;
} else {
ch20 = ppbCh20 = 0;
}
Log.d(TAG, "ch2o: " + ch2o0);
}
} catch (IOException e) {
Log.e (TAG, "Ze(08CH20 read data error " + e.getMessage(), e);

5. Connect the device to loT Platform and report data.

72 > Document Version: 20220624



MEEME & Best Practices- Device access

/*
Payload format
{
"id": 123243,
"params": {
"temperature": 25.6,
"humidity": 60.3,
"ch2o0": 0.048
3y
"method": "thing.event.property.post"
}
wY

MgttMessage message = new MgttMessage (payload.getBytes ("utf-8"));

message.setQos (1) ;

String pubTopYourPc = "/sys/${YourProductKey}/${YourDeviceName}/thing/event/property/po
Stll;

mgttClient.publish (pubTopic, message) ;

You can visit aliyun-iot-androidthings-nxp on GitHub to download the complete sample project.

View real-time data of the device

Afterthe device is started, log onto the IoT Platform console. On the Device Details page, view the
real-time property data of the device in the Status section.

IoT Platform Devices > Device Details

Temperatu re-sensor
Product : Air_test Vie ProductKey : L Copy DeviceSecret : ™**** 5hg

Device Information Events Invoke Service

Rules

Extended Services
Status Real-time Refresh m Form

My Services
Humidity

Documentation

0.03mg/m? 10C° 27%
Last update: 2018/07/19 15:50:16 Last update: 2018/07/19 15:50:16 Last update: 2018/07/19 15:50:16
View logs View logs View logs

1.9. Connect an RTOS device to IoT

Platform by using a TCP
communication module

1.9.1. Overview

This topic describes how to use a device SDK for C-based application to connect a microcontroller
(MCU) device on which a real-time operating system (RTOS) runs to loT Platform.
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Most electrical devices use one or more MCUs on which an RTOS runs. These electrical devices include
industrial automation devices, data collection devices, real-time control devices, and home appliances.
To connect these electrical devices to IoT Platform, use device SDK for C that is provided by loT
Platform.

Implementation

Connect an MCU to a communication module and use AT commands for communication between the
MCU and the communication module. Use device SDK for C to connect the communication module to
lIoT Platform and enable communication between each other.

- - AT w—_-

- = commands{ £ e MQTT

= e i —" .

- - - @@ -

= @ C€0678

- ‘-E‘

MCU+RTOS Communication module loT Platform

Prepare software and hardware
You must prepare the following items.

e A NUCLEO-F103RB demo board that is equipped with an STM32F103 MCU from ST.

e An SIM800C mini V2.0 demo board that is equipped with a SIM800C communication module from
SIMcom.

e The IAR Embedded Workbench for ARM development environment.

Procedure

Create a product and add a device
Build a development environment for devices

Develop for a device

1.9.2. Create a product and add a device

This topic describes how to create a product, add a device to the product, and obtain certificate
information about the device inthe IoT Platform console. The certificate information includes the
ProductKey, DeviceName, and DeviceSecret parameters. Certificate information about a device must be
added to a device SDK-based project. If a device attempts to communicate with loT Platform, loT
Platformuses the certificate information about the device to authenticate the device.

Procedure
1. Logontothe loT Platformconsole.
2. Create a product.

i. Inthe left-side navigation pane, choose Devices > Products.
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i. Onthe Products page, click Create Product, specify the required parameters, and click Save.
Parameter Description
Product Name The name of the product.
[DO NOT TRANSLATE] [DO NOT TRANSLATE]
Node Type Select Directly Connected Device.

Network Connection

Method Select Wi-Fi.
Data Type Select ICA Standard Data Format (Alink JSON).
Authentication Mode Select Device Secret.

3. Add a device to the product.
i. Inthe left-side navigation pane, choose Devices > Devices.

ii. Onthe Devices page, click Add Device to add a device to the product.

1.9.3. Build a development environment for

devices

This topic describes how to connect a microcontroller (MCU) to a demo board that includes a
communication module. It also describes how to build a development environment, create a project,
import a device SDK, and configure the project.

Context

The following figure shows the demo boards.

e NUCLEO-F103RB

‘.‘ gl f.ﬂ;i L=Ij

= ;I m!fﬂm;;sm
Cin. I L

!‘i""

The following figure shows pins for the demo board.
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NUCLEQ-F103RE
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The following figure shows pins for the demo board.

Power GSM_RF
o (EmErE E ) o
%Ejﬂ""""lm R
-— -
- —
e - -
®|PWR - -
®|sta '[_., ]
®| GND fnnnn
o po EREREE__ [ ]
®| XD .'f
®| EN '
M| VIN O
O B i
Pin Description
PWR Power switch. Automatic power-on is enabled by default.
STA Status.
GND Ground.
RXD Receive data.
TXD Transmit data.
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Pin Description
EN Enable.
VIN 5V to 18 Vinput.

Connect demo boards

Connect the RXD pin of each demo board to the TXD pin of each demo board. This allows you to
establish a connection and run AT commands. The following figure shows how to connect the demo
boards.

Build a development environment

This topic uses the STM32CubeMX tool as an example. For more information, see STM32Cube
Ecosystem.

1. Openthe STM32CubeMX tool and click New Project.
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=T
» .
st @ File window Hel (a3) n k I'¢
CubeMX b o u , ’l
Existing Projects New Project Manage software installations

Check for STM32Cubeid

CHECK FOR UPDATES

Install or remove embedd.

INSTALL / REMOVE

Open Existing Projects E‘f

| need to :

ACCESS TO BOARD SELECTOR

art o . for Industrial and loT applications

ACCESS TO CROSS SELECTOR

Lyr

STM3IZMP1

2. Onthe Board Seletor tab, search for NUCLEO-F103RB and click STM32F103RBT x.

MK Hew Project from a Boeard

Board Filters
[E\ El, O Features Large Picture Docs & Resources Datasheet Buy Start Project
Ql Q
Part Mumber Search ~
ow multicore STM32MP1 Se
Q [ucLEO-FiDIRE ~ for Industrial and loT applications
Wendot >
Type > ,’
STM32MP1
MCUMPU Series >
Other hd
Price =10.32
L
Oscillatar Freq. =0 (WHz) Boards List: 1 item ¢ Export
P
- Marksting Status Unit Price (US$) Mourted Devics
MUCLEO-F103RB Mucleobd Active 1032 ETMIZF103RET
Perigheral hd
%]

3. Inthe upper-right comer, click Start Project.

4. Inthe left-side navigation pane, click Connectivity, and select USART 1 as the port for
communication between an MCU and a communication module. Proceed as follows.

o Set Mode to Asynchronous.
o Inthe Configuration section, set the following parameters.
m Onthe GPIO Settings tab, select PA9 and PA10 in the Pin field.
m Onthe NVIC Settings tab, set USART 1 global interrupt to Enabled.
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Pinout & Configuration gu
Additional Softwares

Mode Asynchronous

USART1 Mode and Configuration

System Core
Analog Hardware Flow Contrel (RS232) Disable
Timers
e
;
CAN
12C1 -
12C2 ® NVIC Settings
@ sPin Preemption Priority |Sub Priority
SPI2 SART1 global interrupt m 0 0
USART1
USART3
Use
Computing
Middleware

P FEEE

(T

oy x &Gy
GENERATE CODE

@ Pinout view

System view

- .

5. Inthe left-side navigation pane, clickMiddleware, select FREERT OS, set
USE_COUNTING_SEMAPHORES to Enabled, and set TOTAL HEAP_SIZE. Each thread can share the

heap.

File Window

Untitled - Pino

Help

Pinout & Configuration o Configuration
Additional Softwares
Oiptions FREERTOS Mode and Configuration 1
System Core Inferface CMSIS_V1
Anaiog
Configuration

Timers

Connesinity

Computing "

Middieware @ Config parameters o In

Configure the following paramebers:
FATFS =
- FreerTOS []
| USE_COUNTING_SEMAPHORES Enabled |
QUELE_REGISTRY_SIZE []
USE_APPLICATION_TASK_TAG Dasabied
ENABLE_BACKWARD_COMPATIBILITY Erabled
USE_TICKLESS_IDLE Disabled
USE_TASK_NOTIFICATIONS Enabled
Memary Mansgement settings
Memary Alacabon Diynanse
[ToraL_near_size 0x1800 Bytes |

Whemaory Managerment scheme heap_4

6. Onthe Project Manager tab, complete the settings in the Project section.
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GENERATE CODE

Project Manager

Project Name
Eal I = |
Project Location

[Ci\Users.isasmy ht\D
w Structure _
Basic ~ | [[] Do not generate the main()

Project

Tookhain Folder Location
C:\Wsers'sagng ht\D: ) 321103 _ P

Tooichain / IDE
EWARM V8 - [[] Generate Under Root

Linker g
Minimum Heap Size  [0x400
Minimum Stack Sze  0x800

Mcu and Firmware Package
Mcu Reference
STM32F103RBTx |

Firmware Package Mame and Version
be FW F1V1.7.0 l

7. Inthe upper-right corner of the page, click GENERATE CODE to generate code for the project.

1.9.4. Develop for a device

Use Link SDK for C to connect a communication module to IoT Platform.

Configure a device SDK
1. Download Link SDK 3.0.1 for C.
2. Extract code fromthe SDK package. T his topic uses Linux as an example.
i. Runthe make menuconfig command.

ii. Select ATM Configurations and clickSelect.
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iii. Select AT HAL Configurations and clickSelect.

iv. Set the following parameters:

FEATURE PLATFORM HAS STDINT=y
FEATURE PLATFORM HAS OS=y
FEATURE_INFRA STRING=y
FEATURE INFRA NET=y

FEATURE INFRA LIST=y

FEATURE INFRA LOG=y

FEATURE INFRA LOG ALL MUTED=y
FEATURE INFRA LOG MUTE FLW=y
FEATURE INFRA 1LOG MUTE DBG=y
FEATURE_INFRA LOG MUTE INF=y
FEATURE INFRA 1LOG MUTE WRN=y
FEATURE INFRA LOG MUTE_ERR-y
FEATURE INFRA LOG MUTE CRT=y
FEATURE INFRA TIMER-y
FEATURE INFRA SHA256=y
FEATURE INFRA REPORT=y
FEATURE INFRA COMPAT=y
FEATURE DEV_SIGN=y
FEATURE MQTT COMM ENABLED = y
FEATURE MQTT DEFAULT IMPL=y
FEATURE_MQTT DIRECT = y
FEATURE DEVICE MODEL CLASSIC=y
FEATURE ATM ENABLED=y
FEATURE AT TCP ENABLED=y
FEATURE AT PARSER ENABLED=y
FEATURE AT TCP HAL SIM800=y
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v. Afterthe configuration is complete, run the ./extract.sh script to extract code.

hubengf rlEebS0LHT7 : ~/c-sdk$ ./extract.sh

. Download request sent, waiting respond ...
. Respond generating, wait longer

. Retried 1/20

% Total % Received % Xferd Average Speed Time Time Time Current
Dload Upload Total Spent Left Speed
100 107k 100 107k 0 0 408k 0 ——t—=2—= —=1——f-- ——i1-—:-— 408k

Please pick up extracted source files in [/diskl/huteng/c-sdk/output]

The code is saved in the output /eng directory.

[msmngd el 3e5087 : ~/c-sdk/output/eng$ 1s
atm dev_sign infra mgtt sdk include.h wrappers

The following table lists subdirectories that reside in the output/eng directory.

Directory Description

atm Includes code that you can use to send and receive AT commands.
dev_sign Includes code that you can use to authenticate devices.

infra Includes code that you can use to implement internal functions.

matt Includes code that you can use to implement the Message Queuing
q Telemetry Transport (MQTT) protocol.
Includes code that you can use to implement hardware abstraction layer

rappers
wrapp (HAL) functions.

vi. Inthe wrappersdirectory, create the wrappers.cfile. Implement the following HAL functions in
the file.
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int32 t HAL AT Uart Deinit (uart dev t *uart)
int32_t HAL AT Uart Init (uart_dev_t *uart)
int32 t HAL AT Uart Recv(uart dev_t *uart, void *data, uint32 t expect size, uint32
_t *recv size, uint32 t timeout)
int32 t HAL AT Uart Send(uart dev_t *uart, const void *data, uint32 t size, uint32
t timeout)
int HAL GetDeviceName (char device name[IOTX DEVICE NAME LEN])
int HAL GetDeviceSecret (char device secret[IOTX DEVICE SECRET LEN])
int HAL GetFirmwareVersion (char *version)
int HAL GetProductKey (char product key[IOTX PRODUCT KEY LEN])
void *HAL Malloc (uint32 t size);
void HAL Free (void *ptr);
void *HAL MutexCreate (void)
void 1ls osa mutex destroy(void *mutex)
void HAL MutexLock (void *mutex)
void HAL MutexUnlock (void *mutex)
void *HAL SemaphoreCreate (void)
void HAL SemaphoreDestroy (void *sem)
void HAL SemaphorePost (void *sem)
int HAL SemaphoreWait (void *sem, uint32 t timeout ms)
int HAL ThreadCreate (void **thread handle,
void *(*work routine) (void *),
void *arg,
hal os thread param t *hal os thread param,
int *stack used)
void HAL SleepMs (uint32 t ms)
void 1ls osa print(const char *fmt, ...)
int HAL Snprintf (char *str, const int len, const char *fmt, ...)
uint64 t HAL UptimeMs (void)

Download a sample wrappers.c file.

The following figure shows how to specify the certificate information about the serial device
inthe file.

e
* ROTE:

*
* HAL TCP_xxx API reference implementation: wrappers/os/ubuntu/HAL TCP_linux. ¢
*

*/

#include <stdlib. h:
#include <string. h*
#include <stdars. h
#include “stm3Zflxx_hal. h”
#include “cmsis_os. h

Minclude “infra_types. h”
#include Tinfra_defs.h
Binclude “wrappers_defs. h”
Binclude “at_srapper. h

b de fine EXANFLE_PRODIET_KEY . ES
fi de Fine EXANFLE_PRODUCT_SECRET o ey T
b de fine EXANFLE_DEVICE_NANE
fidefine EXANFLE_DEVICE_SECRET L | |
define EXANPLE_FIFNRARE_VERSION  ~app-l.0.0-20120118. 10007

#define RING_BUFFER_SIZE (128)

#define HAL_SEN_MAXK COUNT (10}
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@ Note If you are not using the NUCLEO-F103RB demo board, set FEATURE AT TCP HA
L SIM800=n .You also need to implement the following HAL functions in the wrappers.c
file.

int HAL AT CONN Close (int fd, int32 t remote port)
int HAL AT CONN Deinit (void)
int HAL AT CONN DomainToIp (char *domain, char ip[16])
int HAL AT CONN Init (void)
int HAL AT CONN Send(int fd, uint8 t *data, uint32 t len, char remote ip[16], i
nt32 t remote port, int32 t timeout)
int HAL AT CONN Start(at conn t *conn)
int32 t HAL AT Uart Deinit (uart dev t *uart)
int32 t HAL AT Uart Init (uart dev t *uart)
int32 t HAL AT Uart Recv(uart dev t *uart, void *data, uint32 t expect size, ui
nt32 t *recv _size, uint32 t timeout)
int32 t HAL AT Uart Send(uart dev t *uart, const void *data, uint32 t size, uin
£32_t timeout)
int HAL GetDeviceName (char device name[IOTX DEVICE NAME LEN])
int HAL GetDeviceSecret (char device secret[IOTX DEVICE SECRET LEN])
int HAL GetFirmwareVersion (char *version)
int HAL GetProductKey (char product key[IOTX PRODUCT KEY LEN])
void *HAL Malloc(uint32 t size);
void HAL Free (void *ptr);
void *HAL MutexCreate (void)
void ls osa mutex destroy(void *mutex)
void HAL MutexLock (void *mutex)
void HAL MutexUnlock (void *mutex)
void *HAL SemaphoreCreate (void)
void HAL SemaphoreDestroy (void *sem)
void HAL SemaphorePost (void *sem)
int HAL SemaphoreWait (void *sem, uint32 t timeout ms)
int HAL ThreadCreate (void **thread handle,
void * (*work routine) (void *),
void *arg,
hal os thread param t *hal os thread param,
int *stack used)
void HAL SleepMs (uint32 t ms)
void ls osa print(const char *fmt, ...)
int HAL Snprintf (char *str, const int len, const char *fmt, ...)
uint64 t HAL UptimeMs (void)

3. Add the file to the IAR project.

84
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=l ® stm321103_simB00tcp - stm321103_simB00tcp v

XX API reference img TC)

s/0s/ubuntu/HAL TCP_linux.c

& axamples

| & & infra

| @ & mat

| & & wrappars .
"s on
e yWog2E®™

WB00icp map Jp— i
. "N K “wZRj

app- -201901 000

juarc_ring_buffer_t:

extern UART HandleTypeDef huartl;

statioc uint8_t g_

typedet

void

stm32f103_sim800icp <

4. Runthe project to performatest.

Afterthe project is completed, the following figure shows device logs.

Low Power Timer Stort
signal guality is
+L50: 2.8

o
netmork registrotion is

+(REG: @,1

eheck
+CEATT: 1

'y port=[1883])

Arrived:
Topic
Payload: hel

Inthe loT Platform console, choose Maintenance > Device Log. The Device Log page also shows
logs that are generated each time the device reports data to loT Platform.

1.10. Connect a bare-metal device to
loT Platform by using TCP

1.10.1. Overview

This topic describes how to use device SDK for Cto connect a bare-metal microcontroller device to IoT
Platform by using Message Queuing Telemetry Transport (MQTT).

Implementation
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Connect an MCU to a communication module and use AT commands for communication between the
MCU and the communication module. Use device SDK for C to connect the communication module to
lIoT Platform and enable communication between each other.

- D AT ]

- = commands oo MQTT

=11 - ()

- @ C€0678

Vs f

MCU+RTOS Communication module loT Platform

Prepare software and hardware
You must prepare the following items.

e A NUCLEO-F103RB demo board that is equipped with an STM32F103 MCU from ST.

e An SIM800C mini V2.0 demo board that is equipped with a SIM800C communication module from
SIMcom.

e The IAR Embedded Workbench for ARM development environment.

Procedure
Create a product and add a device
Build a development environment for devices

Provision a device

1.10.2. Create a product and add a device

This topic describes how to create a product, add a device to the product, and obtain certificate
information about the device in the IoT Platform console. The certificate information includes the
ProductKey, DeviceName, and DeviceSecret parameters. Certificate information about a device must be
added to a device SDK-based project. If a device attempts to communicate with IoT Platform, loT
Platformuses the certificate information about the device to authenticate the device.

Procedure

1. Logontothe loT Platformconsole.
2. Create a product.

i. Inthe left-side navigation pane, choose Devices > Products.

86 > Document Version: 20220624


https://www.st.com/content/st_com/en/products/microcontrollers-microprocessors/stm32-32-bit-arm-cortex-mcus/stm32-mainstream-mcus/stm32f1-series/stm32f103/stm32f103rb.html
https://www.st.com/en/evaluation-tools/nucleo-f103rb.html
https://simcom.ee/modules/gsm-gprs/sim800c
https://item.taobao.com/item.htm?spm=a1z10.5-c.w4002-6466605198.37.1c5063caZLVeD3&id=552488996692
https://www.iar.com/iar-embedded-workbench/#!?architecture=Arm
https://www.alibabacloud.com/help/doc-detail/146230.htm#task-2339606
https://www.alibabacloud.com/help/doc-detail/146228.htm#task-2339610
https://www.alibabacloud.com/help/doc-detail/146227.htm#task-2357185
http://iot.console.aliyun.com/

MBS & Best Practices- Device access

i. Onthe Products page, click Create Product, specify the required parameters, and click Save.
Parameter Description
Product Name The name of the product.
[DO NOT TRANSLATE] [DO NOT TRANSLATE]
Node Type Select Directly Connected Device.

Network Connection

Method Select Wi-Fi.
Data Type Select ICA Standard Data Format (Alink JSON).
Authentication Mode Select Device Secret.

3. Add a device to the product.
i. Inthe left-side navigation pane, choose Devices > Devices.

ii. Onthe Devices page, click Add Device to add a device to the product.

1.10.3. Build a development environment for

devices

This topic describes how to connect a microcontroller (MCU) to a demo board that includes a
communication module. It also describes how to build a development environment, create a project,
import a device SDK, and configure the project.

Context

The following figure shows the demo boards.

e NUCLEO-F103RB
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The following figure shows pins for the demo board.
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The following figure shows pins for the demo board.

Power GSM_RF
o (EmErE E ) o
%Ejﬂ""""lm R
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®|PWR - -
®|sTa '[_., ]
®| GND fnnnn
o po EREREE__ [ ]
®| XD .'f
®| EN '
M| VIN O
5 B i
Pin Description
PWR Power switch. Automatic power-on is enabled by default.
STA Status.
GND Ground.
RXD Receive data.
TXD Transmit data.
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Pin Description
EN Enable.
VIN 5V to 18 Vinput.

Connect demo boards

Connect the RXD pin of a demo board to the TXD pin of the other demo board. This allows you to
establish a connection and run AT commands. The following figure shows how to connect the demo
boards.

Build a development environment

T his section uses the STM32CubeMX tool as an example. For more information, visit STM32Cube
Ecosystem.

1. Openthe STM32CubeMX tool and click New Project.
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PR=TE
» :
st @ File window Hel (a3) n k I'¢
CubeMX b o u , ’l
Existing Projects New Project Manage software installations

Check for STM32Cubeid

CHECK FOR UPDATES

Install or remove embedd.

INSTALL / REMOVE

Open Existing Projects E‘f

| need to :

ACCESS TO BOARD SELECTOR

art o . for Industrial and loT applications

ACCESS TO CROSS SELECTOR

Lyr

STM3IZMP1

2. Onthe Board Selector tab, search for NUCLEO-F103RB and click STM32F103RBTx.

MK Hew Project from a Boeard

Board Filters
[E\ El, O Features Large Picture Docs & Resources Datasheet Buy Start Project
Ql Q
Part Mumber Search ~
ow multicore STM32MP1 Se
Q [ucLEO-FiDIRE ~ for Industrial and loT applications
Wendot >
Type > ,’
STM32MP1
MCUMPU Series >
Other hd
Price =10.32
L
Oscillatar Freq. =0 (WHz) Boards List: 1 item ¢ Export
P
- Marksting Status Unit Price (US$) Mourted Devics
MUCLEO-F103RB Mucleobd Active 1032 ETMIZF103RET
Perigheral hd
%]

3. Inthe upper-right comer, click Start Project.

4. Inthe left-side navigation pane, click Connectivity, select USART 1 as the port for communication
between the MCU and the communication module. Set the following parameters:

o Set Mode to Asynchronous.
o Inthe Configuration section, set the following parameters:
m Onthe GPIO Settings tab, select PA9 and PA10 in the Pin field.
m Onthe NVIC Settings tab, set USART 1 global interrupt to Enabled.
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(T

GENERATE CODE

Pinout & Configuration . gu
Additional Softwares ~ Pinout
USART1 Mode and Configuration

@ Pinout view System view

oy x G

q
System Core Mode Asynchronous '
Hardware Flow Control (RS232) |Disable
Analog
Timers
Comectivity
CAN
12C1
1zcz -
@ sPI1 o
SPI2 USART1 global interrupt 8 |0
” USARTa STMIZF10JRET:
Use
Computing
Middleware
5. Onthe Project Manager tab, specify the required parameters in the Project section.
o Set Toolchain/IDE to EWARM V8.
o Set Heap/Stack size based on your business requirements.
File Help © Flow

Untitled - Project Manage GENERATE CODE

Pinout & Configuration Clock Configuration | Project Manager

Project Settings
Project Name

=BT p
Project Location
C\Usersstemy ht\Desktop\Referencel
Application Structure
Basic [[] Do not generate the main()

Toolchain Folder Location
C\Users'sstgag hi\Desktop\Reference'stm321103_simB800tcp’
Code Generator

Teoichain / IDE
EWARM V&

Linker Settings
Minimum Heap Size 0x400

Minimum Stack Size  0x800

Mcu and Firmware Package
Mcu Reference
STM32F103RBTx

Firmware Package Name and Version
STM32Cube FW F1V1.7.0

6. Inthe upper-right corner, click GENERATE CODE to generate code for the project.

1.10.4. Provision a device

This section describes how to use the Link SDK for C to connect a communication module to loT
Platform.

Procedure
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1. Download Link SDK 3.0.7 for C.
2. Extract code fromthe SDK package. T his section uses Linux as an example.
i. Runthe make menuconfig command.

i. Select ATM Configurations and clickSelect.

iii. Select AT HAL Configurations and clickSelect.
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iv. Set the following parameters:

FEATURE_PLATFORM HAS STDINT=y
FEATURE INFRA STRING=y
FEATURE_INFRA NET=y

FEATURE INFRA LIST=y

FEATURE INFRA LOG=y

FEATURE INFRA LOG ALL MUTED=y
FEATURE INFRA LOG MUTE FLil=y
FEATURE_INFRA LOG MUTE DBG=y
FEATURE INFRA LOG MUTE INF=y
FEATURE_INFRA LOG_MUTE WRN=y
FEATURE INFRA LOG MUTE ERR=y
FEATURE_INFRA LOG MUTE CRT=y
FEATURE INFRA TIMER=y
FEATURE INFRA SHA256=y
FEATURE INFRA REPORT=y
FEATURE INFRA COMPAT=y
FEATURE DEV_SIGN=y
FEATURE MQTT COMM ENABLED = y
FEATURE MQTT DEFAULT IMPL=y
FEATURE MQTT DIRECT = y
FEATURE_DEVICE MODEL CLASSIC=y
FEATURE ATM ENABLED=y
FEATURE AT TCP ENABLED=y
FEATURE AT PARSER ENABLED=y
FEATURE AT TCP HAL SIM800=y
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3.

v. Afterthe configuration is complete, runthe ./extract.sh script to exact the code.

MEX M5

hubenglrlEebYLHT : ~/c-sdk$ ./extract.sh

. Download request sent, waiting respond ...
. Respond generating, wait longer

. Retried 1/20

% Total % Received % Xferd Average Speed Time Time Time Current
Dload Upload Total Spent Left Speed
100 107k 100 107k 0 0 408k 0 ——t==1== =—=i==i== —=1=-=:1-= 408k

Please pick up extracted source files in [/diskl/huteng/c-sdk/output]

The code is saved in the output/eng directory.

[f =S v 1 304087 : ~/c-sdk/output/eng$ 1s
atm dev_sign infra mgtt sdk include.h wrappers

The following table lists the subdirectories that reside in the directory.

Directory Description

atm Includes code that you can use to send and receive AT instructions.
dev_sign Includes code that you can use to authenticate devices.

infra Includes code that you can use to implement internal functions.

matt Includes code that you can use to implement the MQ Telemetry
q Transport (MQTT) protocol.
Includes code that you can use to implement hardware abstraction layer

rappers
wrapp (HAL) functions.

In the wrappers directory, create a file named wrappers.c. Implement the following HAL functions in

the file.

int32 t HAL AT Uart Deinit (uart dev t *uart)

int32 t HAL AT Uart Init (uart dev t *uart)

int32 t HAL AT Uart Recv(uart dev_t *uart, void *data, uint32 t expect size,
uint32 t *recv size, uint32 t timeout)

int32 t HAL AT Uart Send(uart dev_t *uart, const void *data, uint32 t size,
uint32 t timeout)

int HAL GetFirmwareVersion (char *version)

int HAL GetDeviceName (char device name[IOTX DEVICE NAME LEN])

int HAL GetDeviceSecret (char device secret[IOTX DEVICE SECRET LEN])

int HAL GetProductKey (char product key[IOTX PRODUCT KEY LEN])

void *HAL Malloc (uint32 t size);

void HAL Free (void *ptr);

void *HAL MutexCreate (void)

void HAL MutexDestroy(void *mutex)

void HAL MutexLock (void *mutex)

void HAL MutexUnlock (void *mutex)

void HAL Printf (const char *fmt, ...)

void HAL SleepMs (uint32 t ms)

int HAL Snprintf (char *str, const int len, const char *fmt, ...)

uint64 t HAL UptimeMs (void)
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Download a sample wrappers.c file.

The following figure shows how to specify the certificate information about the serial device in the

file.

e

* HITE:

Ll

* HAL TCP_xxx API reference implementation: wrappers/os/ubuntuw/HAL_TCP_linux. o
L
-/
Hinclude <stdlib. h
#include <string. h>
#include <stdarg. h>

include “stm32flxx_hal. h”
include “cmsis_os. h”

#include “infra_types.h”
#include "infra defs h”
finclude “wroppers_defs. h”
#include "at_srapper h”

fdefine EXANPLE PRODICT_KEY "2l Dt kT _

define EXANPLE_PRODUCT _SECRET AL 2y Wog 2B

fdefine EXANPLE DEVICE_NANE “exanple”

pdefine EXANPLE DEVICE_SECRET TSR N RS

define EXANPLE FIRNRARE VERSION "app-1. 0, 0-20190118, 10007
pdefine RING_BUFFER_SIZE (128)

define HAL SEN_NAX_COUNT (1o

® Note If you are not using the SIM800C communication module, add the FEATURE AT TCP
_HAL_sTM800=n statement, and implement the following HAL functions.

int HAL AT CONN Close (int fd, int32 t remote port)

int HAL AT CONN Deinit (void)

int HAL AT CONN DomainToIp (char *domain, char ip[16])

int HAL AT CONN Init (void)

int HAL AT CONN Send(int fd, uint8 t *data, uint32 t len, char remote ip[16], int32

_t remote port, int32 t timeout)

int HAL AT CONN Start (at conn t *conn)
int32 t HAL AT Uart Deinit (uart dev t *uart)
int32 t HAL AT Uart Init (uart dev t *uart)

int32 t HAL AT Uart Recv(uart dev t *uart, void *data, uint32 t expect size, uint32

_t *recv size, uint32 t timeout)

int32 t HAL AT Uart Send(uart dev t *uart, const void *data, uint32 t size, uint32

t timeout)

int HAL GetDeviceName (char device name[IOTX DEVICE NAME LEN + 1])
int HAL GetDeviceSecret (char device secret[IOTX DEVICE SECRET LEN + 1])

int HAL GetFirmwareVersion (char *version)

int HAL GetProductKey (char product key[IOTX PRODUCT KEY LEN + 1])

void *HAL Malloc(uint32 t size);
void HAL Free (void *ptr);

void *HAL MutexCreate (void)

void HAL MutexDestroy(void *mutex)
void HAL MutexLock (void *mutex)

void HAL MutexUnlock (void *mutex)
void HAL Printf (const char *fmt, ...)
void HAL SleepMs (uint32 t ms)

int HAL Snprintf (char *str, const int len, const char *fmt,

uint64 t HAL UptimeMs (void)

4. Add the file to the IAR project.

-)
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=l ® stm321103_simB00tcp - stm321103_simB00tcp v

XX API reference img TC)

/os/ubuntu/MAL_TICP linux.c

& axamples

| & & infra

| & mqrt

| o wTappars .
" s lh”
e L yWog2E®™

W 00tcp map - e
. "N E “wZR)

"app- -201901 000

juart_ring_buffer_t:

extern UART HandleTypeDef huartl;

statioc uint8_t g_

typedet
void

stm32f103_sim800icp <

. Runthe project and test data communication.

Afterthe test is successful, the device logs are displayed, as shown in the following figure.

Low Power Timer Stort
signal guality is
+L50: 2.8

o
netmork registrotion is

+(REG: @,1

eheck
+CEATT: 1

'y port=[1883])

Arrived:
Topic
Payload: hel

Inthe loT Platform console, choose Maintenance > Device Log to view logs generated when the
device reports datato loT Platform.

1.11. Connect a serial device to loT
Platform by using a DTU device

1.11.1. Overview

loT Platform can communicate with serial devices. You can use data transmission unit (DT U) devices to
connect serial devices to IoT Platform without changing communication protocols for these serial
devices.
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Scenarios

Devices for serial communication are used in a variety of scenarios, such as manufacturing, agriculture,
healthcare, city, building, and industrial parks. Before you connect these devices to loT Platform, you
must enable communication between these devices and loT Platform. However, t he serial
communication protocols used by these devices cannot be changed to communicate with loT Platform.
Therefore, data can be parsed only on the cloud. To connect these devices to IoT Platform, Alibaba
Cloud works with hardware partners to provide a solution to communication between the serial devices
and loT Platform. This solution allows you to use DT U devices as proxies to enable communication
between serial devices and IoT Platform by using simple configurations.

This topic uses a motor speed controller as an example to describe how to connect a serial device with
loT Platform by using a DT U device. This device complies with the integration standard of IoT Platform.

Implementation

To connect a serial device to loT Platform, specify the certificate information of the serial device in a
DTU device. Use the DTU device as a proxy for communication between the serial device and loT
Platform. Connect the serial device to the DTU device by using a serial port. Connect the DTU device to
loT Platformoverthe 2G, 3G, 4G, 5G, or Ethernet network. Use the DTU device as a proxy to enable
communication between the serial device and loT Platform.

The following figure shows how to connect a serial device to loT Platform by using a DTU device.

MQTT

-[ Modbus
. Teyw .

Sensor DTU loT Platform

Procedure

1. Configure a product and a device.
2. Configure a DTU device.

3. Test data communication.

1.11.2. Configure a product and a device

This article describes how to create a product whose data type is custom, create a device forthe
product, obtain the device certificate, define a Thing Specification Language (TSL) model, and then
write a data parsing script. After you performthese operations, you can connect the device to loT
Platform by using a data transmission unit (DT U) device.

Create a product and a device

Inthe loT Platform console, create a product and a device, and obtain the device certificate. The
device certificate consists of a ProductKey, a DeviceName, and a DeviceSecret.

1. Logontothe loT Platformconsole.
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2.

3. Inthe left-side navigation pane, choose Devices > Products. On the Products page, click Create
Product and create a product.

Product information

Parameter

Product

Category

Node Type

Network Connection

Method

Data Type

Authorization Mode

Description

The name of the product. Example: VariableFrequencyMotor.

Select Custom Category.

Select Directly Connected Device.

Select Cellular (2G / 3G / 4G / 5G).

Select Custom.

Select Device Secret.

4. Inthe left-side navigation pane, choose Devices > Devices. On the Devices page, click Add Device

Define a TSL model

and create a device for the product.

Afterthe device is created, go to the Devices page. Find the created device and click View in the
Actions column. On the Device Details page, view the information about the device certificate.
The device certificate will be configured to the DTU device. Keep it properly.

In this example, the RotateSpeed, Current, and RotateSpeedSet properties are defined for a variable
frequency motor. For more information about TSL-related concepts, see What is a TSL model?.

1. Logontothe loT Platform console.n the left-side navigation pane, choose Devices > Products.

2.
3.

Onthe Products page, find the created product and click View in the Actions column.

Onthe Product Details page, clickthe Define Feature tab, and then click Edit Draft. On the Edit

Draft page, clickAdd Self-defined Feature.

publish the TSL model.
Feature Feature
Type Name
Propertie RotateSp
S eed
Propertie

P Current

s
Propertie RotateSp
s eedSet

Identifier

speed

current

setspeed

Write a data parsing script

Data
Type

int32

int32

int32

Value
Range

0 ~ 3000

0~ 300

0 ~ 3000

Step

. Create the properties that are described in the following table. Then, click Release online to

. Read/Wri
Unit
te Type
) Read-
r/min
only
A Read-
only
) Read/Wri
r/min
te
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loT Platform processes data of the AlinkJSON format. If devices communicate with loT Platform by
using DT U devices, loT Platform cannot process pass-through data that is sent fromthe devices.

loT Platform provides the data parsing feature. This feature allows you to convert the customformat
of upstreamdata into the AlinkJSON format and the format of downstream data into the custom
format of your device. To use the data parsing feature, you must write a data parsing script in the loT
Platform console and submit the script to loT Platform. You must write a data parsing script based on
upstream and downstream data.

1. Onthe Product Details page, clickthe Data Parsing tab.

2. Onthistab, set the Script Language parameter next to Edit Script toJavaScript (ECMAScript
5). Then, enter a data parsing script in the code editor.

For more information about how to write a data parsing script, see Submit a data parsing script.

In this example, a device sends data of the hexadecimal format to loT Platform. Therefore, you
must use a data parsing script to convert upstream data of the hexadecimal format into data of
the AlinkJSON format and downstream data of the AlinkJSON format into data of the hexadecimal
format.

The following code provides an example on how to write a data parsing script:

var ALINK ID = "12345";
var ALINK VERSION = "1.1";
var ALINK PROP_POST METHOD = 'thing.event.property.post';

// var ALINK EVENT TEMPERR METHOD = 'thing.event.TempError.post';

// var ALINK EVENT HUMIERR METHOD = 'thing.event.HumiError.post';

var ALINK PROP SET METHOD = 'thing.service.property.set';

// var ALINK SERVICE THSET METHOD = 'thing.service.SetTempHumiThreshold';

/‘k‘k‘k‘k‘k‘k

* Upstream data:
* 0102 // Two bytes in total * Results:
* {"method":"thing.event.TempError.post","id":"12345", "params" : {"Temperature": 2},"vers
ion":"1.1"}
* Upstream data:
* 0202 // Two bytes in total * Results:
* {"method":"thing.event.HumiError.post","id":"12345", "params" : {"Humidity":2}, "version
"er1.1M)
Y
/* The rawDataToProtocol () function converts upstream data that is submitted by a devic
e into TSL data of the Alink JSON format. */
function rawDataToProtocol (bytes) {
/* Convert upstream data into an array. Upstream data is stored in the bytes object
*/
var uint8Array = new Uint8Array (bytes.length);
for (var i = 0; i < bytes.length; i++) {

uint8Array[i] = bytes[i] & O0xff;
}
var params = {}; // Create an object to store device pro
perties.
var JjsonMap = {}; // Create an object to define the forma

t of an Alink message.

/* Specify header fields for an Alink message. */

jsonMap|['version'] = ALINK VERSION; // The version number of the Alink prot
ocol.

jsonMap['id'] = ALINK ID; // The ID of the Alink message.
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jsonMap [ 'method'] = ALINK PROP_POST METHOD; // The method that is used to submit de
vice properties.

/* Specify properties for the Alink message. */

params['speed'] = uint8Array(0]; // Convert the first received byte into
the value of the RotateSpeed property.

params|['current'] = uint8Array[1l]; // Convert the second received byte int

o the value of the Current property.

jsonMap|['params'] = params; // Pack the required parameters to a JS
ON array.
return jsonMap; // Return the results to IoT Platform.

}
// The following code describes helper functions:
function buffer uint8 (value)
{
var uint8Array = new Uint8Array(1l);
var dv = new DataView (uint8Array.buffer, 0);
dv.setUint8 (0, wvalue);
return [].slice.call (uint8Array);
}
function buffer intlé6(value)
{
var uint8Array = new Uint8Array(2);
var dv = new DataView (uint8Array.buffer, 0);
dv.setIntl6 (0, value);
return [].slice.call (uint8Array);
}
function buffer int32 (value)
{
var uint8Array = new Uint8Array (4);
var dv = new DataView (uint8Array.buffer, 0);
dv.setInt32 (0, wvalue);
return [].slice.call (uint8Array);
}
function buffer float32 (value)
{
var uint8Array = new Uint8Array(4);
var dv = new DataView (uint8Array.buffer, 0);
dv.setFloat32 (0, value);
return [].slice.call (uint8Array);
}
/* The protocolToRawData () function converts downstream data into hexadecimal data that
can be recognized by the device. */
function protocolToRawData (json)
{
var method = json['method'];
var id = json['id'];
var version = json['version'];
var payloadArray = [];
if (method == ALINK PROP SET METHOD) // If the device receives the Set Device Pr
operties command from IoT Platform, the following code is run:
{
var send params = json['params'];
var prop_cur = send params|['setspeed']; // Specify the received value for the

prop cur parameter.
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// Concatenate raw data based on the custom format.
payloadArray = payloadArray.concat (buffer uint8(0x55)); // The first byte that
indicates the header of a message.
payloadArray = payloadArray.concat (buffer uint8 (prop bool)); // The second byte
that indicates the value of a property.
}

return payloadArray; // Send values to the device.

}

function transformPayload (topic, rawData) {
var jsonObj = {};
return jsonObj;
}
3. Test the script.
o Parse datathat is submitted by a device.
a. Select Upstreamed Device Data fromthe Simulation Type drop-down list.
b. Onthe Input Simulation tab, entertest data in the field.

The preceding script specifies the first byte as the value of the RotateSpeed property and
the second byte as the Current property. If you enter 6410, the first byte 64 indicates that
the rotating speed is 100 RPM and the second byte 10 indicates that the electric current is
16 A.

c. ClickRun.

The Parsing Results tab displays the results, as shown in the following figure.

Input Simulation Parsing Results

Simulation TypeUpstreamed Device Data

o Parse datathat is sent fromIoT Platform.

a. Select Received Device Data fromthe Simulation Type drop-down list.
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b. Onthe Input Simulation tab, entertest data in the field. Sample downstream data:

{

"method": "thing.service.property.set",
"id": "12345",

"version": "1.0",

"params": {

"setspeed": 123

}

. ClickRun.
The Parsing Results tab displays the results, as shown in the following figure.

Input Simulation Parsing Results

Simulation TypeUpstreamed Device Data

4. Afteryou confirmthat test data can be parsed by the script as expected, click Submit to submit
the script to IoT Platform.

@ Note IoT Platform cannot use scripts that are in the draft state. Before IoT Platform can
use a script to parse data, you must submit the script.

What's next

Configure a DTU device
1.11.3. Configure a DTU device

This topic describes how to use a data transmission unit (DT U) configuration toolto configure a serial
port for a DTU device, obtain the device certificate information, and connect the DTU device to loT
Platform. The certificate information includes the ProductKey, DeviceName, and DeviceSecret
parameters.

Context

This section uses an F2x16 DT U device as an example. You can use a PC to simulate the DTU device for
data communication. Connect the DTU device to the PC by using a USB to serial adapter cable.
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(@ Note Make sure that the DTU device is connected to the Intemet.

Procedure

1. Connect the DTU device to a USB port of the PC.

2. Onthe PC, openthe DTU configuration tool. This topic uses an F2x16 configuration tool as an
example.

. Set avalid port number, set a baud rate, and open a serial port.
. Clicklogin configuration to bring DTU into the configuration state.

. ClickRead Configuration to obtain the current settings of the DTU device.

OO U A~ W

. Onthe right side of the Configuration window, click Serial Port to configure a serial port.
@ Note Youmust select PORT inthe Protocol field.

7. ClickloT Integration and specify the certificate information of the device and the name of the
region where the device resides. You can obtain the information fromthe IoT Platform console.

8. Click Apply to apply the settings.
If you failto apply the settings, click Exit and try again later.
9. Afterthe configuration is complete, click Exit to switch the DTS device to the normal mode.

10. Power off and then power onthe DTU device. If the Online LED of the DTU device lights up, it
indicates that the DTU device is connected to IoT Platform.

You can also view the status of the DTU device in the loT Platform console.

What's next

Test data communication
1.11.4. Test data communication

This topic describes how to use a data transmission unit (DTU) as a device to report datato loT
Platform and receive data fromIoT Platform.

Test data reporting
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1. Start asierial port debugging tool. This topic uses sscomv4.2 as an example.

@ Note Before you use the debugging tool to simulate data sending and receiving, you
must exit the DTU configuration tool.

2. Set the required parameters for the debugging tool, open a serial port, and then click Send.

Set the spinning speed and electric current parameters based on the TSL model you created in loT
Platform. Then, send the values of the parameters to lIoT Platform. Set the spinning speed to 150,
electric current to 10 A. In the debugging tool, enter the following hex digits in sequence: 96 and

0A.

3. Afterdatais sent, turn on the Real-time Refresh switch.

i. Logontothe loT Platform console. In the left-side navigation pane, choose Devices >
Devices.

ii. Find the target device and click View.

ii. Onthe Device Details page, choose TSL Data > Status, and turn on the Real-time Refresh
switch.
Wait a few minutes until the uploaded data is displayed.

Test data receiving

On the Debug Physical Device tab, send a command to set the spinning speed, and test data
receiving for the DT U device.

1. Logontothe loT Platformconsole. In the left-side navigation pane, choose Maintenance >
Online Debug.

2. Select the device that you want to debug and click the Debug Physical Device tab.

3. Select the spinning speed property in the Debug Feature field, select Set inthe Method field, enter
avalue, and then clickSend Command.

4. Afterthe command is sent, view the received data in the debugging tool for the DTU device.

If data is displayed as expected in both the loT Platform console and the device, it indicates a
successful configuration.

1.12. Connect environmental sensors
to loT Platform by using HTTPS

Devices can be connected over HTTPS to loT Platform only in the China (Shanghai) region. The HTTPS
communication method is available only for scenarios where devices report data to loT Platform. Only
the POST request method is supported. A device can report a maximum of 128 KB of data at a time.

Context

This topic describes how to enable communication between a device and loT Platform by using HTTPS
and report data fromthe device to loT Platform. It uses an environmental sensor as an example.
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HTTPS

loT Platform

Create a product and add a device

Inthe loT Platform console, create a product, add a device to the product, create a Thing Specification
Language (TSL) model, and obtain certificate information about the device. The certificate information
includes the ProductKey, DeviceName, and DeviceSecret parameters.

1. Logontothe loT Platformconsole.

2. Inthe left-side navigation pane, choose Devices > Products. On the Products page, click Create
Product to create a product.

Parameter Description

Product Name The name of the product.

[DO NOT TRANSLATE] [DO NOT TRANSLATE]

Node Type Select Directly Connected Device.

Network Connection

Method Select Wi-Fi.
Data Type Select ICA Standard Data Format (Alink JSON).
Authentication Mode Select Device Secret.

3. Afterthe product is created, click Create TSL.

4. Onthe Define Feature tab of the Product Details page, choose Edit Draft > Add Self-
defined Feature to add properties.

The environmental sensor will report temperature data and humidity data. Therefore, you must
add the following properties.

Feature Feature . Value Read/write
Identifier Data type Step
type name range type

Temperatu temperatur .
Property . R int32 -10to 50 1 Read-only

Property Humidity humidity int32 1to 100 1 Read-only

5. Afterthe TSL modelis created, click Release Online to publish the TSL model.

6. Inthe left-side navigation pane, click Devices and click Add Device to add a device to the

> Document Version: 20220624 105


https://iot.console.aliyun.com

Best Practices-Device access MIBEMTE

product.

Afterthe device is added, obtain the values of ProductKey, DeviceName, and DeviceSecret

parameters.

Send data from a device to a topic

Use HTTPS to enable communication between a device and IoT Platform and use POST requests to
report temperature data and humidity data.

1. Obtain a device token.

When a device attempts to communicate with lIoT Platform, loT will authenticate the device. After
the authentication is complete, a device token is returned. The token is required when the device
reports datato loT Platform.

The following table lists the parameters that you must specify to obtain a device token.

Parameter

method

uri

productKey

deviceName

clientld

timestamp

signmethod

sign

Description
The request method. You must specify POST for the parameter.
Specify https://iot-as-http.cn-shanghai.aliyuncs.com/auth.

The product key. You can obtain the information from the Device Details page
of the IoT Platform console.

The name of the device. You can obtain the information from the Device Details
page of the loT platform console.

The client ID. The ID can be a maximum of 64 characters in length. The ID can be
the MAC address or SN of the device. The following sample code uses the

random() function to generate a random ID.

The timestamp. The following sample code uses the now() function to obtain a
timestamp.

The type of the algorithm. Valid values: hmacmd5 and hmacshat.

The signature. Use the following function to generate a signature.

password = signHmacShal (params, deviceConfig.deviceSecret)

Use the following code to obtain a device token.
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var

rp = require ('request-promise');

const crypto = require('crypto');

const deviceConfig = {

}

productKey: "<yourProductKey>",
deviceName: "<yourDeviceName>",

deviceSecret: "<yourDeviceSecret>"

//Obtain a token.

rp (getAuthOptions (deviceConfiqg))

.then (function (parsedBody) {
console.log ('Auth Info :',parsedBody)

})
}) .catch(function (err) {

console.log ('Auth err :'+JSON.stringify(err))

}) i

//Specify the required parameters for authentication.

function getAuthOptions (deviceConfig) {

}

const params = {
productKey: deviceConfig.productKey,
deviceName: deviceConfig.deviceName,

timestamp: Date.now(),

clientId: Math.random() .toString(36) .substr(2),

}
//Specify the required parameters.

var password = signHmacShal (params, deviceConfig.deviceSecret);

var options = {

method: 'POST',

uri: 'https://iot-as-http.cn-shanghai.aliyuncs.com/auth',

"body": {
"version": "default",
"clientId": params.clientId,
"signmethod": "hmacShal",
"sign": password,
"productKey": deviceConfig.productKey,
"deviceName": deviceConfig.deviceName,
"timestamp": params.timestamp

s

json: true

}i

return options;

//HmacShal sign

function signHmacShal (params, deviceSecret) {

let keys = Object.keys (params) .sort () ;
// Sort parameters in the alphabetical order.
keys = keys.sort();
const list = [];
keys.map ( (key) => {
list.push( ${key}${params[key]l}");
}) 7
const contentStr = list.join('');

return crypto.createHmac ('shal', deviceSecret)

.update (contentStr)

.digest ('hex"') ;
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Afteryou specify the required parameters in the code, run the code to initiate device
authentication. If the authentication is successful, a device token is returned.

! g 1 $ node device-https.js
Auth Info : { code:
info: { token: ': : I Tt b40139

L
message: 'success'

@ Note A device token will expire after seven days. Make sure that you have solutions to
token expiration issues.

2. Report data fromthe device.
After a device is authenticated, a token is returned. You can specify the token for the password
parameter that is required for data reporting.
The following table lists the parameters that you must specify to report data.
Parameter Description
method The request method. You must specify POST.
The syntaxis https://iot-as-http.cn-shanghai.aliyuncs.com/topic + top
ic .The URL consists of the HTTP endpoint of IoT Platform and the name of a
topic.
uri The second topic specifies the name of a topic of the following syntax:
/sys/${deviceConfig.productKey}/${deviceConfig.deviceName}/thing/e
vent/property/post
body The datato report.
password The device token.
Content-Type The content type of the data. Set the value to application/octet-stream.
The following code shows how to report data.
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const topic = ‘/sys/${deviceConfig.productKey}/${deviceConfig.deviceName}/thing/event/p
roperty/post’;
//Report data.
pubData (topic, token, getPostDataf())
function pubData (topic, token, data) {
const options = {

method: 'POST',

uri: 'https://iot-as-http.cn-shanghai.aliyuncs.com/topic' + topic,

body: data,

headers: {

password: token,

'Content-Type': 'application/octet-stream'

}
rp (options)
.then (function (parsedBody) {
console.log ('publish success :' + parsedBody)
})
.catch (function (err) {
console.log ('publish err ' + JSON.stringify(err))
}) i
}
// Create test data that conforms to the TSL model.
function getPostData () {
var payloadJson = {
id: Date.now(),
params: {
humidity: Math.floor ((Math.random() * 20) + 60),
temperature: Math.floor ((Math.random() * 20) + 10)
}y
method: "thing.event.property.post"
}
console.log ("===postData\n topic=" + topic)
console.log (payloadJdson)

return JSON.stringify (payloadJdson) ;

Afteryou specify the required parameters in the code, run the code to report data. Then, view the
results in local logs.

$ node device-https.js

ifdlced' },

ent/property

To find the temperature data and humidity data that are reported fromthe device, follow these
steps: Log onto the IoT Platform console. Go to the Device Details page. View the data onthe
Status tab. If data is displayed as expected, it indicates that the device is connected to loT
Platform and the data is reported.

For more information about HTTPS communication, see Establish connections over HT TPS.
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1.13. Connect a Linux device to loT
Platform

You can directly compile and run the demo in the device SDK for C on a Linux device to connect to loT
Platform by using Message Queuing Telemetry Transport (MQTT). T his article describes how to
configure and connect a Linux device to IoT Platform. In the following example, the demo in the device
SDK for Cis compiled on a device that runs the Ubuntu x86_64 operating system.

Context

For more information about the device SDK for C, see Overview.

Create a product and a device

1. Logontothe loT Platformconsole.

2.

3. Inthe left-side navigation pane, choose Devices > Products. On the Products page, click Create
Product to create a product.

Parameter Description
Product Name The name of the product.
Node Type Select Directly Connected Device.

Network Connection

Method Select Wi-Fi.
Data Type Select ICA Standard Data Format (Alink JSON).
Authorization Mode Select Device Secret.

4. Inthe left-side navigation pane, choose Devices > Devices. On the Devices page, click Add

Device to add a device to the product.
Afterthe device is added, obtain the certificate information of the device. The certificate
information includes the ProductKey, DeviceName, and DeviceSecret.

Create a TSL model

In the package of the device SDK for C provided by IoT Platform, you can obtain a JSON file that
contains a complete sample Thing Specification Language (TSL) model. In the following example, the
JSON file is imported to apply the TSL model to the product.
1. Edit the JSON file.
i. Download the package of the device SDK for C.

ii. Decompress the package and openthe model for examples.jsonfile inthe src/dev_model/ex
amples directory.
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iii. Specify the value of the ProductKey that you obtain fromIoT Platformfor the productKey
parameter in the JSON file. Then, save the file.

jotx-tal oss-gp-scoutheast-1.alivuncs,com/achema.json™,

"productEey"™: "alpkctattasn

method":"thing.service.property.set"”,

T
true,
Ilas‘l.:l:llr

"desc™:"PropertySettinga”™

2. Logontothe IoT Platform console. Onthe Products page, find the product that you created
earlier and click View in the Actions column.

3. Onthe Define Feature tab of the Product Details page, click Edit Draft and thenImport.

4. Inthe Import TSL dialog box, clickthe Import TSL tab, upload the JSON file that you edited in the
preceding step, and then click OK.

Import TSL X

ﬂ MNote: The features of the imported TSL will cover the previous features

Copy Product Import TSL

* Select Product
Select a product W

* Select Version
W

Afterthe file is imported, all features that are defined in the JSON file appear on the Edit Draft
page.
5. ClickRelease online to publish the TSL model.

Configure the SDK demo

> Document Version: 20220624 111



Best Practices-Device access MIBEMTE

Copy the package of the device SDK for C to the Linux device. Decompress the package and modify the
device information in a configuration file.

1. Inthe wrappers/os/ubuntu directory, specify the certificate information of your device in the HAL_
0S linux.cfile.

PLATFORM_WAIT_INFINITE a

det DYNAMIC REGISTER
4 I0TX _PRODUCT _LEN 1]
t_secret X_PRO SECRET_LEN
e_name[IOTX_DEVICE_NAME_LEN 1]
evice_secret[IOTX_DEVICE_SECRET_LEN 1]

f DEVICE_MODEL_ EMNABLED

_product_key[ IOTX CT_KEY_LEN + 1]
_product_secret[IOTX_PRODUCT SECRET_LEN + 1]
_device_name[ L LEN + 1]
_device_secret[IOTX_DEVICE_SECRET_LEN 1]

T_KEY_LEN + 1]
DDUCT_SECRET_LEN + 1]
| DEVICE_NAME_LEN + 1]
secret[IOTX DEVICE SECRET LEN + 1]

_ftirmware_version[IOTX_FIRMWARE_VER_LEN]

2. Compile the SDK demo. In the root directory of the SDK, run the make reconfig command, enter 3,
and then run the make command.

rootl infc-sdk-v3.0.1# make reconfig
SELECT A CONFIGURATION:

1) config.alios.esp8266

config.alios.mk3@8e
config.ubuntu.x86

) z

3. Runthe SDK demo.

In the root directory of the SDK, runthe ./output/release/bin/linkkit-example-solo command.
The following figure shows the result.
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@ infc-sdk-v
establish tcp connection with server(hos
fd=3

"wersion™: T1.87,
“params™: [
{
"attrKey™: "SYS_LP_SDK_VERSION™,
"attrValue™: "3.8.17,
“domain”: “SYSTEM"

"attrKey™: "SYS_SDK_LANGUAGE",
“attrvalue": "C",
"domain™: "SYSTEM"
}
1,

"method”: "thing.deviceinfo.update”

>
>
>
>
>
>
>
>
>
>
>
>
>
>
>
>
>

.foutput/release/bin/linkkit-example-solo
( t-as-mgtt.cn-shanghai.al s.com’, port=[1883])

Afterthe SDK demo is run, log onto the IoT Platform console. On the Device Details page, view

the device status and the TSL data reported by the device.
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2.Communications

2.1. Use custom topics for
communication

You can create custom topic categories in the lIoT Platform console. Then, a device can send messages
to a customtopic that belongs to a topic category. Your server can receive the messages by using an
AMQP SDK. Your server can also call the Pub APl operation to send commands to the device.
Communication based on customtopics does not use the TSL model. In this case, you can define the
data structure of the message.

Context

In this example, an electronic thermometer exchanges data with a server at a regular interval. The
thermometer sends the real-time temperature data to the server, and the server sends the precision
setting command to the thermometer.

E Precision setting command »4| Precision setting command

Current temperature [~ Current temperature [~] o o cm—

Thermometer loT Platform Server

Prepare the development environment

In this example, both devices and loT Platform use SDKs for Java. You need to prepare the Java
development environment first. You can download Java fromthe Java official website and install the
Java development environment.

Create a product and a device

1. Logontothe loT Platformconsole.
2. Inthe left-side navigation pane, choose Devices > Products.
3. ClickCreate Product to create athermometer product.

For more information, see Create a product.

4. Afterthe thermometer product is created, find it on the Products page and click View in the
Actions column.

5. Onthe Products Details page, clickthe Topic Categories tab. Then, you can create topic
categories for the product.

For more information, see Custom topics.
In this example, you must define the following two topic categories:

o /${productKey}/${deviceName}/user/devmsg: Devices send messages to this topic. Set Device
Operation Authorizations to Publish for this topic category.

o /${productKey}/${deviceName}/user/cloudmsg: Devices subscribe to this topic. Set Device
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Operation Authorizations to Subscribe for this topic category.

6. Clickthe Server-side Subscription tab. Then, you can create an AMQP server-side subscription to
subscribe to Device Upstream Notification.

For more information, see Configure an AMQP server-side subscription.

7. Inthe left-side navigation pane, choose Devices > Devices. Then, you can add a thermometer
device to the thermometer product.

For more information, see Create a device.

The server receives messages from the device

The following figure shows how the server receives messages fromthe device.

Server 16T Platform Thermometer

1. Subscribestothe topic

2.1 Connects toloTPlatform

2.2 Publishes messages

3. The server receivesthe messages

T his section describes how to configure the server and the device to implement the process.

e The server receives messages from an AMQP client. Therefore, you must configure the AMQP client to
connect the client with loT Platform and enable the client to send messages.

For more information, see Connect an AMQP client to loT Platform.

The following example shows how to connect a Qpid JMS 0.47.0 client as an AMQP client to loT
Platform.

o Add the following Maven dependency:

<!-— amgp 1.0 gpid client -->
<dependency>
<groupId>org.apache.gpid</groupId>
<artifactId>gpid-jms-client</artifactId>
<version>0.57.0</version>
</dependency>
<!-— util for base64-—>
<dependency>
<groupIld>commons-codec</groupld>
<artifactId>commons-codec</artifactId>
<version>1.10</version>

</dependency>
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o Connect the client to IoT Platform and enable the client to listen for device messages. Sample

code:

e Configure the device SDK to connect the device with lIoT Platform and enable the device to send
messages.

o Specify the device authentication parameters.

final String productKey = "XXXXXX";

final String deviceName = "XXXXXX";
final String deviceSecret = "XXXXXXXXX";
final String region = "XXXXXX";

o Set the connection initialization parameters. These include the MQTT connection parameters,

o

device parameters, TSL model parameters.

LinkKitInitParams params = new LinkKitInitParams () ;

// Set the MQTT connection parameters. Link Kit uses MQTT as the underlying protocol.
IoTMgttClientConfig config = new IoTMgttClientConfig() ;

config.productKey = productKey;

config.deviceName = deviceName;

config.deviceSecret = deviceSecret;

config.channelHost = productKey + ".iot-as-mgtt." + region + ".aliyuncs.com:1883";
// Set the device parameters.

DeviceInfo deviceInfo = new DeviceInfo();

deviceInfo.productKey = productKey;

deviceInfo.deviceName = deviceName;

deviceInfo.deviceSecret = deviceSecret;

// Register the initial status of the device.

Map<String, ValueWrapper> propertyValues = new HashMap<String, ValueWrapper>();
params.mgttClientConfig = config;

params.deviceInfo = devicelInfo;

params.propertyValues = propertyValues;

Initialize the connection.

// Initialize the connection and configure the callback function that is used after the
initialization succeeds.
LinkKit.getInstance() .init (params, new ILinkKitConnectListener() {
@Ooverride
public void onError (AError aError) {
System.out.println("Init error:" + aError);
}
// Configure the callback function that is used after the initialization succeeds.
@override
public void onInitDone (InitResult initResult) {
System.out.println ("Init done:" + initResult);
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o Send a message fromthe device.

After a device connects to loT Platform, the device sends a message to the specified topic.
Replace the content of the onlnitDone function, as shown in the following example:

@Override

public void onInitDone (InitResult initResult) {

// Set the topic to which the message is published and the message content.
new MgttPublishRequest () ;

MgttPublishRequest request =

request.topic = "/" + productKey + "/" + deviceName + "/user/devmsg";

request.gos = 0;

request.payloadObj = "{\"temperature\":35.0,

\"time\":\"sometime\"}";

// Publish the message and configure the callback functions that are used after th

e message is published.

LinkKit.getInstance () .publish (request,

@Override

new IConnectSendListener () {

public void onResponse (ARequest aRequest, AResponse aResponse) {

System.out.println ("onResponse:" + aResponse.getDatal());

}

@Override

public void onFailure (ARequest aRequest, AError aError)

System.out.println ("onFailure:" + aError.getCode ()

The server receives the following message:

Message

{payload={"temperature":35.0,

"time":"sometime"},

topic="'/aluzcHO****/devicel/user/devmsg',
messageld="'1131755639450642944",

gos=0,

generateTime=1558666546105}

The server sends messages to the device

The following figure shows how the server sends a message to the device.

Thermometer

1.1 Connects toloTPlatfarm

1.2. 5ubscribes to thetopic

3. The devices receivesmessgges

16T Platform

2 Publishes messazes

e Configure the device SDK to subscribe to a topic.

Server

{
+ aError.getMsg()) ;
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For more information about how to specify device authentication parameters, set connection
initialization parameters, and initialize the connection, see the sample code in the The server receives
messages from the device section.

The device must subscribe to a specific topic before the device can receive messages sent by the
server.

The following example shows how to configure the device SDK to subscribe to a topic:

// Configure the callback function that is used after the initialization succeeds.
@QOverride
public void onInitDone (InitResult initResult) {

// Set the topic to which the device subscribes.

MgttSubscribeRequest request = new MgttSubscribeRequest () ;

request.topic = "/" + productKey + "/" + deviceName + "/user/cloudmsg";

request.isSubscribe = true;

// Send a subscription request and configure the callback functions that are used aft
er the subscription succeeds or fails.

LinkKit.getInstance () .subscribe (request, new IConnectSubscribelistener () {

@QOverride

public void onSuccess () {
System.out.println("");

}

@Override

public void onFailure (AError aError) ({
}
)i

// Set the listener that listens for subscribed messages.
IConnectNotifylListener notifyListener = new IConnectNotifylListener () {

// Configure the callback functions that are used after a subscribed message is r

eceived.

@Override

public void onNotify (String connectId, String topic, AMessage aMessage) {

System.out.println(
"received message from " + topic + ":" + new String((byte[])aMessage.getD

ata()));

}

@Override

public boolean shouldHandle (String s, String sl) {
return false;
}
@QOverride
public void onConnectStateChange (String s, ConnectState connectState) {
}
}i

LinkKit.getInstance () .registerOnNotifyListener (notifyListener) ;

e Configure the loT Platform SDK to enable loT Platformto publish a message by calling the Pub API
operation.
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o Specify identity verification information.

String regionId = "XXXXXX";
String accessKey = "XXXXXX";
String accessSecret = "XXXXXXXXX";
final String productKey = "XXXXXX";

o Set the connection parameters.

// Set the parameters of the client.

DefaultProfile profile = DefaultProfile.getProfile (regionId, accessKey, accessSecret);

IAcsClient client = new DefaultAcsClient (profile);

o Set the parameters that are used to publish a message.

PubRequest request = new PubRequest () ;

request.setQos (0) ;

// Set the topic to which the message is published.

request.setTopicFullName ("/" + productKey + "/" + deviceName + "/user/cloudmsg");

request.setProductKey (productKey) ;

// Set the MessageContent parameter. The message content must be encoded in Base64.

erwise, the message content will appear as garbled characters.

request.setMessageContent (Base64.encode ("{\"accuracy\":0.001,\"time\":now}"));

o Publish the message.

try {
PubResponse response = client.getAcsResponse (request) ;
System.out.println ("pub success?:" + response.getSuccess());
} catch (Exception e) {

System.out.println(e);

The device receives the following message:

msg = [{"accuracy":0.001,"time" :now}]

Appendix: demo

You can Download the Pub/Sub demo to view the demo for this example.

Oth

For more information about how to connect an AMQP client to loT Platform, see the following articles:

Connect aclient to loT Platform by using the SDK for Java
Connect aclient to loT Platform by using the SDK for .NET
Connect aclient to loT Platform by using the SDK for Node.js
Connect aclient to loT Platform by using the SDK for Python 2.7
Connect aclient to loT Platform by using the SDK for PHP
Connect aclient to loT Platform by using the SDK for Go

2.2. Remotely control a Raspberry Pi

server
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loT Platform allows you to implement pseudo-Intranet penetration to remotely control a Raspberry Pi
server that does not have a public IP address. This topic describes how to use IoT Platformto remotely
control a Raspberry Piserver, and provides sample code.

Context

For example, you use Raspberry Pito build a server in your company or at home to run some simple
tasks, such as starting a script or downloading files. If the Raspberry Piserver does not have a public IP
address and you are not in the company or at home, you cannot manage the server. If you use other
Intranet penetration tools, disconnections may frequently occur. To resolve this issue, you can use the
RRPC feature of IoT Platformtogether with the |Sch library to remotely control the Raspberry Piserver.

@ Note Inthis example, a product and a device in a public instance are used.

Process

1.Sends RRPC SSH command
IZ. Sends the command over M

E 3. Executes the 55H

command

4, Returns the result over MQTT,
I5.Return5 the result I

The following process shows how to use IoT Platformto remotely control a Raspberry Pi server:
1. Callthe loT Platform RRPC operation on your computer to send a Secure Shell (SSH) command.

2. AfterloT Platform receives the SSH command, lIoT Platform sends the SSH command to the
Raspberry Piserver over Message Queuing Telemetry Transport (MQTT).

3. The systemruns the SSH command on the server.

D

. The system encapsulates the result of the SSH command as an RRPC response on the server and
sends the response to loT Platformover MQTT.

Ul

. loT Platform sends the RRPC response to your computer.

@ Note The RRPC timeout period is 5 seconds. If IoT Platform does not receive a response from
the Raspberry Piserver within 5 seconds, a timeout error occurs. If you send a command that
requires a long period of time to process, ignore the timeout error message.

Download SDKs and sample code
Before you can remotely control the Raspberry Piserver, develop an loT Platform SDK and Link SDK.

e Install an loT Platform SDK on your computer. You can use the Java sample code to develop the loT
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Platform SDK.

e Install a Link SDK on the Raspberry Piserver. You can use the Java sample code to develop the Link
SDK.

The following sample code shows how to develop the loT Platform SDK and Link SDK.

@ Note The sample code supports only simple Linux commands, such as uname, touch, and mv.
Complex commands, such as the commands that are used to modify files are not supported. To use
complex commands, write code based on your business requirements.

Develop the Link SDK

Afteryou install the Link SDK and download the sample code, add project dependencies and the
required Java files.

The project can be exported as a JAR package and run on the Raspberry Piserver.

1. Add the following dependencies to the pom.xmifile:

<! -- Link SDK -->

<dependency>
<groupId>com.aliyun.alink.linksdk</groupId>
<artifactId>iot-linkkit-java</artifactId>
<version>1.1.0</version>
<scope>compile</scope>

</dependency>

<dependency>
<groupId>com.google.code.gson</groupIld>
<artifactId>gson</artifactId>
<version>2.8.1</version>
<scope>compile</scope>

</dependency>

<dependency>
<groupId>com.alibaba</groupId>
<artifactId>fastjson</artifactId>
<version>1.2.40</version>

<scope>compile</scope>

</dependency>

<! -- SSH client --—>

<!-- https://mvnrepository.com/artifact/com.jcraft/jsch —->
<dependency>

<groupId>com.jcraft</groupId>

<artifactId>jsch</artifactId>

<version>0.1.55</version>
</dependency>

2. Create afile named SSHShell javato run SSH commands.
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public class SSHShell {
private String host;
private String username;
private String password;
private int port;

private Vector<String> stdout;

public SSHShell (final String ipAddress, final String username, final String passwor

d, final int port) {
this.host = ipAddress;
this.username = username;
this.password = password;
this.port = port;
this.stdout = new Vector<String>();
}
public int execute (final String command) {
System.out.println ("ssh command: " + command) ;
int returnCode = 0;
JSch jsch = new JSch();
SSHUserInfo userInfo = new SSHUserInfo();
try {
Session session = jsch.getSession (username, host, port);
session.setPassword (password) ;
session.setUserInfo (userInfo) ;
session.connect () ;
Channel channel = session.openChannel ("exec");
( (ChannelExec) channel) .setCommand (command) ;

channel.setInputStream(null);

BufferedReader input = new BufferedReader (new InputStreamReader (channel.get

InputStream()));
channel.connect () ;
String line = null;
while ((line = input.readLine()) != null) ({
stdout.add (line) ;
}
input.close();
if (channel.isClosed()) {
returnCode = channel.getExitStatus() ;

}
channel.disconnect () ;
session.disconnect () ;

} catch (JSchException e) {
e.printStackTrace () ;

} catch (Exception e) {
e.printStackTrace () ;

}

return returnCode;

}
public Vector<String> getStdout () {

return stdout;

3. Create afile named SSHUserinfo.javato verify the SSH username and password.
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public class SSHUserInfo implements UserInfo {
@Override
public String getPassphrase () {
return null;
}
@Override
public String getPassword() {
return null;
}
@Override
public boolean promptPassphrase (final String arg0) ({
return false;
}
@override
public boolean promptPassword(final String arg0) ({
return false;
}
@override
public boolean promptYesNo (final String arg0O) {
if (arg0.contains ("The authenticity of host")) {
return true;
}
return false;
}
@verride
public void showMessage (final String arg0) {
}

4. Create afile named Device.javato establish an MQTT connection.

public class Device {

/**

* Establish a connection.

*

* @param productKey The ProductKey of the product.

* @param deviceName The DeviceName of the device.

* @param deviceSecret The DeviceSecret of the device.

* @throws InterruptedException

=y

public static void connect (String productKey, String deviceName, String deviceSecre

t) throws InterruptedException {

// Initialize parameters.
LinkKitInitParams params = new LinkKitInitParams () ;
// Configure the required parameters to establish an MQTT connection.
IoTMgttClientConfig config = new IoTMgttClientConfig() ;
config.productKey = productKey;
config.deviceName = deviceName;
config.deviceSecret = deviceSecret;
params.mgttClientConfig = config;
// Specify the certificate information about the device.
DeviceInfo deviceInfo = new DevicelInfo();
deviceInfo.productKey = productKey;

devicelInfo.deviceName = deviceName;
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deviceInfo.deviceSecret = deviceSecret;

params.deviceInfo = devicelInfo;

// Initialize a client.

LinkKit.getInstance () .init (params, new ILinkKitConnectListener () {
public void onError (AError aError) {

System.out.println("init failed !! code=" + aError.getCode() + ",msg="

+ aError.getMsg() + ",subCode="

+ aError.getSubCode () + ",subMsg=" + aError.getSubMsg());
}
public void onInitDone (InitResult initResult) {

System.out.println("init success !!");

}) 7
// Before you perform the following steps, make sure that the initialization is

complete. You can specify a reasonable value based on your business scenario.

Thread.sleep (2000) ;

* Send a message.

@param topic The topic to which the message is sent.

* @param payload The content of the message.

public static void publish (String topic, String payload) {

MgttPublishRequest request = new MgttPublishRequest () ;
request.topic = topic;

request.payloadObj = payload;

request.qgos = 0;

LinkKit.getInstance () .getMgttClient () .publish (request, new IConnectSendListener

@QOverride

public void onResponse (ARequest aRequest, AResponse aResponse) {
}

@Override

public void onFailure (ARequest aRequest, AError akError) {

* Subscribe to messages.

* @param topic The topic whose messages to which you want to subscribe.

public static void subscribe (String topic) {

MgttSubscribeRequest request = new MgttSubscribeRequest () ;
request.topic = topic;
request.isSubscribe = true;

LinkKit.getInstance () .getMgttClient () .subscribe (request, new IConnectSubscribel

istener () {

@Override

public void onSuccess () {
}

@override

public void onFailure (AError aError) {

1
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/**
* Unsubscribe from messages.
*
* @param topic The topic whose messages from which you want to unsubscribe.
v
public static void unsubscribe (String topic) {
MgttSubscribeRequest request = new MgttSubscribeRequest () ;
request.topic = topic;
request.isSubscribe = false;
LinkKit.getInstance () .getMgttClient () .unsubscribe (request, new IConnectUnscribe
Listener () {
@override
public void onSuccess () {
}
@Override

public void onFailure (AError aError) {

/**
* Terminate the connection.
=Y
public static void disconnect () {

// Deinitialize the parameters.

LinkKit.getInstance () .deinit();

5. Create a file named SSHDevice.java. The SSHDevice.javafile includes the main method that is used
to receive RRPC commands. You can also call ssushell to run SSH commands, and return RRPC
responses. In the SSHDevice.javafile, you must enter the device certificate information and the SSH
username and password. The device certificate information includes the ProductKey, DeviceName,
and DeviceSecret.

public class SSHDevice {

// The start of the segment in which you configure the required

parameters.

// The ProductKey of the product.

private static String productKey = "";

//

private static String deviceName = "";

// The DeviceSecret of the device.

private static String deviceSecret = "";

// The topic that you want to use for messaging. You can use the topic without the
need to create or define the topic.

private static String rrpcTopic = "/sys/" + productKey + "/" + deviceName + "/rrpc/
request/+";

// The endpoint or the IP address to which the SSH client needs to access.

private static String host = "127.0.0.1";

// The username that is used to log on to the SSH client.

private static String username = "";

// The password for the username.
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private static String password = "";

// The number of the port that is used to log on to the SSH client.

private static int port = 22;

// The end of the segment in which you configure the required pa

rameters.
public static void main(String[] args) throws InterruptedException {
// Listen to downstream data.
registerNotifyListener () ;
// Establish a connection.
Device.connect (productKey, deviceName, deviceSecret);
// Subscribe to a topic.
Device.subscribe (rrpcTopic) ;
}
public static void registerNotifyListener () {
LinkKit.getInstance () .registerOnNotifyListener (new IConnectNotifyListener () {
@Override
public boolean shouldHandle (String connectId, String topic) {
// Process messages only from specific topics.
if (topic.contains ("/rrpc/request/")) {
return true;
} else {

return false;

}
@Override
public void onNotify (String connectId, String topic, AMessage aMessage) {
// Receive RRPC requests and return RRPC responses.
try {
// Run a remote command.
String payload = new String((byte[]) aMessage.getData(), "UTF-8");
SSHShell sshExecutor = new SSHShell (host, username, password, port)

sshExecutor.execute (payload) ;
// Obtain the output of the command.
StringBuffer sb = new StringBuffer();
Vector<String> stdout = sshExecutor.getStdout () ;
for (String str : stdout) {

sb.append (str) ;

sb.append ("\n") ;
}
// Return the output to the server.
String response = topic.replace("/request/", "/response/");
Device.publish (response, sb.toString()):

} catch (UnsupportedEncodingException e) {

e.printStackTrace () ;

}
@Override
public void onConnectStateChange (String connectId, ConnectState connectStat
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Develop the IoT Platform SDK

Afteryouinstall the loT Platform SDK and download the sample code, add project dependencies and
the required Java files.

1. Add the following dependencies to the pom.xmifile:

) Notice Formore information about the latest version of the IoT Platform SDK, see Use
loT Platform SDK for Java.

<! -- IoT Platform SDK -—>

<dependency>
<groupId>com.aliyun</groupId>
<artifactId>aliyun-java-sdk-iot</artifactId>
<version>7.38.0</version>

</dependency>

<dependency>
<groupId>com.aliyun</groupId>
<artifactId>aliyun-java-sdk-core</artifactId>
<version>4.5.6</version>

</dependency>

<!-- commons-codec -->

<dependency>
<groupId>commons-codec</groupld>
<artifactId>commons-codec</artifactId>
<version>1.8</version>

</dependency>

2. Create afile named OpenApiClient javato call loT Platform APl operations.

public class OpenApiClient {
private static DefaultAcsClient client = null;
public static DefaultAcsClient getClient (String accessKeyID, String accessKeySecret

if (client != null) {
return client;
}
try {
IClientProfile profile = DefaultProfile.getProfile ("cn-shanghai", accessKey
ID, accessKeySecret);
DefaultProfile.addEndpoint ("cn-shanghai", "cn-shanghai", "Iot", "iot.cn-sha
nghai.aliyuncs.com") ;
client = new DefaultAcsClient (profile);
} catch (Exception e) {
System.out.println ("create OpenAPI Client failed !! exception:" + e.getMess
age());
}

return client;

3. Create afile named SSHCommandSender.java. The SSHCommandSender.javafile includes the main
method that is used to send SSH commands and receive responses to SSH commands. In the SSHCo
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mmandSender,javafile, you must specify the device certificate information, the AccessKey pair of
your Alibaba Cloud account, and SSH commands. The device certificate information includes the
ProductKey, DeviceName, and DeviceSecret.

public class SSHCommandSender {

// The start of the segment in which you configure the required

parameters.
// The AccessKey ID of your Alibaba Cloud account.
private static String accessKeyID = "";
// The AccessKey secret of your Alibaba Cloud account.
private static String accessKeySecret = "";
// The ProductKey of the product.
private static String productKey = "";
// The DeviceName of the device.
private static String deviceName = "";

// The end of the segment in which you configure the required pa

rameters.
public static void main(String[] args) throws ServerException, ClientException, Uns

upportedEncodingException {

// The remote Linux command.

String payload = "uname -a";

// Create an RRPC request.

RRpcRequest request = new RRpcRequest () ;

request.setProductKey (productKey) ;

request.setDeviceName (deviceName) ;

request.setRequestBaseb64Byte (Base64.encodeBase64String (payload.getBytes())) ;

request.setTimeout (5000) ;

// The client that is used to receive requests from the server.

DefaultAcsClient client = OpenApiClient.getClient (accessKeyID, accessKeySecret)

// Send an RRPC request.

RRpcResponse response = (RRpcResponse) client.getAcsResponse (request);

// Process RRPC responses.

// The result that is returned after the execution of the response.getSuccess ()
function indicates only that the RRPC request is sent. The returned response does not i
ndicate whether the request is received by the device or whether the device returned a
response based on the result.

// You must check the result based on the RRPC response code that is returned.
For more information, see https://www.alibabacloud.com/help/doc-detail/69797.htm.

if (response != null && "SUCCESS".equals (response.getRrpcCode())) {

// The output.
System.out.println (new String(Base64.decodeBaseb4 (response.getPayloadBase64
Byte()), "UTE-8"));

} else {

// Failed to obtain the output and print the related RRPC response code.
System.out.println (response.getRrpcCode()) ;
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2.3. Establish TSL-based
communhnication

You can establish Thing Specification Language (TSL)-based communication between devices and loT
Platform over the Alink protocol. Devices submit properties or events to IoT Platform, and IoT Platform
sends commands to devices to configure properties or call services. T his topic provides sample Java
code to describe how to establish TSL-based communication.

Prerequisites

e |oT Platformis activated.

e A Java development environment is installed.

Create a product and a device

You must create a product and a device, and define TSL features for the product.

1.

2
3.
4

Logontothe loT Platformconsole.

In left-side navigation pane, choose Devices > Products.

. Onthe Products page, click Create Product. On the Create Product page, specify a custom name

forthe product and select Custom Category. Use the default values for other parameters and
click OK.

For more information, see Create a product.

Onthe Product Details page of the product, click Define Feature. On the Define Feature tab,
define a TSL model.

In this example, an event, a service, and two properties are added to the Def ault Module section,
as shown in the following figure.

This topic provides a sample TSL model that you can import. For more information about how to
import a TSL model, see Batch add TSL features.

Audd self-defined feature Import TSL Wiew TSL Build device-side code

Feature Type Feature Name Identifier Data Type Data Definition Actions

Boolean value:

Properties Switch tdic Suvitch bool 0 - off Edit | Delete

l-on

Properties Calar hue int32 “Walue Range:l ~ 254 Edit | Delete

Services modify Modifyvehiclelnfo - Call Method: Asynchronous Invoke Edit | Delete

Events Offline Offline_alarm - Event Type:dlert Edit | Delete

. Inthe left-side navigation pane, click Devices. On the Devices page, click Add Device to create a

device.

You can use the sample code to batch configure device properties and batch call device services.
You must create at least two devices. For more information, see Create multiple devices at a time.

Download and install an SDK demo
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The SDK demo includes the server-side sample code and device-side sample code.

1.
2.

4.

Click iotx-api-demo to download the iotx-api-demo package and then decompress the package.

Start the Java development tool and import the decompressed iotx-api-demo folder.

. Add the following Maven dependencies to the pom.xmifile to import the loT Platform SDK and a

Link SDK:

<!-- https://mvnrepository.com/artifact/com.aliyun/aliyun-java-sdk-iot -->
<dependency>
<groupId>com.aliyun</groupId>
<artifactId>aliyun-java-sdk-iot</artifactId>
<version>7.33.0</version>
</dependency>
<dependency>
<groupId>com.aliyun</groupId>
<artifactId>aliyun-java-sdk-core</artifactId>
<version>3.5.1</version>
</dependency>
<dependency>
<groupId>com.aliyun.alink.linksdk</groupId>
<artifactId>iot-linkkit-java</artifactId>
<version>1.2.0</version>
<scope>compile</scope>
</dependency>

In the java/src/main/resources/ directory, open the configfile and specify the required information
forinitialization.

user.accessKeyID = <your accessKey ID>
user.accessKeySecret = <your accessKey Secret>
iot.regionId = <regionId>

iot.productCode = Iot

iot.domain = iot.<regionId>.aliyuncs.com
iot.version = 2018-01-20

Parameter Description

The AccessKey ID of your Alibaba Cloud account.

To create or view your AccessKey pair, perform the following steps: Log on

accessKeylD to the Alibaba Cloud Management console. Move the pointer over your
profile picture, and click AccessKey Management to go to the AccessKey
Pair page.

The AccessKey secret of your Alibaba Cloud account. You can obtain the

accessKeySecret .
AccessKey secret the same way you obtain the AccessKey ID.

The ID of the region where your IoT devices reside. For more information

regionld . )
9 about region IDs, see Regions and zones.

Submit properties and events by using Link SDK

Configure Link SDK to connect to loT Platform and submit properties and events.
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The ThingTemplatefile in the java/src/main/com.aliyun.iot.api.common.deviceApidirectory contains

the sample code.

e Specify the connection information.

Replace the values of the productKey, deviceName, and deviceSecret parameters in the sample code
with the information about your device certificate. Replace the value of the url parameter with your
MQTT endpoint. For more information about how to obtain an endpoint, see View the endpoint of an
instance. The endpoint must include port 1883.

public static void main(String[] args) {

/**
* The
4
String
String
String

/*TODO :

*/
String
/**

* The
4

information about the device certificate.

productKey = "your productKey";
deviceName = "your deviceName";
deviceSecret = "your deviceSecret";

Replace the following endpoint with the endpoint of your instance.

url = "iot-6d***gl.mgtt.iothub.aliyuncs.com:1883";

information about the MQTT connection.

ThingTemplate manager = new ThingTemplate() ;

DeviceInfo deviceInfo = new DeviceInfo();

deviceInfo.productKey = productKey;

deviceInfo.deviceName = deviceName;

deviceInfo.deviceSecret = deviceSecret;

/**
* The
*/

Java HTTP client supports TSLvl.2.

System.setProperty ("https.protocols"™, "TLSv2");

manager.init (deviceInfo, url);

e |Initialize the connection parameters.
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public void init (final DeviceInfo devicelInfo, String url) {

n about

LinkKitInitParams params = new LinkKitInitParams () ;
/**
* Configure the parameters for MQTT initialization.
=/
IoTMgttClientConfig config = new IoTMgttClientConfig();
config.productKey = deviceInfo.productKey;
config.deviceName = devicelnfo.deviceName;
config.deviceSecret = deviceInfo.deviceSecret;
config.channelHost = url;
/**
* Specify whether to receive offline messages.
* The cleanSession field that corresponds to the MQTT connection.
=/
config.receiveOfflineMsg = false;
params.mgttClientConfig = config;
ALog.setLevel (LEVEL DEBUG) ;
ALog.i (TAG, "mgtt connetcion info=" + params);
/**
* Configure the initialization parameters and specify the certificate informatio
the device.
*/
params.deviceInfo = devicelInfo;
/** Establish a connection. **/
LinkKit.getInstance () .init (params, new ILinkKitConnectListener () {
public void onError (AError aError) {
Alog.e (TAG, "Init Error error=" + aError);
}
public void onInitDone (InitResult initResult) {
ALog.i (TAG, "onInitDone result=" + initResult);
List<Property> properties = LinkKit.getInstance () .getDeviceThing () .getP

roperties () ;

ts();

ALog.i (TAG, "The device properties" + JSON.toJSONString (properties));
List<Event> getEvents = LinkKit.getInstance () .getDeviceThing () .getEven

ALog.i (TAG, "List of device events" + JSON.toJSONString (getEvents)) ;
/* Submit properties. TODO: Make sure that the properties that you want t

o submit are defined in the TSL model of the product. Example: MicSwitch. Otherwise, an e

rror message is returned. */

handlePropertySet ("MicSwitch", new ValueWrapper.IntValueWrapper (1)) ;
/* Submit events. TODO: Make sure that the events that you want to submit

are defined in the TSL model of the product. Example: Offline alarm. Otherwise, an error

message

is returned. */
Map<String,ValueWrapper> values = new HashMap<>();
values.put ("eventValue",new ValueWrapper.IntValueWrapper (0)) ;
OutputParams outputParams = new OutputParams (values) ;

handleEventSet ("Offline alarm",outputParams) ;
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@ Note The property and event identifiers in the code must be the same as the identifiers
that are defined in the TSL model.

e Configure Link SDK to submit properties.

JHx
* The device submits properties in the Alink JSON format.
* @param identifier: the identifier of the property.
* @param value: the value of the property.
* Q@return
*/
private void handlePropertySet (String identifier, ValueWrapper value ) {
ALog.i (TAG, "Identifier of the property=" + identifier);
Map<String, ValueWrapper> reportData = new HashMap<>();
reportData.put (identifier, wvalue);
LinkKit.getInstance () .getDeviceThing () .thingPropertyPost (reportData, new IPublish
Resourcelistener () {
public void onSuccess (String s, Object o) {
// The property is submitted.
ALog.1i (TAG, "Submitted. onSuccess() called with: s = [" + s + "], o = ["
+ o+ "I");
t
public void onError(String s, AError aError) {
// The property value failed to be submitted.
ALog.i (TAG, "Failed to submit. onError() called with: s = [" + s + "], aE
rror = [" + JSON.toJSONString(aError) + "]");
}
}) i

e Configure Link SDK to submit events.
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/**
* The device submits events in the Alink JSON format.
* @param identifier: the identifier of the event.
* (@param params: the parameters of the event.
* @return
*/
private void handleEventSet (String identifyID, OutputParams params ) {
ALog.1i (TAG, "Identifier of the event=" + identifyID + " params=" + JSON.toJSONSt
ring (params)) ;
LinkKit.getInstance () .getDeviceThing () .thingEventPost ( identifyID, params, new I
PublishResourcelistener () {
public void onSuccess (String s, Object o) {
// The event is submitted.
ALog.i (TAG, "Submitted. onSuccess() called with: s = [" + s + "], o = ["
+ o+ "I");
}
public void onError (String s, AError aError) {
// Failed to submit the event.
ALog.i (TAG, "Failed to submit. onError () called with: s = [" + s + "], aE
rror = [" + JSON.toJSONString(aError) + "]1");
}
)i

Send commands to configure properties and call services by using an
loT Platform SDK

e |[nitialize a client.

The lotClient file in the java/src/main/com.aliyun.iot.client directory contains the sample code.
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public class IotClient {
private static String accessKeyID;
private static String accessKeySecret;
private static String regionId;
private static String domain;
private static String version;
public static DefaultAcsClient getClient () {
DefaultAcsClient client = null;
Properties prop = new Properties();
try {
prop.load(Object.class.getResourceAsStream("/config.properties")) ;
accessKeyID = prop.getProperty ("user.accessKeyID");
accessKeySecret = prop.getProperty ("user.accessKeySecret");
regionId = prop.getProperty("iot.regionId") ;
domain = prop.getProperty ("iot.domain") ;
version = prop.getProperty("iot.version");
IClientProfile profile = DefaultProfile.getProfile (regionId, accessKeyID, accessKey
Secret) ;
DefaultProfile.addEndpoint (regionId, regionId, prop.getProperty("iot.productCode"),
prop.getProperty ("iot.domain")) ;
// Initialize the client.
client = new DefaultAcsClient (profile);
} catch (Exception e) {
LogUtil.print ("Failed to initialize the client. exception:" + e.getMessage());
}

return client;

public static String getRegionId() ({
return regionId;

}

public static void setRegionId(String regionId) {
TotClient.regionId = regionId;

}

public static String getDomain () {
return domain;

}

public static void setDomain (String domain) {
IotClient.domain = domain;

}

public static String getVersion () {
return version;

}

public static void setVersion (String version) {

IotClient.version = version;

e Initialize the CommonRequest public class.

The AbstractManagerfile inthe java/src/main/com.aliyun.iot.api.common.openApidirectory
encapsulates the CommonRequest public class.
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public class AbstractManager ({
private static DefaultAcsClient client;
static {
client = IotClient.getClient();
}
/**
* 1Initialize the CommonRequest class. action: the name of the API operation.
* domain: the endpoint.
* version: the API version.
“Y
public static CommonRequest executeTests (String action) {
CommonRequest request = new CommonRequest () ;
request.setDomain (IotClient.getDomain()) ;
request.setMethod (MethodType.POST) ;
request.setVersion (IotClient.getVersion());
request.setAction (action) ;

return request;

e C(Callthe APl operations of IoT Platformto configure properties and call services.

The ThingManagerforPopSDkfile in the java/src/main/com.aliyun.iot.api.common.openApidirectory
contains the sample code.

o Callthe SetDeviceProperty operation to configure a device property.

public static void SetDeviceProperty (String Instanceld, String IotId, String ProductKey
, String DeviceName , String Items) {
SetDevicePropertyResponse response =null;
SetDevicePropertyRequest request=new SetDevicePropertyRequest () ;
request.setDeviceName (DeviceName) ;
request.setIotId(IotId);
request.setItems (Items) ;
request.setProductKey (ProductKey) ;
request.setIotInstancelId(Instanceld) ;
try {
response = client.getAcsResponse (request) ;
if (response.getSuccess() != null && response.getSuccess()) {
LogUtil.print ("The device property is configured.");
LogUtil.print (JSON.toJSONString (response)) ;
} else {
LogUtil.print ("Failed to configure the device property.");
LogUtil.error (JSON.toJSONString (response)) ;
}
} catch (ClientException e) {
e.printStackTrace () ;
LogUtil.error ("Failed to configure the device property." + JSON.toJSONStrin
g (response)) ;

}
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o Callthe SetDevicesProperty operation to batch configure device properties.

/**
* Batch configure device properties.
*
* @param ProductKey: the ProductKey of the product to which the devices whose prop
erties you want to configure belong.
* @param DeviceNames: the DeviceNames of the devices whose properties you want to
configure.
* @param Items: the property information that consists of multiple pairs of key-va
lue JSON strings. This parameter is required.
*
* @Des: the description.
=y
public static void SetDevicesProperty (String InstanceId, String ProductKey, List<St
ring> DeviceNames, String Items) {
SetDevicesPropertyResponse response = new SetDevicesPropertyResponse () ;
SetDevicesPropertyRequest request = new SetDevicesPropertyRequest () ;
request.setDeviceNames (DeviceNames) ;
request.setItems (Items);
request.setProductKey (ProductKey) ;
request.setIotInstanceld (Instanceld) ;
try {
response = client.getAcsResponse (request) ;
if (response.getSuccess() != null && response.getSuccess()) {
LogUtil.print ("The properties are batch configured.");
LogUtil.print (JSON.toJSONString (response)) ;
} else {
LogUtil.print ("Failed to batch configure the device properties.");
LogUtil.error (JSON.toJSONString (response)) ;
}
} catch (ClientException e) {
e.printStackTrace () ;
LogUtil.error ("Failed to batch configure the device properties." + JSON.toJ
SONString (response)) ;
}

o Callthe InvokeThingService operation to call a device service.
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/**
* @param Identifier: the identifier of the service. This parameter is required.
* @param Args: the input parameters that are required to start the service. This p
arameter is required.
wy
public static InvokeThingServiceResponse.Data InvokeThingService (String Instanceld,
String IotId, String ProductKey, String DeviceName,
String Identifier,
String Args) {
InvokeThingServiceResponse response =null;
InvokeThingServiceRequest request = new InvokeThingServiceRequest () ;
request.setArgs (Args) ;
request.setDeviceName (DeviceName) ;
request.setIotId(IotId);
request.setIdentifier (Identifier);
request.setProductKey (ProductKey) ;
request.setIotInstanceld(Instanceld) ;
try {
response = client.getAcsResponse (request) ;
if (response.getSuccess() != null && response.getSuccess()) {
LogUtil.print ("The service is executed.");
LogUtil.print (JSON.toJSONString (response)) ;
} else {
LogUtil.print ("Failed to execute the service.");
LogUtil.error (JSON.toJSONString (response)) ;
}
return response.getData () ;
} catch (ClientException e) {
e.printStackTrace () ;

LogUtil.error ("Failed to execute the service." + JSON.toJSONString (response

}

return null;

@ Note I you want to synchronously call services, set the Invoking Method parameterto
Synchronization when you define TSL models. When you develop devices, you must write the
code to process synchronous service calls.
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o Callthe InvokeThingsService operation to batch call device services.

/**
* @param Identifier: the identifier of the service. This parameter is required.
* @param Args: the input parameters that are required to start the service. This p
arameter is required.
=y
public static void InvokeThingsService (String InstanceId, String IotId, String Prod
uctKey, List<String> DeviceNames,
String Identifier, String Args) {
InvokeThingsServiceResponse response =null;
InvokeThingsServiceRequest request = new InvokeThingsServiceRequest () ;
request.setArgs (Args) ;
request.setIdentifier (Identifier);
request.setDeviceNames (DeviceNames) ;
request.setProductKey (ProductKey) ;
request.setIotInstanceld(Instanceld) ;
try {
response = client.getAcsResponse (request) ;
if (response.getSuccess() != null && response.getSuccess()) {
LogUtil.print ("The services are called.");
LogUtil.print (JSON.toJSONString (response)) ;
} else {
LogUtil.print ("Failed to batch call the services.");
LogUtil.error (JSON.toJSONString (response)) ;
}
} catch (ClientException e) {
e.printStackTrace () ;
LogUtil.error ("Failed to batch call the services." + JSON.toJSONString (resp

onse)) ;

Sample request:
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public static void main (String[] args) {

/** The DeviceName of the online device and the Productkey of the product to which
the online device belongs. */

String deviceName = "2pxuAQB2I7wGPmgg***";

String deviceProductkey = "alQbjI2***";

/** If you use an Enterprise Edition instance or a public instance of the new versi
on, specify the instance ID for the Instanceld parameter. To obtain the instance ID, log on
to the IoT Platform console and view the instance ID on the Overview page.

* If you use a public instance of the old version, leave the Instanceld parameter
empty"".
*/

String Instanceld = "iot-***tl02";

//1. Configure a device property.

SetDeviceProperty (Instanceld, null, deviceProductkey, deviceName,"{\"hue\":0}");

//2. Batch configure device properties.

List<String> deviceNames = new ArrayList<>();

deviceNames.add (deviceName) ;

SetDevicesProperty (Instanceld, deviceProductkey, deviceNames, "{\"hue\":0}");

//3. Call a device service.

InvokeThingService (InstancelId, null, deviceProductkey, deviceName, "ModifyVehiclelIn
fo", "{}");

//4. Batch call device services.

List<String> deviceNamesService = new ArrayList<>();

deviceNamesService.add (deviceName) ;

InvokeThingsService (null, deviceProductkey, deviceNamesService, "ModifyVehicleInfo"
s ")

}

Debug the SDKs
After you configure the Link SDK and the IoT Platform SDK, run the SDKs.
Check results:

e View local logs.
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main(Stringl] args) {

yropertymap =new Hashp

propertymap)

propertymaphiames =i Hash
5. put )

ProductManager main()

3-BFDB-4F5A-AF4C-BD61DCFECGAL" , "Data" : {"MessageId" : "895138926"}, "Success" : true}

977-C064-40D4-BDAE-80B76C4996D1" , "'Success" : true}

e Onthe Device Details page of the device, click Def ault Module.

o The Status tab displays the property values that the device most recently submitted.

o The Events tab displays the events that the device most recently submitted.

o TheInvoke Service tab displays the records of service calls.

laT Platform

Querview
Devices
Products
Devices
Groups
Rules
DataAnalysis
Edge Management

Developrent

Devices » Device Details

TSLtest

HEWEE view Copy

Device Inforrmation Topic List Status Events Irvoke Senice Device Shadow Manage Files

Status

mic View Data colar View Data

0 (off) 0

e

Device Log Online Debugging

2.4. Communication between devices

2.4.1. M2M communication

The machine-to-Machine (M2M) technology is used to achieve end-to-end communication. T his article
describes how to build an M2M communication architecture in IoT Platform by using the data
forwarding feature of the rules engine or the topic-based message routing service. A connection
between a smart lamp and a mobile app is used as an example.

loT Platform handles communication requests between the device and the app. This allows you to
focus on your business system. You do not need to worry about technical issues such as guaranteeing
stable communication in high-concurrency scenarios or maintaining a large number of servers to handle

requests.

For more information, see the following topics:
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e Use the rules engine to establish M2M communication

e Use topic-based message routing to establish M2M communication

2.4.2. Use the rules engine to establish M2M
communication

This article describes how to use the data forwarding feature of the rules engine in IoT Platformto
build an machine-to-machine (M2M) communication architecture. A connection between a smart lamp
and a mobile app is used as an example.

Context

The following figure shows how to control the smart lamp by using the mobile app.

1. Signintheappand the seryer returns the devi ce information of the App.

| 2 Usethe appto scanthe QR code onthe bulb, and the serwer returns the deviceMame of the bulb.
T m s m e | | T Tr T
Z l6T Platform ; i Server
. HTTPS I . .
ITO[:NC. ! ! Lser mamegement
5. The app sends a command.) fal987654321/ControlAppfuser
App The deviceMame ofthe bulb is -fl:ommand
included inthe command. i Device mAmEEEMENt
Rules ! : Autharization
4 Forwardsthe command to ) _ rmEmEge ment
the destinationtopic Engme 1
Dewice mEEtEtion
ol . MQTT : ! :
- - ' Topic: fal123456789/light/user f sete——rmH i . Devie cancelition
= 5. The bulb receives the : ! !
command. i : : !
Bulb et et it
Procedure

1. Inthe loT Platform console, create a product and device for the smart lamp and define the
features of the product. For more information, see Create a product, Create multiple devices at a time,
and Add a TSL feature.

In this example, the ProductKey and DeviceName parameters of the smart lamp are respectively
set to al123456789 and light.

2. Develop a device SDK for the smart lamp.
In this example, the device and IoT Platform use MQTT to communicate with each other.
For information about how to develop a device SDK, see the Link SDK documentation.

3. Inthe IoT Platform console, create a product and a device for the mobile app.

In this example, the ProductKey and DeviceName parameters of the mobile app are respectively
set to al987654321 and ControlApp.

When a registered user logs on to the mobile app, your server sends the device information to the
mobile app. T his way, the mobile app can connect to lIoT Platform as a device.
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4. Develop the mobile app.

In this example, the mobile app and IoT Platform use HTTPS to communicate with each other.

Format of a command that the mobile app sends to the smart lamp:

{

}

"TargetDevice": "light",
"Switch": "off",
"Timestamp": 1557750407000

5. Develop the device SDK to connect the smart lamp with loT Platform, receive the command, and
implement the command.

6. Configure a data forwarding rule to forward the command from the mobile app to the topic of the
smart lamp.

i.
i.
iii.
iv.

V.

Logontothe loT Platform console. Choose Rules > Data Forwarding.

Click Create Rule. Inthe dialog box that appears, enter a rule name and click OK.
Inthe A flow rule has been created message, click Edit.

Onthe Data Forwarding Rule page, clickWrite SQL inthe Data Processing section.

Inthe Write SQL dialog box, write an SQL statement that is used to process the forwarded
message, and then click OK. You can use the SQL statement to extract required fields fromthe
message that is sent by the mobile app. Only the fields are sent to the smart lamp.

In this example, the TargetDevice, Timestamp, and Switch fields are extracted.

Write SGAL

Fule Query Expressian:

SELECT
FROM "falmty4 OigDAControlApplusencammand”
YWHERE

® Field:

TargetDevice, Switch, Timestamp

o Topic:

Custom
apptest
ContralApp
usercommand

Conditions {Optional)

o
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vi. Onthe Data Forwarding Rule page, click Add Operation inthe Data Forwarding section.
In the dialog box that appears, set a forwarding message destination. In this example, specify
a smart lamp topic that has the Subscribe permission as the destination.

@ Note
m Select Publish to another Topic.

m When you specify devices, use s{Targetbevice} to indicate all smart lamps. In
this example, s{Targetbevice} indicatesthe smart lamp named 1ight

Edit Cperation

Select Operation:

Fuhblish to anather Topic

* Topic &

Custam

atest

$TargetDeivce}

useriset

Cancel

7. The mobile app user scans the QR code to bind the app with the smart lamp.

Afterthe app sends a request to the serverto bind a device, the server binds the smart lamp and
returns the device name. The returned name is specified by the deviceName parameter. In this
example, the device name is light.

8. The mobile app user sends a command fromthe app.

i. The app sends the command to the topic in lIoT Platform. In this example, the topicis /a19876
54321 /ControlApp/user/update

ii. Then, IoT Platform sends the command to the topic of the smart lamp based onthe data
forwarding rule. In this example, the topicis /a1123456789/1ight/user/set

ii. The smart lamp device receives the commands and performs the required operations.

@ Note The app can also send a request to your serverto unbind the smart lamp device.
Afterthe device is unbound, you cannot use the app to control the smart lamp.

2.4.3. Use topic-based message routing to
establish M2M communication
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This article describes how to use the topic-based message routing service of IoT Platformto build an
M2M communication architecture. A connection between a smart lamp and a mobile app is used as an
example.

Context

The following figure shows how to control the smart lamp by using the mobile app.

1. Sign in the app and the server returns the device information of the App.

‘ 2. Usethe appto scan the CR code on the bulk, and the server returns the deviceName of the bulb.
loT Platform Server
HTTPS i . ! i
'TODIC: ! | Us er management
3. The app sends a command, /al987654321/ControlApp/user . ;
App The deviceMame of thebulb is :;"update
includedin the command. H . Device management
i | Autharizati
4 Routesthe commandto :ﬂes?ge —_— ;;n:;::z,:
the destination topic. outing
Device registration
Ly MOTT i i |
- O e, Topic: fal123456789/light/user/set «—— i . e —
=" 5. Thebulbreceivesthe ! ! i
cormrmand, i i i !
Bulb i et
Procedure

1. Inthe loT Platform console, create a product and device for the smart lamp and define the
features of the product. For more information, see Create a product, Create multiple devices at a time,
and Add a TSL feature.

In this example, the ProductKey and DeviceName parameters of the smart lamp are respectively
set to al123456789 and light.

2. Develop a device SDK for the smart lamp.
In this example, the device and loT Platform use MQTT to communicate with each other.
For information about how to develop a device SDK, see the Link SDK documentation.

3. Inthe IoT Platform console, create a product and a device for the mobile app.

In this example, the ProductKey and DeviceName parameters of the mobile app are respectively set
to al987654321 and ControlApp.

When a registered user logs on to the mobile app, your server sends the device information to the
mobile app. This way, the mobile app can connect to IoT Platform as a device.

4. Callthe CreateTopicRouteTable operation to create a message routing relationship between the
topics of the app and the smart lamp.

o Set the SrcTopic parameterto the topic of the app: /a1987654321/ControlApp/user/update

o Set the DstTopics parameter to the topic of the smart lamp: /a1123456789/1ight/user/set
5. Develop the mobile app.

In this example, the mobile app and IoT Platform use HTTPS to communicate with each other.

Format of a command that the mobile app sends to the smart lamp:
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"TargetDevice": "light",
"Switch": "off",
"Timestamp": 1557750407000
}
6. The mobile app user scans the QR code to bind the app with the smart lamp.

Afterthe app sends a request to the serverto bind a device, the server binds the smart lamp and
returns the device name. The returned name is specified by the deviceName parameter. In this
example, the device name is light.

7. The mobile app user sends control commands fromthe app.

i. The topic to which the app sends commandsis /a1987654321/ControlApp/user/update .OnNly
JSON format commands are supported.

ii. 10T Platform routes commands to the topic of the smart lamp device based on the defined
message routing relationship. The topicis /a1123456789/1ight/user/set

ii. The smart lamp device receives the commands and performs the required operations.

@ Note Youcan configure the mobile app to send an unbinding request to the server. This
way, the server calls the DeleteTopicRouteT able operation of IoT Platformto delete the
message routing relationship. After the routing relationship is deleted, you cannot use the app
to control the smart lamp.

2.5. Create an MNS server-side
subscription

This article describes how to create a Message Service (MNS) server-side subscription to push status
changes of the devices under a product to an MNS queue. Your server can receive the messages by
listening to the MNS queue.

Prerequisites

e The following Alibaba Cloud services are activated:
o |oT Platform
o MNS

e The Java development environment Eclipse is installed.

Context

The following figure shows data flows.
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Configure a server-side subscription

Inthe IoT Platform console, create an MNS server-side subscription and select the types of messages to
which you want to subscribe.

1.
2.
3.

Logontothe loT Platformconsole.

In the left-side navigation pane, choose Devices > Products. On the Products page, click Create
Product to create a product.

. Inthe left-side navigation pane, choose Devices > Devices. On the Devices page, click Add

Device to create a device under the product.

When you use Link SDK to develop a device, you must obtain the device certificate.

. Inthe left-side navigation pane, choose Rules Engine > Server-side Subscription. Onthe

Server-side Subscription page, click Create Subscription to create an MNS server-side
subscription. For more information, see Configure MNS server-side subscriptions.

@ Note The first time you select MNS in the Subscription Type field, a message prompts
you to authorize the access of IoT Platformto MNS. Click Authorize Now to go to the
Resource Access Management (RAM) console. Click Confirm Aut horization Policy.

Set the Message Type parameter to Device Status Change Notification. All messages about
status changes of the devices under the product are pushed to an MNS queue.

Afteryou create the subscription, IoT Platform automatically creates a queue in MNS. The queue is
used to receive messages fromloT Platform. The format of the queue nameis aliyun-iot-${your
Productkey} .Whenyou use an MNS SDK to listen to the messages of a queue, you must specify
the name of the queue.

On the Server-side Subscription page, move the pointer over the icon next to MNS to view the
name of a queue.

Create Subscription Tutorial All v

Product Name ProductKey

Queuealiyun-iot-a1LTo0q Created At Actions

MyLight allTo0q MNS Aug 3, 2020, 19:44:24 Edit | Delete

Use MNS SDK to receive messages
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In this example, MNS SDK for Java is used.

1. To download the SDK, see Release notes of the SDK for Java. Download the aliyun-sdk-mns-samples].
7.8 package, and then decompress the package.

2. Open Eclipse, click Import Project, and then select the aliyun-sdk-mns-samples directory.

3. Inthe C:\Users\${YourComputerUserNamef local directory, create the .aliyun-mns .properties file.
Add identity information in the following format to the file. The identity information is used by
MNS for authentication.

mns.accountendpoint=http://$your accountId.mns.$your regionId.aliyuncs.com
mns.accesskeyid=$your accesskeyid

mns.accesskeysecret=$your accesskeysecret

Parameter Description

. The endpoint of MNS. In the MNS console, select the region where the queue
accountendpoint . . . . . .
resides and click Get Endpoint to view the information.

The AccessKey ID of your Alibaba Cloud account.

To create or view your AccessKey pair, log on to the Alibaba Cloud

accesskeyid Management Console. Move the pointer over your profile picture, and click
AccessKey to go to the User Management page. On the page, you can
create or view your AccessKey pairs.

The AccessKey secret of your Alibaba Cloud account. Obtain the AccessKey

accesskeysecret .
4 secret in the same way as the AccessKey ID.

4. Add the following code to the ComsumerDemo file in the src\main\java\com.aliyun.mns.sample.Qu

eue directory. The code is used to specify the name of the queue that is automatically created by
loT Platform.
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public static void main (String[] args) {
CloudAccount account = new CloudAccount (
ServiceSettings.getMNSAccessKeyId(),
ServiceSettings.getMNSAccessKeySecret (),
ServiceSettings.getMNSAccountEndpoint ()) ;
MNSClient client = account.getMNSClient(); // Initialize the client.
// Retrieve messages.
try{
CloudQueue queue = client.getQueueRef ("aliyun-iot-aleN7La****");// Replace
this queue with the queue that is automatically created by IoT Platform.
for (int 1 = 0; 1 < 10; i++)
{
Message popMsg = queue.popMessage(); // The long polling period.
if (popMsg != null) {
System.out.println ("message handle:
" + popMsg.getReceiptHandle()) ;
System.out.println ("message body:
" + popMsg.getMessageBodyAsString()); // Retrieve the message payloads.
System.out.println ("message id:
" + popMsg.getMessagelId()) ;
System.out.println ("message dequeue count:"
+ popMsg.getDequeueCount ()) ; // <<to add your special logic.
>>
// Delete messages from the queue.
queue.deleteMessage (popMsg.getReceiptHandle () ) ;

System.out.println ("delete message successfully.\n");

5. Runthe ComsumerDemo file.

Configure a device SDK

1. To download a device SDK, see Download device SDKs. In this example, use the SDK for Java.

2. At the bottom of the Configure a project article, click Java SDK Demo to download the package,
and then decompress the package.

3. Inthe Java development tool, import the javalLinkKit Demo directory as a project.

4. Inthe device idfile, specify the device certificate information.

"productKey”
"deviceName"
"deviceSecre
"subDevice™: [
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5. Inthe MgttSamplefile of the src\devicesdk\demo directory, add the information about the device,
and specify the name of the topic to which device data is submitted.

MgttSample(String a

(aHETLEESTh, &

Mg ques W MgttPublishRequest();

request.topic / /" + productKey + "/" + deviceMame + °

6. Runthe MgttSample file to connect the device with lIoT Platform.

Verify the result

Afteryou run the code, a message indicating that the device is online is sent to the MNS queue. You can
use MNS SDK for Java to receive the message and then delete the message from the queue.

The following figure shows how to receive the message and then delete the message.

o - PN B0 R Q-BE-EE TP 18-l -
[# Package Explorer 532 | [J] ComsumerDeme. .. 2 HtipEndpoint. .. CloudPullTop. . . ¥y = 8 [E] Task List 52 = 8
= ":_./‘ = ; . aliyun.mns.sample.Queue; = B v‘ . %—| & |
242 alipun-sdicmns-samples . .
Z# 1. aliyun.mns. client. CloudAccount; =
E-4® sre/main java 12 ¥ il i | 4
=) ﬂ com. alizun. mns. sample 11 1ss ComsumerDemo { =4
1J] HttpEndpoint. java 12
! I - Q
#-1J] TawaSDEPerfTest. java 13- static wodd main{String[] args) { Find Q] b AL b hc..
[J] BueneSanple. java 14 .oudAccount account = new CloudAccount(
[1] Sanple. java 15 SEr\t:l:.cESEtt]:.ngs.get!‘WSAccEss&’eyId(),
Bl [7) TopicSanple. java 15 Ser\t::ceSettJ:ngs.getPWSAccess(eySEC{‘et(),
17 servicesettings. getMisAccountEndpoint()
5 ﬂ com. alizun. mns. sample. Buene 15 .
= " H
EREIRConunex Deno_java 19 IsClient client = account.getMNsClient(); //this client need only initi:_|]
[J] CreateQuevellens. java oA
|1] Deletefuencllens. java 21 " Demo for receive message code E; Dutline B2 = 8
[ ListGueueDeme. java ERIT -
[3] ProducerDemo. java £E] Cloudgueu$ queue = cliem.:.getQueueRef("aliyun—iot—a R ECTVE") ;S re 5 AR W e w |
[] Transacticilessagelens, je | 21 for (imt 1= @; 1 < 10; i)
[J] TransactieMessageleme2. - t
R . 25 Message popMsg = queuc. popMessage(); -
com. sliyun. nns. sanple. Topic | oo if (pophsg lo null){
i &l [J] ClondPullTepi cllema. java 28 System. out, println{"message handle: " + pophsg.getReceiptHant B com. aliyun mns. sample
o [w] README. md =) System.out. println{“message body: ™ + pophsg.getMessagebodyf: Bl @, Consumerlemo
[#-@i, Maven Dependencies &1 System.out. println{“message id: " + poplisg. getMessageld()); oo @ ¥ nain(Stringl1)
[#-B), JRE System Library [TavaSE-1 6] EXN System.out. println{“message dequeue count:™ + pophsg. getDeque
o sroftest/java Sz fi<<to add your special logic.»»
[H-§= sre -3 ]
— S firemember to delete message when consume message successfulw
B[ target A | E " ;
4] aliyun-sdlemns-sanples. inl Hi—
-J-@ pom. xml Problems (@ Javadoe [} Declaration [EJ Conzole 52 X% BEEREEE#B2-09-=0
™
[y JavalinkHi themo <terminated”> ComsumerDemo [Tava Agzlication] C:\Progam Files'Tava'jrel 5. 0 _ZF11\bin'javaw. exe (2013 5:30:35)
message handle: §-8zujB@GyRzZzozclz@z8MmzoyiQaxs7FLY =

message body: {“payleoad™:"eyIsYXN@YG1tZSIET IWMTRIMDCEMDIEMTRGN] AGMz AUMZASTINIdXR] TGFzdFRpbWULOL IYMDESL T)R:
message id: AFCFLEBDD9@S7FIL7CSDOMCDASCFTLE
message dequeue count:l

delete message successfully.

<l | S ET | [

2.6. Parse pass-through data from
devices
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In some loT scenarios, devices that have limited resources or low specifications cannot use Thing
Specification Language (TSL) models in the JSON format to communicate with IoT Platform. To resolve
the issue, you can pass through raw data from devices to IoT Platform. IoT Platform converts raw
device data to AlinkJSON data by using data parsing scripts that you submit. Then, you can perform
subsequent operations on the converted data.

Context

The following figure shows how data flows between devices and enterprise servers.

loT Platform

=0

. e

-

& -

MQTT

vy
Connect to loT Protocol
Collect .
] Platform server conversion
environment data ;
script

In this example, a device that collects environmental data is used.

Connect a device to 10T Platform

1.
2.
3.

Logontothe loT Platformconsole.

Structured data

Alink JSON

itk

Enterprise server

In the left-side navigation pane, choose Devices > Products. On the Products page, click Create

Product to create a product.

Set the Data Type parameterto Custom. For other parameters, use the default values.

Afterthe product is created, click Define TSL to add TSL features. Then, publish the TSL model.

This article provides a sample TSL model that you can import. For more information about how to

import a TSL model, see Batch add TSLfeatures.

In the left-side navigation pane, click Devices. Then, click Add Device to create a device underthe

product.

Afterthe device is added, obtain the certificate information of the device. The certificate

information includes ProductKey, DeviceName, and DeviceSecret.

. Develop a device and perform a test.

Use Link SDK to simulate a device and submit AlinkJSON data to IoT Platform. In this example, Link

SDK for Node.js is used.
For more information, see Link SDK.

Sample code:
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const mgtt = require('aliyun-iot-mgtt');
// 1. Specify the device certificate information.
var options = {

productKey:
ug4yf***",

deviceName:

"Esensor",

deviceSecret: "eldf81***",

host:

"iot—-*** . mgtt.iothub.aliyuncs.com"
bi
// 1. Establish a connection.
const client = mgtt.getAliyunIotMgttClient (options) ;
// 2.

Listen to commands from IoT Platform.
client.subscribe (' /${options.productKey}/${options.deviceName}/user/get")
client.on ('message', function (topic, message) {

console.log ("topic " + topic)

console.log ("message " + message)

})
setInterval (function () {

// 3. Submit environmental data.

client.publish (" /sys/${options.productKey}/${options.deviceName}/thing/event/proper
ty/post’, getPostData(), { gos: 0 });

}, 5 * 1000);
function getPostData () {
const payloadJdson = {
id:

Date.now (),

version: "1.0",
params:
{
PM25:
Math.floor ( (Math.random() * 1000)),
temperature: Math.floor ((Math.random() * 60) - 10),
humidity:
Math.floor ( (Math.random() * 100)),
co2:

Math.floor ( (Math.random() * 10000)),
hcho: Math.floor ((Math.random() * 5)),
lightLux:
Math.floor ((Math.random() * 10000))
s
method:
"thing.event.property.post"
}
console.log ("payloaddson " + JSON.stringify (payloadJdson))
return JSON.stringify (payloadJdson) ;

Afterthe device is connected to loT Platform, you can view the device status on the Devices
page. The device status is Online.
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Click View inthe Actions column. Then, click TSL Data. In this example, the data type of the
product is set to Custom. Therefore, the submitted TSL data is not displayed on the Status tab.

Choose Maintenance > Device Log > Cloud run log. You can select Device-to-cloud
Messages to view the submitted TSL data. The data is displayed in the hexadecimal format.

In this example, the following data is displayed: 0xaalfc800003710££0005d76b15001c013400ad04ffE
f0400ff££18003000ff2e

Write a data parsing script

Inthe loT Platform console, you can edit, submit, and debug data parsing scripts.

1.
2.

Log onto the IoT Platform console.ln the left-side navigation pane, choose Devices > Products.

Onthe Products page, find the product that you want to configure and click View in the Actions
column.

. Onthe Product Details page, clickthe Data Parsing tab.

. Onthe Data Parsing tab, write a data parsing script in the Edit Script section.

Edit the script based on the communication protocol that is used by the device. The following
table shows the message body structure of the device.

Byte Description Remarks

12 Low byte of a PM2.5 value Returns a PM2.5 value. Valid
. 3

13 High byte of a PM2.5 value values: 0to 999 ug/m-.

14 Low byte of a temperature

value x 10
Returns a temperature value.

. Valid values: -10°C to 50°C.
High byte of a temperature

15
value x 10
16 Low b f a humidit L
ow byte of a humidity value Returns a humidity value. Valid
. o values: 0to 99%.
17 High byte of a humidity value
18 Low byte of a carbon dioxide
value Returns a carbon dioxide value.
. . 3
" High byte of a carbon dioxide Valid values: 0 to 9999 mg/m?~.
value
22 Low byte of a formaldehyde
value x 100 Returns a formaldehyde value.
. Valid values: 0 to 9.99.
23 High byte of a formaldehyde
value x 100
28 Low byte of an illuminance
value . . .
Returns an illuminance value, in
. . . lux.
29 High byte of an illuminance

value
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In this example, the device only submits environmental data. Therefore, you only need to configure
the rawDataToProtocol() function to parse upstreamdata. You do not need to configure the
protocolToRawData() function.

The following code shows a sample script:

var PROPERTY REPORT METHOD = 'thing.event.property.post';

// Parse upstream data in a custom format to Alink JSON data.

function rawDataToProtocol (bytes) {

var

for

var

var

uint8Array = new Uint8Array (bytes.length);
(var i = 0; 1 < bytes.length; i++) {
uint8Array[i] = bytes[i] & O0xff;

dataView = new DataView (uint8Array.buffer, 0);

jsonMap = new Object();

// The method that is used to submit properties.
jsonMap [ 'method'] = PROPERTY REPORT METHOD;

// The version number of the protocol. Set the value to 1.0.
jsonMap|['version'] = '1.0';

// The ID of the request.

jsonMap['id'] = new Date () .getTime () ;

var params = {};

// The number 12 or 13 indicates a PM2.5 value.
params['PM25'] = (dataView.getUint8 (13)*256+dataView.getUint8(12));

// The number 14 or 15 indicates a temperature value.

params [ 'temperature'] = (dataView.getUint8 (15)*256+dataView.getUint8 (14)

// The number 16 or 17 indicates a humidity value.

params [ 'humidity'] = (dataView.getUint8(17)*256+dataView.getUint8(16));
// The number 18 or 19 indicates a carbon dioxide value.

params|['co2'] = (dataView.getUint8 (19)*256+dataView.getUint8(18))

// The number 22 or 23 indicates a formaldehyde value.

params['hcho'] = (dataView.getUint8 (23)*256+dataView.getUint8(22))/100;
// The number 28 or 29 indicates an illuminance value.
params|['lightLux'] = (dataView.getUint8 (29)*256+dataView.getUint8(28));

jsonMap|['params'] = params;

return jsonMap;

}

// Parse downstream Alink JSON data to the data in a custom format.

function protocolToRawData (json) {

) /10;

var payloadArray = [1];// This device only submits data and cannot receive downstre

am commands.

return payloadArray;

}

// Parse topic data in a custom format to Alink JSON data.

function transformPayload (topic, rawData) {

var

jsonObj = {}

return jsonObj;

5. Test data parsing.

i. Select Upstreamed Device Data inthe Simulation Type field.
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i. OntheInput Simulation tab, entertest data inthe text box.

You can use the hexadecimal data that is submitted by the device as the test data. To view
the hexadecimal data, go to the Device Log page. Example: 0xaalfc800003710£f£0005d76b15

001c013400ad04fEffE0400££F£18003000££2e
ii. ClickRun.

The following figure shows the result on the Parsing Results tab.

Input Simulation Parsing Results

Simulation TypeUpstreamed Device Data

1

L
"method": "thing.event.property.post”,
"id": 1596424283189,

"params": {
"hcho": B.064,
"pm25": 21,
"lightLux": 48,
"co2": 1197,

"temperature": 28.4,
"humidity": 52
¥,

"version™: "1.8"

6. Afteryou confirmthat test data can be parsed by the script, click Submit to submit the script to
loT Platform.

Afteryou submit the script, you can use the device SDK to debug the script. You can submit data. Then,
loT Platform uses the script to parse the data. To view the parsed data, go to the Device Details
page. Choose TSL Data > Status.
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&« F Offline

Products View DeviceSecret TREOETE \fiew
ProductKey Copy
Device Information Topic List TSL Data Device Shadow Manage Files Device Log Online Debug
Events Invoke Service
Real-time Refresh IE‘ = ?
Formaldehyde View Data CarbonDioxide View Data Temperature View Data Humidity View Data
0.04 mg/m? 1197 ppm 28.4c 52 %
llluminance View Data PM2.5 View Data
48 Lux 21
Example of upstream TSL data
{
"schema": "https://iotx-tsl.oss-ap-southeast-1.aliyuncs.com/schema.json",
"profile":
{
"version": "1.0",
"productKey":
ug4***u
} 4
"properties": [
{
"identifier":
"lightLux",
"name": "illuminance",
"accessMode":
"rw,
"required": false,
"dataType":
{
"type": "float",
"specs":
{
"min":
" O " 0
"max": "10000",
"unit":
"Tux",
"unitName": "luminous flux per unit area",
"step":
" O . 1 "
}
}
by
{
"identifier": "PM25",
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"name" :
"pM25" ,

"accessMode":

rw",
"required": false,
"dataType": {
"type":
"int",
"specs": {
"min":
g,
"max": "1000",
"unit":

"pg/m3 " ,

"unitName": "micrograms per cubic

"step":
"1"

"identifier": "hcho",
"name" :

"formaldehyde",
"accessMode": "rw",
"desc":

"HCHOValue",
"required": false,
"dataType": {

"type":

"float",

"specs": {

"io",
"unit":
"ppm",

"unitName":
"parts per million",
"step":

"0.1"
}

"identifier": "co2",
"name":
"carbon dioxide",
"accessMode": "rw",
"required": false,
"dataType":
{

lltype" : "int",
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"specs":

"min":

non,
"max": "10000",
"unit":

llmg/m3 " ,

"unitName": "micrograms per cubic meter",

"step":
"1"

"identifier": "humidity",
"name" :

"humidity",
"accessMode": "rw",
"required": false,
"dataType":

{

"type": "int",
"specs":

{

"min": "O",

"max":

"100",

"unit": "§",

"unitName" :

"percentage",

"step": "1"

"identifier":
"temperature",

"name" :
"temperature",
"accessMode" :

"rw",
"desc":

"motor working temperature",
"required": false,
"dataType":

{
"type": "float",
"specs":
{
"min": "_10",
"max":
ll50",
"Ul’lit" . u°Cn,
"step":

158
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"o, 1"

1,
"events": [
{
"identifier":
"post",
"name" :
"post",
"type": "info",
"required": true,
"desc":

"submit properties",
"method": "thing.event.property.post",
"outputData™:

[

{

"identifier": "lightLux",
"name" :
"illuminance",
"dataType": {
"type":
"float",
"specs": {
"min":
"o,
"max": "10000",
"unit":
"Lux",
"unitName": "luminous flux per unit area",
"step":
"0.1"
}

"identifier": "PM25",
"name" :

"pM25" ,
"dataType":

"type":
"int",
"specs":
{
"min":
",
"max": "1000",
"unit":
"hg/m*",

"unitName": "micrograms per cubic meter",

"step":
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"identifier": "hcho",

"name" :
"formaldehyde",
"dataType":

"type": "float",

"specs":

"minll : HOH,
"max":
lllO",
"unit" : "ppm"’
"unitName" :
"parts per million",
"Step“: "O.l"
}

"identifier":

"C02",

"name": "carbon dioxide",

"dataType":
{
"type" : l'int"’

"specs":

"min": "0",
"max":

"10000",
"unitll: l'mg/mB ",

"unitName":

"micrograms per cubic meter",

"step":
lllll

"identifier":
"humidity",

"name" :
"humidity",

"dataType":

utypeu . "int",

"specs":

"min": "Q" ,

LI LI
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e
"100",
"unit": "§",
"unitName":
"percentage",
"step":
nyw

"identifier": "temperature",
"name" :
"temperature",
"dataType": {
"type":
"float",
"specs": {
"min":
W=iQw,
"max": "50",
"unit":
meCr,
"step": "0.1"

Jl

"services":

[

"identifier": "set",
"name":

"set",
"required": true,
"callType": "async",
"desc":

"set properties",

"method": "thing.service.property.set",

"inputData":
[
{
"identifier":
"lightLux",
"name" :
"illuminance",

"dataType":

"type":
"float",

now,
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"max": "10000",

"unit":
"Lux",
"unitName": "luminous flux per unit
"step":
"0.1"
}
}
by
{
"identifier": "PM25",
"name" :
"PM25",
"dataType":
{
"type": "int",
"specs":
{
"min": "O0",
"max":
"1000",
"unit": "pg/m3",
"unitName":
"micrograms per cubic meter",
"step": "1"
}
}
3y
{
"identifier":
"hcho",
"name": "formaldehyde",
"dataType":
{
"type": "float",
"specs":
{
"min": "0",
"max":
"10",
"unit":
"ppm",

"unitName":

"parts per million",

"step":
"0.1"
}
}
by
{
"identifier":
"co2",

"name": "carbon dioxide",

"dataType":

area",
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" type " :
" int" 0
"specs": {
"min":

IIOII,

"max": "10000",

"unit":

umg/m3 ll,

"unitName": "micrograms per cubic meter",

"step":
lll"

"identifier":

"humidity",

"name": "humidity",

"dataType":

lltypell . llint",
"specs":

llminll: "O"’
"max":
"100",

"unit":

"unitName": "percentage",

"step":
"1"
}

"identifier": "temperature",

"name" :

"humidity",

"dataType": {
"type":
"float",
"specs": {

"min":

max": "50",
"unit":

u°C|v,

"step": "oL1"

1,
"outputData™:
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"identifier": "get",
"name" :

"get",
"required": true,
"callType": "async",
"desc":

"obtain properties",

"method": "thing.service.property.get",

"inputData":

[
"lightLux",
"PM25",

"hcho",
"co2",
"humidity",
"temperature"
1,
"outputData": [
{
"identifier":
"lightLux",
"name" :
"illuminance",

"dataType":

" type" .
"float",

"specs":

"min": "O",
"max":
"10000",

"unit": "Lux",

"unitName" :
"luminous flux per unit area",
"step": "0.1"

}

"identifier":
"PM25",
"name": "PM25",
"dataType":
{
"type": "int",
"specs":
{
"min": "O",
"max":
"1000",
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llunitll: llug/m:! Il,
"unitName" :
"micrograms per cubic meter",
"step": l'll'
}

"identifier":
"hcho",
"name": "formaldehyde",
"dataType":
{
"type": "float",
"specs":
{
"min
"o,
"max
"i0",
"unit":
"ppm",
"unitName":

"parts per million",
"stepll: "0.1"
}

"identifier":
"CO2 ",
"name": "carbon dioxide",
"dataType":
{
"type" : " intll 7
"specs":
{
"min": "0"’
"max":
"10000",
"unit" B nmg/ma ",
"unitName":
"micrograms per cubic meter",
"Step": l'll'
}

"identifier":
"humidity",
"name": "humidity",

"dataType":
{
"type": "int",
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sSpecs o
{
llminll : "O" 0
"max":
"100",
"unitl': ll%",
"unitName":
"percentage",
"step":
lllll

"identifier":
"temperature",

"name" :
"temperature",

"dataType":

{

"type": "float",

"specs":

"min": "-10",
"max":
"50",
TgmilETg TACT,
"step":
"0.1"
}

166
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3.Device management

3.1. Set a desired property value to
control the bulb status

You can set desired property values in loT Platformto control device properties. This article describes
how to set a desired property value in IoT Platformto control the bulb status.

Context

After a bulb device is connected to IoT Platform, you must keep the bulb online all the time to control
the bulb status. The bulb status in loT Platformincludes On (1) and Off (0). However, the bulb may not
be online all the time in production environment.

You can set and store the desired property value of the bulb in lIoT Platform. After the device goes
onling, it can read the desired property value that is stored in IoT Platform and update the property
value. Then, the updated property value is submitted to IoT Platform and displayed inthe lIoT Platform
device status.

Create a product and a device

1. Logontothe loT Platformconsole.

2. Inthe left-side navigation pane, choose Devices > Products. On the Products page, click Create
Product to create a bulb product.

roduct Name
Bulb
* Category

Standard Category @ Custom Category

* Mode Type
f Directly Conn 1l Gateway sub- 1y B Gateway devic
L ected Device device L e

MNetworking and Data Format

* Metwark Connection Method

Wi-Fi W
* Data Type

ICA Standard Data Format [Alink JSON) W
s Checksum Type

s Authentication Mode

3. Afteryou create the product, click Create TSL to add Thing Specification Language (TSL) features
to the product and publish the TSL model. For more information, see Add a TSL feature.

In this example, add the LightStatus property.
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Default Module

4. Inthe left-side navigation pane, choose Devices > Devices, and click Add Device to add the
Lamp device to the product.

Add Device X

@ nNote: You do not need to specify DeviceMame. If DeviceMame is not
specified, Alibaba Cloud will issue a unigue identifier under the product
as DeviceMame

Products

DeviceMame

Lamp

Afteryou add the device, obtain the certificate information of the device. The certificate
information includes the ProductKey, DeviceName, and DeviceSecret.

In the device list, click View to go to the Device Details page. You can view the device property
value and desired property value on the Status tab. In this example, both the values are empty.
The version of the desired property value is 0.

« Lamp e

Produ Bulb View

Pr géa Cop
Device Information Topic List TSL Data Device Shadow Manage Files Device Log Online Debug Groups
Status Events nvoke Service

View Data

Default Module

Set and query the desired property value in 1oT Platform

You can set and query the latest desired property values of a device in IoT Platform by calling API
operations.
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For more information, see APl operations. In this example, loT Platform SDK for Java is used.

e C(Callthe SetDeviceDesiredProperty operation to set desired property values of the device.

DefaultProfile profile = DefaultProfile.getProfile (
"<RegionId>", // The region ID.
"<accessKey>", // The AccessKey ID of the Alibaba Cloud account.
"<accessSecret>"); // The AccessKey secret of Alibaba Cloud account.
IAcsClient client = new DefaultAcsClient (profile);
// Create an API request and set the parameters.
SetDeviceDesiredPropertyRequest request = new SetDeviceDesiredPropertyRequest();
request.setIotInstanceId ("iot-060***") ;
request.setDeviceName ("Lamp") ;
request.setProductKey ("gdr***") ;
//The identifiers and desired values of the properties that you want to set.
request.setItems ("{\"LightStatus\": 1}");
request.setVersions (" {\"LightStatus\": 0}");
// Send the request and handle the response or exception.
try {
SetDeviceDesiredPropertyResponse response = client.getAcsResponse (request) ;
System.out.println (new Gson () .toJson (response)) ;
} catch (ServerException e) {
e.printStackTrace () ;
} catch (ClientException e) {
System.out.println ("ErrCode:" + e.getErrCode());
System.out.println ("ErrMsg:" + e.getErrMsg());
System.out.println ("RequestId:" + e.getRequestId()):;

e Callthe QueryDeviceDesiredProperty operation to query the desired property values of the device.
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DefaultProfile profile = DefaultProfile.getProfile (
"<RegionId>", // The region ID.
"<accessKey>", // The AccessKey ID of the Alibaba Cloud account.
"<accessSecret>"); // The AccessKey secret of Alibaba Cloud account.
IAcsClient client = new DefaultAcsClient (profile);
// Create an API request and set the parameters.
QueryDeviceDesiredPropertyRequest request = new QueryDeviceDesiredPropertyRequest () ;
request.setIotInstanceId("iot-060a02fq") ;
request.setProductKey ("g4rmjb5g400") ;
request.setDeviceName ("Lamp") ;
// The identifiers of the properties that you want to query. If you do not specify a prop
erty identifier, the desired values of all properties except the read-only properties are
queried.
List<String> identifierList = new ArrayList<String>();
identifierList.add("LightStatus");
request.setIdentifiers (identifierList);
// Send the request and handle the response or exception.
try {
QueryDeviceDesiredPropertyResponse response = client.getAcsResponse (request) ;
System.out.println (new Gson () .toJson (response)) ;
} catch (ServerException e) {
e.printStackTrace () ;
} catch (ClientException e) {
System.out.println ("ErrCode:" + e.getErrCode());
System.out.println ("ErrMsg:" + e.getErrMsg());
System.out.println ("RequestId:" + e.getRequestId()):;

For more information about how to set the parameters in the code, see Use IoT Platform SDK for Java.
Afteryou set the desired property value of the Lamp device, the value is displayed on the Status tab in
loT Platform.

Develop the device

The bulb device can obtain desired property values in the following scenarios:

o If the bulb device goes from offline to online, it requests the desired property value that is cached in
loT Platform.

e If the bulb device is online, it receives the desired property value that is pushed by IoT Platformin real
time.

For more information, see Download device SDKs.

This article provides complete device-side sample code. For more information, see Appendix: Sample
code to configure a device.

1. Specify the certificate information and region ID of the device.
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/**

* The certificate information about the device.
=y

private static String productKey = "**x*xxu;
private static String deviceName = "**x*xkxim;

private static String deviceSecret = "X*xFkxdkkdkxdkxdkxkn,
/**

* The MQTT connection information.

&/

private static String regionId = "x*x&x&n:

@ Note
o For more information about the device certificate, see Create a product and a device.

o regionld specifies the ID of the region where your service resides. You can view the
region in the upper-left corner of the loT Platform console. For more information about
region IDs, see Regions and zones.

2. Add the following methods. These methods can be used to change the actual property values of
the bulb and automatically report the changes to loT Platform.

> Document Version: 20220624 171


https://www.alibabacloud.com/help/doc-detail/109292.htm#section-izi-82q-p0n
https://www.alibabacloud.com/help/doc-detail/40654.htm#concept-2459516

Best Practices-Device management MIBEMTE

/**
* When the device handles a property value change, the methods are called in the follo
wing scenarios:
* Scenario 1. Pull mode: After the device is connected to IoT Platform again, the devi
ce automatically requests the latest desired property value from IoT Platform.
* Scenario 2. Push mode: When the device is online, it receives the desired property v
alues that IoT Platform pushes to the property.set topic.
* @param identifier: the property identifier.
* @param value: the desired property value.
* @param needReport: specifies whether to report the property value to IoT Platform by
using the property.post topic.
* In Scenario 2, the property report capability is integrated into the processing func
tion and the needReport parameter is set to false.
* @return
*/
private boolean handlePropertySet (String identifier, ValueWrapper value, boolean needRe
port) {
ALog.d(TAG, "The device handles property changes= [" + identifier + "], value = ["
+ value + "]");
// Check whether the property settings are successful based on the response. In thi
s example, a success message is returned.
boolean success = true;
if (needReport) {
reportProperty (identifier, wvalue);
}
return success;
}
private void reportProperty(String identifier, ValueWrapper value) {
if (StringUtils.isEmptyString(identifier) || value == null) {
return;
}
ALog.d (TAG, "Report property identity=" + identifier);
Map<String, ValueWrapper> reportData = new HashMap<>() ;
reportData.put (identifier, wvalue);
LinkKit.getInstance () .getDeviceThing () .thingPropertyPost (reportData, new IPublishRe
sourcelistener () {
public void onSuccess (String s, Object o) {
// The property value is reported.
ALog.d (TAG, "Report success onSuccess() called with: s = [" + s + "], o = [
"o+ "M
}
public void onError (String s, AError aError) ({
// The property value fails to be reported.
ALog.d(TAG, "Report failure onError() called with: s = [" + s + "], aError
= [" + JSON.toJSONString (aError) + "]1");
}
1)

3. If the bulb is online and a desired property value is set forthe bulb in lIoT Platform, IoT Platform
pushes the value to the bulb. The bulb processes the message and changes the status.

Inthe following code, the connectNotifyListener () method is called to processthe message.
For information about the Alink protocol, see Devices submit property information to loT Platform.
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After the device receives an asynchronous message fromloT Platform, the device calls the mcommo
nHandler () method and thenthe handilePropertyset method to update the property value.

/**
* Register a function to respond to service calls and property settings.
* When IoT Platform calls a service from the device, the device must respond to the ca
11 and return a response.
*/
public void connectNotifyListener() {
List<Service> servicelist = LinkKit.getInstance () .getDeviceThing () .getServices();
for (int i = 0; servicelList != null && i < servicelist.size(); i++) {
Service service = servicelist.get (i);
LinkKit.getInstance () .getDeviceThing () .setServiceHandler (service.getIdentifier (
) , mCommonHandler) ;
}
}
private ITResRequestHandler mCommonHandler = new ITResRequestHandler () {
public void onProcess (String servicelIdentifier, Object result, ITResResponseCallbac
k itResResponseCallback) {
ALog.d (TAG, "onProcess() called with: s = [" + serviceldentifier + "]," +
" o= [" + result + "], itResResponseCallback = [" + itResResponseCallb
ack + "1");
ALog.d(TAG, "Received an asynchronous service call from IoT Platform " + servic
eldentifier);
try {
if (SERVICE SET.equals (serviceldentifier)) {
Map<String, ValueWrapper> data = (Map<String, ValueWrapper>) ( (InputPara
ms)result) .getDatal();
ALog.d(TAG, "Received asynchronous downstream data " + data);
//Set the property of the device and then report the property value to
IoT Platform.
boolean isSetPropertySuccess =
handlePropertySet ("LightStatus", data.get ("LightStatus™), false

if (isSetPropertySuccess) {
if (result instanceof InputParams) {
// Return a response to IoT Platform.

itResResponseCallback.onComplete (serviceldentifier, null, null)

} else {

itResResponseCallback.onComplete (serviceldentifier, null, null)

}
} else {
AError error = new AError();
error.setCode (100) ;
error.setMsg ("setPropertyFailed.") ;
itResResponseCallback.onComplete (serviceldentifier, new ErrorInfo (e
rror), null);
}
} else if (SERVICE GET.equals (serviceIdentifier)) {
} else {
// The device operation varies by service.

ALog.d(TAG, "Return a response to IoT Platform.");
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OutputParams outputParams = new OutputParams () ;
// outputParams.put ("op", new ValueWrapper.IntValueWrapper (20)) ;
itResResponseCallback.onComplete (serviceldentifier, null, outputParams)

}
} catch (Exception e) {
e.printStackTrace () ;
ALog.d(TAG, "The format of the returned data is invalid");

}
public void onSuccess (Object o, OutputParams outputParams) {
ALog.d (TAG, "onSuccess () called with: o = [" + o + "], outputParams = [" + outp
utParams + "1");
ALog.d (TAG, "The service was registered");
}
public void onFail (Object o, ErrorInfo errorInfo) ({
ALog.d(TAG, "onFail() called with: o = [" + o + "], errorInfo = [" + errorInfo
+ M)
ALog.d(TAG, "Service registration failed.");

};

4. If the bulb is offline and a desired property value is set forthe bulb in loT Platform, the value is
stored in loT Platform.

Afterthe bulb goes online, it requests the desired property value fromloT Platformand callthe n
andlePropertyset () method to update the property value.

LinkKit.getInstance () .init (params, new ILinkKitConnectListener () {
public void onError (AError aError) {
ALog.e (TAG, "Init Error error=" + aError);
}
public void onInitDone (InitResult initResult) {
ALog.i (TAG, "onInitDone result=" + initResult);
connectNotifyListener () ;
// Request the latest desired property value from IoT Platform.
getDesiredProperty (deviceInfo, Arrays.asList ("LightStatus"), new IConnectSendLi
stener () {
public void onResponse (ARequest aRequest, AResponse aResponse) {
if (aRequest instanceof MgttPublishRequest && aResponse.data != null) {
JSONObject jsonObject = JSONObject.parseObject (aResponse.data.toStr
ing());
ALog.i (TAG, "onResponse result=" + jsonObject);
JSONObject dataObj = jsonObject.getJSONObject ("data");
if (dataObj != null) {
if (dataObj.getJSONObject ("LightStatus") == null) ({
// No desired value is set.
} else {
Integer value = dataObj.getJSONObject ("LightStatus") .getInt
eger ("value");
handlePropertySet ("LightStatus", new ValueWrapper.IntValueW

rapper (value), true);
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}
public void onFailure (ARequest aRequest, AError akError) {
ALog.d(TAG, "onFailure() called with: aRequest = [" + aRequest + "], aE
rror = [" + aError + "]");
}
1)

1) i
private void getDesiredProperty (BaseInfo info, List<String> properties, IConnectSendLis
tener listener) {
ALog.d(TAG, "getDesiredProperty() called with: info = [" + info + "], listener = ["
+ listener + "1");
if (info != null && !StringUtils.isEmptyString(info.productKey) && !StringUtils.isEm
ptyString (info.deviceName)) {
MgttPublishRequest request = new MgttPublishRequest () ;
request.topic = DESIRED PROPERTY GET.replace ("{productKey}", info.productKey).r
eplace ("{deviceName}", info.deviceName) ;
request.replyTopic = DESIRED PROPERTY GET REPLY.replace ("{productKey}", info.pr
oductKey) .replace ("{deviceName}", info.deviceName) ;
request.isRPC = true;
RequestModel<List<String>> model = new RequestModel<> () ;
model.id = String.valueOf (IDGeneraterUtils.getId());
model .method = METHOD GET DESIRED PROPERTY;
model.params = properties;
model.version = "1.0";
request.payloadObj = model.toString() ;
ALog.d (TAG, "getDesiredProperty: payloadObj=" + request.payloadObj) ;
ConnectSDK.getInstance () .send (request, listener);
} else {
ALog.w (TAG, "getDesiredProperty failed, baseInfo Empty.");
if (listener != null) {
AError error = new AError();
error.setMsg ("BaseInfoEmpty.") ;

listener.onFailure (null, error);

Verify the result

Run the sample code based on scenarios to verify the online and offline status of the bulb. You can
change the device property value by setting the desired property value in loT Platform.

e [f the bulb is online, you can change the bulb status in IoT Platform. The bulb responds to the change
in real time.
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Appendix: Sample code to configure a device

package com.aliyun.alink.devicesdk.demo;
alibaba.fastjson.JSON;
.alibaba.fastjson.JSONObject;
.aliyun.alink.apiclient.utils.StringUtils;
alink.dm.
alink.

import com.

import com

import com

import com.aliyun. api.BaseInfo;

import com.aliyun. api.DeviceInfo;

import com.aliyun.alink. api.InitResult;

dm.
dm.
import com.aliyun.alink.dm.model.RequestModel;
import com.aliyun.alink.dm.utils.IDGeneraterUtils;
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import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import
import

public

com.

com.

com.

com.

com.

com

com

com

com

com.
com.
com.
com.
com.
com.
com.
com.
com.
com.

java.util.Arrays;

aliyun.
aliyun.
aliyun.
aliyun.
aliyun.
.aliyun.
.aliyun.
.aliyun.
.aliyun.
aliyun.
aliyun.
aliyun.
aliyun.
aliyun.
aliyun.
aliyun.
aliyun.
aliyun.

aliyun.

alink.
alink.
alink.
alink.
alink.
alink.
alink.
alink.
alink.
alink.
alink.
alink.
alink.
alink.
alink.
alink.
alink.
alink.

alink.

linkkit.
linkkit
linkkit.
linkkit
linksdk.
linksdk.
linksdk.
linksdk.
linksdk.
linksdk.
linksdk.
linksdk.
linksdk.
linksdk.
linksdk.
linksdk.
linksdk.
linksdk.
linksdk.

java.util.HashMap;

java.util.List;

java.util.Map;

class LampDemo {

private static final String

private final static String

private final static String

api.
.api.
.LinkKit;

api

.api.

cmp.

cmp
cmp
cmp

cmp

tmp.
tmp.
tmp.
tmp.
tmp.
tmp.
tmp.
tmp.

ILinkKitConnectListener;
TIoTMgttClientConfig;

LinkKitInitParams;

api.ConnectSDK;

.connect.channel .MgttPublishRequest;
.core.base.ARequest;
.core.base.AResponse;

.core.listener.IConnectSendListener;

api.InputParams;

api.OutputParams;
device.payload.ValueWrapper;
devicemodel.Service;
listener.IPublishResourcelistener;
listener.ITResRequestHandler;
listener.ITResResponseCallback;

utils.ErrorInfo;

tools.AError;

tools.ALog;

TAG

= "LampDemo";

SERVICE SET = "set";
SERVICE GET = "get";

public static String DESIRED PROPERTY GET = "/sys/{productKey}/{deviceName}/thing/prope
rty/desired/get";
public static String DESIRED PROPERTY GET REPLY = "/sys/{productKey}/{deviceName}/thing

/property/desired/get reply";

public static String METHOD GET DESIRED PROPERTY = "thing.property.desired.get";
public static void main (Stringl[]

/**

}

*

*/
String
String
String
/**

*

wY
String
LampDemo manager
DevicelInfo
devicelInfo
devicelInfo

deviceInfo

args) {

The certificate information about the device.

deviceSecret

productKey = "x*xx";

deviceName = "Lamp";

— MkkkxM.
s

The MQTT connection information.

regionId = "cn-shanghai";

= new LampDemo () ;

devicelInfo =

.productKey =

.deviceName =

.deviceSecret

manager.init (devicelInfo,

new

DeviceInfo () ;

productKey;

deviceName;

= deviceSecret;

regionId) ;

public void init (final DeviceInfo deviceInfo, String region) {

LinkKitInitParams params
/**

new LinkKitInitParams() ;

* Specify the parameters for MQTT initialization.
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*/
IoTMgttClientConfig config = new IoTMgttClientConfig() ;
config.productKey = deviceInfo.productKey;
config.deviceName = deviceInfo.deviceName;
config.deviceSecret = deviceInfo.deviceSecret;
config.channelHost = deviceInfo.productKey + ".iot-as-mgtt." + region + ".aliyuncs.
com:1883";
/**
* Specify whether to receive offline messages.
* The cleanSession field that corresponds to the MQTT connection.
Y
config.receiveOfflineMsg = false;
params.mgttClientConfig = config;
/**
* Configure the initialization and pass in the certificate information about the d
evice.
w
params.deviceInfo = devicelInfo;
LinkKit.getInstance() .init (params, new ILinkKitConnectListener() {
public void onError (AError aError) {
ALog.e (TAG, "Init Error error=" + aError);
}
public void onInitDone (InitResult initResult) {
ALog.i (TAG, "onInitDone result=" + initResult);
connectNotifyListener();
// Request the latest desired property value from IoT Platform.
getDesiredProperty (deviceInfo, Arrays.asList ("LightStatus"), new IConnectSe
ndListener () {
public void onResponse (ARequest aRequest, AResponse aResponse) {

if (aRequest instanceof MgttPublishRequest && aResponse.data != null

JSONObject jsonObject = JSONObject.parseObject (aResponse.data.t
oString());
ALog.i (TAG, "onResponse result=" + jsonObject);
JSONObject dataObj = jsonObject.getJSONObject ("data");
if (dataObj != null) {
if (dataObj.getJSONObject ("LightStatus") == null) ({
// No desired value is set.
} else {
Integer value = dataObj.getJSONObject ("LightStatus") .ge
tInteger ("value");
handlePropertySet ("LightStatus", new ValueWrapper.IntVa
lueWrapper (value), true);

}
public void onFailure (ARequest aRequest, AError akError) {
ALog.d(TAG, "onFailure() called with: aRequest = [" + aRequest + "]

, aBrror = [" + aError + "]");
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}
/**
* When the device handles a property value change, the methods are called in the follo
wing scenarios:
* Scenario 1. Pull mode: After the device is connected to IoT Platform again, the devi
ce automatically requests the latest desired property value from IoT Platform.
* Scenario 2. Push mode: When the device is online, it receives the desired property v
alues that IoT Platform pushes to the property.set topic.
* @param identifier: the property identifier.
* @param value: the desired property value.
* @param needReport: specifies whether to report the property value to IoT Platform by
using the property.post topic.
* In Scenario 2, the property report capability is integrated into the processing func
tion and the needReport parameter is set to false.
* @return
*/
private boolean handlePropertySet (String identifier, ValueWrapper value, boolean needRe
port) {
ALog.d(TAG, "The device handles property changes= [" + identifier + "], value = ["
+ value + "1");
// Check whether the property settings are successful based on the response. In thi
s example, a success message is returned.
boolean success = true;
if (needReport) {
reportProperty (identifier, wvalue);
}
return success;
}
private void reportProperty(String identifier, ValueWrapper value) {
if (StringUtils.isEmptyString(identifier) || value == null) {
return;
}
ALog.d (TAG, "Report property identity=" + identifier);
Map<String, ValueWrapper> reportData = new HashMap<>();
reportData.put (identifier, wvalue);
LinkKit.getInstance () .getDeviceThing () .thingPropertyPost (reportData, new IPublishRe
sourcelistener () {
public void onSuccess (String s, Object o) {
// The property value is reported.
ALog.d (TAG, "Report success onSuccess() called with: s = [" + s + "], o = [
"+ o+ "]");
}
public void onError (String s, AError aError) ({
// The property value fails to be reported.
ALog.d(TAG, "Report failure onError() called with: s = [" + s + "], aError
= [" + JSON.toJSONString (aError) + "]1");
}
1)
}
/**
* Register a function to respond to service calls and property settings.
* When IoT Platform calls a service from the device, the device must respond to the ca
11 and return a response.

*/
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public void connectNotitylListener() {
List<Service> servicelist = LinkKit.getInstance () .getDeviceThing() .getServices/()
for (int 1 = 0; servicelist != null && i1 < servicelist.size(); i++) {
Service service = servicelist.get (i)
LinkKit.getInstance () .getDeviceThing () .setServiceHandler (service.getIdentifier (
) , mCommonHandler) ;
}
}
private ITResRequestHandler mCommonHandler = new ITResRequestHandler () {
public void onProcess (String serviceldentifier, Object result, ITResResponseCallbac
k itResResponseCallback) {
ALog.d(TAG, "onProcess() called with: s = [" + serviceIdentifier + "]," +
"o = [" + result + "], itResResponseCallback = [" + itResResponseCallb
ack + "1");
ALog.d (TAG, "Received an asynchronous service call from IoT Platform " + servic
eldentifier);
try {
if (SERVICE SET.equals (serviceldentifier)) ({
Map<String, ValueWrapper> data = (Map<String, ValueWrapper>) ( (InputPara
ms) result) .getDatal();
ALog.d (TAG, "Received asynchronous downstream data " + data);
// Set the property value of the device and report the property value t
o IoT Platform.
boolean isSetPropertySuccess =

handlePropertySet ("LightStatus", data.get ("LightStatus"), false

if (isSetPropertySuccess) {
if (result instanceof InputParams) {
// Return a response to IoT Platform.

itResResponseCallback.onComplete (serviceldentifier, null, null)

} else {

itResResponseCallback.onComplete (serviceldentifier, null, null)

}
} else {
AError error = new AError();
error.setCode (100) ;
error.setMsg ("setPropertyFailed.") ;
itResResponseCallback.onComplete (serviceldentifier, new ErrorInfo (e
rror), null);
}
} else if (SERVICE GET.equals (serviceldentifier)) {
} else {
// The device operation varies by service.
ALog.d(TAG, "The returned values corresponding to the service.");
OutputParams outputParams = new OutputParams();
// outputParams.put ("op", new ValueWrapper.IntValueWrapper (20)) ;

itResResponseCallback.onComplete (serviceIdentifier, null, outputParams)

}
} catch (Exception e) {
e.printStackTrace () ;
ALog.d(TAG, "The format of the returned data is invalid");
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}
public void onSuccess (Object o, OutputParams outputParams) {
ALog.d (TAG, "onSuccess() called with: o = [" + o + "], outputParams = [" + outp
utParams + "1");
ALog.d(TAG, "The service was registered");
}
public void onFail (Object o, ErrorInfo errorInfo) ({
ALog.d(TAG, "onFail() called with: o = [" + o + "], errorInfo = [" + errorInfo
+ "1
ALog.d (TAG, "Service registration failed.");

}i
private void getDesiredProperty (BaseInfo info, List<String> properties, IConnectSendLis
tener listener) {
ALog.d(TAG, "getDesiredProperty() called with: info = [" + info + "], listener = ["
+ listener + "1");
if (info != null && !StringUtils.isEmptyString(info.productKey) && !StringUtils.isEm
ptyString (info.deviceName)) {
MgttPublishRequest request = new MgttPublishRequest () ;
request.topic = DESIRED PROPERTY GET.replace ("{productKey}", info.productKey) .r
eplace ("{deviceName}", info.deviceName) ;
request.replyTopic = DESIRED PROPERTY GET REPLY.replace ("{productKey}", info.pr
oductKey) .replace ("{deviceName}", info.deviceName) ;
request.isRPC = true;
RequestModel<List<String>> model = new RequestModel<>();
model.id = String.valueOf (IDGeneraterUtils.getId())
model.method = METHOD GET DESIRED PROPERTY;
model.params = properties;
model.version = "1.0";
request.payloadObj = model.toString() ;
ALog.d(TAG, "getDesiredProperty: payloadObj=" + request.payloadObj) ;
ConnectSDK.getInstance () .send (request, listener);
} else {
ALog.w (TAG, "getDesiredProperty failed, baseInfo Empty.");
if (listener != null) {
AError error = new AError();
error.setMsg ("BaseInfoEmpty.") ;

listener.onFailure (null, error);

3.2. Connect a sub-device to IoT

Platform
3.2.1. Overview

A sub-device can be connected to IoT Platform only by using a gateway. This article describes how to
connect a sub-device to loT Platform by using a gateway.
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First, create a gateway and a sub-device inthe lIoT Platform console. Then, develop a device SDK for
the gateway to connect the gateway to loT Platform. Next, the gateway creates a topological
relationship between the gateway and sub-devices and reports the relationship to lIoT Platform. If a
sub-device has a topological relationship with the gateway, the gateway reports the certificate of the
sub-device to loT Platform or dynamically registers the sub-device. loT Platformvalidates the identity
of the sub-device and the topological relationship between the sub-device and the gateway. If the
validation is successful, loT Platform establishes a logical channel between the sub-device and loT
Platform and associates the logical channel with the physical channel of the gateway. This way, the
sub-device can connect to and communicate with loT Platform by using the gateway.
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This example describes only how to connect a sub-device to IoT Platform by using a gateway, and
does not involve configurations for data communication such as Thing Specification Language (TSL)
data communication. If you want to transmit TSL data between your sub-device and IoT Platform,
configure your gateway to transmit the data for the sub-device. For more information, see Establish
TSL-based communication.

@ Note Data transmission between a gateway and a sub-device must be implemented by the
provider of the gateway. Alibaba Cloud does not provide code for this feature.

Reference

You can download the sample code for connecting a sub-device to IoT Platform by using a gateway:
iotx-api-demo.

To connect the sub-device to IoT Platform by using the gateway, performthe following steps:

1. Create a gateway and a sub-device
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2. Initialize the SDKs
3. Connect the gateway device to lIoT Platform

4. Connect the sub-device to lIoT Platform

3.2.2. Create a gateway and a sub-device

This article describes how to create a gateway product, a gateway device, a sub-device product, and a
sub-device.

Procedure

1. Logontothe loT Platformconsole.
2.
3. In left-side navigation pane, choose Devices > Products.

4. Onthe Products page, click Create Product and create a gateway product and a sub-device
product.

o Create a gateway product. For more information, see Create a product.
@ Note Set the Node Type parameterto Gateway device.

o Create a sub-device product. For more information, see Create a product.
@ Note Set the Node Type parameter to Gateway sub-device.

5. Inthe left-side navigation pane, choose Devices > Devices. On the Devices page, create a device
forthe gateway product and a sub-device for the sub-device product. For more information, see
Create a device.

What's next
Initialize the SDKs
Connect the gateway device to lIoT Platform

Connect the sub-device to 10T Platform

3.2.3. Initialize the SDKs

This article describes how to initialize IoT Platform SDK for Java and the device SDK for Java. You must
prepare aJava development environment, download the SDK package, import a project, and then
initialize the SDKs.

Prerequisites

Create a gateway and a sub-device

Procedure

1. Download and decompress the SDK package iotx-api-demo.
This package contains the device SDK for Java and loT Platform SDK for Java.

2. Import the decompressed SDK package to your Java development environment.
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3. Inthe pomfile in the java directory, add the following dependencies to import loT Platform SDK for
Java and the device SDK for Java.

<! -- https://mvnrepository.com/artifact/com.aliyun/aliyun-java-sdk-iot -->
<dependency>
<groupId>com.aliyun</groupId>
<artifactId>aliyun-java-sdk-iot</artifactId>
<version>6.5.0</version>
</dependency>
<dependency>
<groupId>com.aliyun</groupId>
<artifactId>aliyun-java-sdk-core</artifactId>
<version>3.5.1</version>
</dependency>
<dependency>
<groupId>com.aliyun.alink.linksdk</groupId>
<artifactId>iot-linkkit-java</artifactId>
<version>1.2.0.1</version>
<scope>compile</scope>

</dependency>

4. Inthe configfile in the java/src/main/resources/ directory, enter the required information for
initialization.

user.accessKeyID = <your accessKey ID>
user.accessKeySecret = <your accessKey Secret>
iot.regionId = <regionId>

iot.productCode = Iot

iot.domain = iot.<regionId>.aliyuncs.com
iot.version = 2018-01-20

Parameter Description

The AccessKey ID of your Alibaba Cloud account.

To create or view your AccessKey pair, perform the following steps: Log on

accessKeylD to the Alibaba Cloud Management console. Move the pointer over your
profile picture, and click AccessKey Management to go to the AccessKey
Pair page.

The AccessKey secret of your Alibaba Cloud account. You can obtain the

accessKeySecret .
4 AccessKey secret the same way you obtain the AccessKey ID.

The ID of the region where your IoT devices reside. For more information

regionlid . :
9 about region IDs, see Regions and zones.

What's next

Connect the gateway device to lIoT Platform

Connect the sub-device to IoT Platform

3.2.4. Connect the gateway device to loT Platform

184 > Document Version: 20220624


https://www.alibabacloud.com/help/doc-detail/40654.htm#concept-2459516
https://www.alibabacloud.com/help/doc-detail/126466.htm#task-1545804
https://www.alibabacloud.com/help/doc-detail/128184.htm#task-1478646

MBS Best Practices-Device management

Afteryou configure the device SDK, connect the gateway device to loT Platform.

Prerequisites
Before you start, make sure that the following operations are performed:

e (reate a gateway and a sub-device

e |[nitialize the SDKs

Configure the device SDK for the gateway device

In the SDK package, the DeviceTopoManagerfile in the

Java/src/main/java/com/aliyun/iot/api/common/deviceApidirectory contains sample code for

connecting the gateway device to loT Platform.

1. Configure the information about the gateway device for connection.

private static String regionId = "cn-shanghai®;
private static final String TAG = "TOPO";

// The information about the gateway device.

private static String GWproductKey = "alBxptK***";
private static String GWdeviceName = "XMtrv3yvitEHAzrTfX1U";
private static String GWdeviceSecret = "19xJNybifnmgcK057vYhazYK4be4****";
public static void main(String[] args) {
/**
* The information about the MQTT connection.
*/
DeviceTopoManager manager = new DeviceTopoManager () ;
/**
* The Java HTTP client of this device supports TSLvl.2.
7/

System.setProperty ("https.protocols", "TLSv2");

manager.init () ;

2. Establish a connection.
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public void init () {
LinkKitInitParams params = new LinkKitInitParams();
/**
* Specify the parameters for MQTT initialization.
=y
IoTMgttClientConfig config = new IoTMgttClientConfig();
config.productKey = GWproductKey;
config.deviceName = GWdeviceName;
config.deviceSecret = GWdeviceSecret;
config.channelHost = GWproductKey + ".iot-as-mgtt." + regionId + ".aliyuncs.com
:1883";
/**
* Specify whether to receive offline messages.
* The cleanSession field that corresponds to the MQTT connection.
*/
config.receiveOfflineMsg = false;
params.mgttClientConfig = config;
ALog.setLevel (LEVEL DEBUG) ;
ALog.i (TAG, "mgtt connetcion info=" + params) ;
/**
* Configure the initialization and pass in the certificate information about t
he device.
=Y
DevicelInfo deviceInfo = new DevicelInfo();
deviceInfo.productKey = GWproductKey;
deviceInfo.deviceName = GWdeviceName;
deviceInfo.deviceSecret = GWdeviceSecret;
params.deviceInfo = devicelInfo;
/**Establish a connection. **/
LinkKit.getInstance () .init (params, new ILinkKitConnectListener () {
public void onError (AError aError) {
Alog.e (TAG, "Init Error error=" + aError);
}
public void onInitDone (InitResult initResult) {

ALog.i (TAG, "onInitDone result=" + initResult);

// Obtain the topological relationships of the gateway and check whethe
r a topological relationship exists between the gateway and the sub-device.

// If a topological relationship exists between the gateway and the sub
-device, the gateway connects the sub-device to IoT Platform.

getGWDeviceTopo () ;

// Dynamically register the sub-device to obtain a DeviceSecret for the
sub-device. If the gateway has obtained the certificate of the sub-device, skip this st
ep.

// When you register the sub-device, set the deviceName parameter to th
e serial number or MAC address of the sub-device.

gatewaySubDevicRegister () ;

//Specify the information about the sub-device for which you want to ad
d a topological relationship.

gatewayAddSubDevice () ;
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Test the connection

Afteryou configure the information about the gateway device in the device SDK, you can test the
connection between the gateway device and loT Platform.

1. Run DeviceTopoManager.
2. Logontothe loT Platform console.ln the left-side navigation pane, choose Devices > Devices.

3. Onthe Devices page, find the gateway device and check its status. If the status of the gateway
device is Online, the gateway device is connected to loT Platform.

What's next

Connect the sub-device to IoT Platform
3.2.5. Connect the sub-device to IoT Platform

A sub-device can be connected to IoT Platform only by using a gateway. After a sub-device is
connected to a gateway, the gateway checks whether a topological relationship exists between the
gateway and the sub-device. If so, the gateway reports the information about the sub-device to loT
Platform and connects the sub-device to IoT Platform.

Prerequisites
Before you start, make sure that the following operations are performed:
e (reate a gateway and a sub-device

e Initialize the SDKs

e Connect the gateway device to loT Platform

Context
e Configure a sub-device

A sub-device cannot directly connect to loT Platform. Therefore, you do not need to install a device
SDK that loT Platform provides on your sub-device. The device SDK of a sub-device must be
developed by its provider.

e The SDK package provided by IoT Platform

The DeviceTopoManagerfile in the java/src/main/java/com/aliyun/iot /api/common/deviceApi
directory contains the code that is used by a gateway to manage topological relationships, obtain
sub-device certificates, and connect a sub-device to IoT Platform by using the gateway.

Step 1: Manage topological relationships by using the gateway

Afterthe gateway is connected to IoT Platform, the gateway must synchronize its topological
relationships to IoT Platform. This way, the gateway can implement communication between sub-
devices and IoT Platform. You can view and add topological relationships in the IoT Platform console.
You can also performthese operations by using the sample code.

e View and add topological relationships between the gateway and sub-devices in the loT Platform
console.

i. Inthe left-side navigation pane, choose Devices > Devices. On the Devices page, find the
gateway device.

ii. ClickSub-device inthe Actions column. Onthe page that appears, view the sub-devices of the
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gateway.

ji. ClickAdd Sub-device. Add the sub-device that you created inthe Create a gateway and a sub-
device step.

e Query and add topological relationships by using the following sample code.

o Query topological relationships by using the following sample code:

/**
* Obtain the topological relationships of the gateway and check whether a topologi
cal relationship exists between the gateway and the sub-device.
=y
private void getGWDeviceTopo () {

LinkKit.getInstance () .getGateway () .gatewayGetSubDevices (new IConnectSendListene

@Override
public void onResponse (ARequest request, AResponse aResponse) {
ALog.i (TAG, "The topological relationships of the gateway are obtained:
" + JSONObject.toJSONString (aResponse)) ;
// Obtain a list of sub-devices.
try {
ResponseModel<List<DeviceInfo>> response = JSONObject.parseObject (a
Response.data.toString (), new TypeReference<ResponseModel<List<DeviceInfo>>>() {
}.getType());
// Process the request based on the actual scenario.
} catch (Exception e) {

e.printStackTrace () ;

}
@Override
public void onFailure (ARequest request, AError error) {
Alog.i (TAG, "Failed to obtain the topological relationships of the gate
way: " + JSONObject.toJSONString (error));
}
});

o Add atopological relationship by using the following sample code:

@ Note

m Forinformation about how to obtain the certification information about the sub-
device, see Step 2.

m AfterloT Platformvalidates the topological relationship between the gateway and the
sub-device, the sub-device can use the physical channel of the gateway to
communicate with IoT Platform.

/**
* Specify the information about the sub-device for which you want to add a topolog
ical relationship.
*/
private void gatewayAddSubDevice () {
BaseInfo baseInfol = new BaselInfo();
baseInfol.productKey = "alj7SyR****";
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baseInfol.deviceName = "safa***";
String deviceSecret = "71zCJIWHMGFpZpDKbJdVucDHUz6C****";
LinkKit.getInstance () .getGateway () .gatewayAddSubDevice (baseInfol, new ISubDevic
eConnectListener () {
@Override
public String getSignMethod() {
// The signature method that you use to sign the request.
return "hmacshal";
}
@Override
public String getSignValue () {
// Generate a signature based on the DeviceSecret.
Map<String, String> signMap = new HashMap<>();
signMap.put ("productKey", baselInfol.productKey) ;
signMap.put ("deviceName", baseInfol.deviceName) ;
//signMap.put ("timestamp", String.valueOf (System.currentTimeMillis()));
signMap.put ("clientId", getClientId());
return SignUtils.hmacSign (signMap, deviceSecret) ;
}
@Override
public String getClientId() {
// Set the clientId parameter as needed.
return "id";
}
@Override
public Map<String, Object> getSignExtraData () {
return null;
}

@Override
public void onConnectResult (boolean isSuccess, ISubDeviceChannel iSubDevice

Channel, AError aError) {
// Handle the result of the operation for adding the topological relati
onship between the sub-device and the gateway.
if (isSuccess) {
// After the topological relationship is added, you can use the gat
eway to connect the sub-device to IoT Platform.
ALog.i (TAG, "The topological relationship is added: " + JSONObject.
toJSONString (iSubDeviceChannel)) ;
// Connect the sub-device to IoT Platform by using the gateway.
gatewaySubDeviceLogin () ;
} else {
ALog.i (TAG, "Failed to add the topological relationship: " + JSONOb
ject.toJSONString (aError)) ;
}
}

@Override
public void onDataPush (String s, AMessage aMessage) {

Step 2: Obtain the certificate information about the sub-device
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Afterthe sub-device is created, IoT Platformissues a certificate to the sub-device. The gateway can
obtain the certificate information by using one of the following methods:

e Unique-certificate-per-device
You can obtain the ProductKey, DeviceName, and DeviceSecret of the sub-device on the details page

of the sub-device inthe IoT Platform console.

o After a gateway discovers a connected sub-device, the gateway can obtain the certificate of the
sub-device based on a protocol that is defined between the gateway and the sub-device. The
protocol is defined by the provider of the gateway and the provider of the sub-device.

o The provider of the gateway provides a configuration method that allows the gateway to preset
certificate information about the sub-device. This feature is implemented by the provider of the
gateway.

e Dynamic sub-device registration

The gateway reports the ProductKey and DeviceName of the sub-device to IoT Platformto register
the sub-device. After IoT Platformvalidates the ProductKey and DeviceName of the sub-device, loT
Platform dynamically assigns a DeviceSecret to the sub-device.

i. When you create a sub-device in IoT Platform, set the deviceName parameterto the serial
number or MAC address of the sub-device. After the sub-device is created, enable dynamic
registration for the sub-device.

¢« GatewayTest01
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0 Manage
Product Information Topic Categories Define Feature Data Parsing Server-side Subscription Device Provisioning

Product Information £ Edit

fal
o
1
1
@
o
=
"

Custom Category Data Type ICA Standard Data Format (Alink JSON)

Device Secret Dynamic Registration

i. When you configure the gateway, make sure that the gateway can obtain the model and unique
identifier, which is the serial number or MAC address, of the sub-device. This is made possible by
the protocol that is defined between the gateway and the sub-device. In addition, map the sub-
device model to the ProductKey in loT Platform.

iii. Obtain a DeviceSecret forthe sub-device fromloT Platform during dynamic registration.

Sample code:
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/**
* Obtain a DeviceSecret for the sub-device during dynamic registration.
* When you create the sub-device in IoT Platform, set the deviceName parameter to th
e serial number or MAC address of the sub-device.
=)
private void gatewaySubDevicRegister () {
List<BaseInfo> subDevices = new ArrayList<>();
BaseInfo baseInfol = new BaseInfol();
baseInfol.productKey = "alj7SyR***";
baseInfol.deviceName = "safasdf";
subDevices.add (baseInfol) ;
LinkKit.getInstance () .getGateway () .gatewaySubDevicRegister (subDevices, new IConne
ctSendListener () {
@Override
public void onResponse (ARequest request, AResponse response) {
ALog.i (TAG, "The sub-device is registered: " + JSONObject.toJSONString (re
sponse) ) ;
}
QOverride
public void onFailure (ARequest request, AError error) {
ALog.i (TAG, "Failed to register the sub-device: " + JSONObject.toJSONStri

For more information about dynamic registration of devices, see Overview.

Step 3: Connect the sub-device to 10T Platform by using the
gateway.
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/**

* Before you call an API operation to connect the sub-device to IoT Platform, make sur

e that a topological relationship is added between the sub-device and the gateway. After th

e gateway discovers a connected sub-device, the gateway reports the information about the s

ub-device to IoT Platform.

* After the sub-device is connected to IoT Platform by using the gateway, the gateway

can subscribe to topics and publish messages for the sub-device.

*/

public void gatewaySubDeviceLogin () {

BaseInfo baseInfol = new BaseInfol();
baseInfol.productKey = "alj7SyR****";

baseInfol.deviceName = "safasdf";

LinkKit.getInstance() .getGateway () .gatewaySubDeviceLogin (baseInfol, new ISubDeviceA

ctionListener () {

@Override

public void onSuccess () {

// The gateway connects the sub-device to IoT Platform.

// The gateway can subscribe to topics or publish messages for the sub-devi

ce. The gateway can also delete or disable the sub-device.
// subDevDisable (null) ;
// subDevDelete (null);

}

@Override

public void onFailed (AError aError) {
ALog.d(TAG, "onFailed() called with: aError = [" + aError + "]");

Appendix: Sample code

A gateway discovers a connected sub-device and reports the information about the sub-device to loT
Platform. IoT Platform establishes a logical channel between the sub-device and IoT Platform. The sub-
device uses the physical channel of the gateway to communicate with loT Platform. The preceding
process can be implemented in the following sample code:

package com.aliyun.iot.api.common.deviceApi;
com.alibaba.fastjson.JSONObject;

import
import
import
import
import
import
import
import
import
import
import
import
import
import

import

com

com.

com.

com.

com.

com.

com.

com

com

com

com

com

com.

com.

.alibaba.fastjson.TypeReference;

.aliyun.
.aliyun.
.aliyun.
.aliyun.

.aliyun.

aliyun.
aliyun.
aliyun.
aliyun.

aliyun.

aliyun.

aliyun.

aliyun.alink.
alink.
.dm.api.InitResult;

alink.

alink

alink

alink.

alink

alink.

alink

alink.

alink

alink.

alink.

dm.api.BaseInfo;

dm.api.DevicelInfo;

dm.api.SignUtils;

.dm.model.ResponseModel;

linkkit.api.ILinkKitConnectListener;

.linkkit.api.IoTMgttClientConfig;

linkkit.api.LinkKit;

.linkkit.api.LinkKitInitParams;

linksdk.channel.gateway.api.subdevice.ISubDeviceActionListener;

.linksdk.channel.gateway.api.subdevice.ISubDeviceChannel;

linksdk.channel.gateway.api.subdevice.ISubDeviceConnectlListener;

linksdk.channel.gateway.api.subdevice.ISubDeviceRemovelListener;
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import com.aliyun.alink.linksdk.cmp.core.base.AMessage;
import com.aliyun.alink.linksdk.cmp.core.base.ARequest;
import com.aliyun.alink.linksdk.cmp.core.base.AResponse;
import com.aliyun.alink.linksdk.cmp.core.listener.IConnectSendListener;
import com.aliyun.alink.linksdk.tools.AError;
import com.aliyun.alink.linksdk.tools.ALog;
import java.util.*;
import static com.aliyun.alink.linksdk.tools.ALog.LEVEL DEBUG;
public class DeviceTopoManager {

private static String regionId = "cn-shanghai";

private static final String TAG = "TOPO";

// The information about the gateway device.

private static String GWproductKey = "alBxp***x*xkxin;
private static String GWdeviceName = "XMtrv3y***xxxkxkxkxin,
private static String GWdeviceSecret = "19xJINybifnmgc*****x&x&xLxxm,

public static void main(String[] args) {
/**
* The information about the MQTT connection.
*/
DeviceTopoManager manager = new DeviceTopoManager () ;
/**
* The Java HTTP client of this device supports TSLvl1.2.
*/
System.setProperty ("https.protocols", "TLSv2");
manager.init () ;
}
public void init () {
LinkKitInitParams params = new LinkKitInitParams () ;
/**
* Specify the parameters for MQTT initialization.
Y
IoTMgttClientConfig config = new IoTMgttClientConfig();
config.productKey = GWproductKey;
config.deviceName = GWdeviceName;
config.deviceSecret = GWdeviceSecret;
config.channelHost = GWproductKey + ".iot-as-mgtt." + regionId + ".aliyuncs.com:188
3";
/**
* Specify whether to receive offline messages.
* The cleanSession field that corresponds to the MQTT connection.
*/
config.receiveOfflineMsg = false;
params.mgttClientConfig = config;
ALog.setLevel (LEVEL DEBUG) ;
ALog.i (TAG, "mgtt connetcion info=" + params) ;
/**
* Configure the initialization and pass in the certificate information about the g
ateway device.
Y
DeviceInfo deviceInfo = new DeviceInfo () ;
deviceInfo.productKey = GWproductKey;
deviceInfo.deviceName = GWdeviceName;
deviceInfo.deviceSecret = GWdeviceSecret;

params.deviceInfo = devicelInfo;

/**Tetahlich a2 AAnnamntiAn %%/

> Document Version: 20220624 193



Best Practices-Device management MIBEMTE
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LinkKit.getInstance () .init (params, new ILinkKitConnectListener () {
public void onError (AError aError) {
ALog.e (TAG, "Init Error error=" + aError);
}
public void onInitDone (InitResult initResult) {
ALog.i (TAG, "onInitDone result=" + initResult);
// Obtain the topological relationships of the gateway and check whether a
topological relationship exists between the gateway and the sub-device.
// If a topological relationship exists between the gateway and the sub-dev
ice, the gateway connects the sub-device to IoT Platform.
getGWDeviceTopo () ;
// Dynamically register the sub-device to obtain a DeviceSecret for the sub
—device. If the gateway has obtained the certificate of the sub-device, skip this step.
// When you create the sub-device in IoT Platform, set the deviceName param
eter to the serial number or MAC address of the sub-device.
gatewaySubDevicRegister () ;
//Specify the information about the sub-device for which you want to add a
topological relationship.

gatewayAddSubDevice () ;

}
/**
* Obtain the topological relationships of the gateway and check whether a topological
relationship exists between the gateway and the sub-device.
*/
private void getGWDeviceTopo () {

LinkKit.getInstance () .getGateway () .gatewayGetSubDevices (new IConnectSendListener ()

@Override
public void onResponse (ARequest request, AResponse aResponse) {
ALog.i (TAG, "The topological relationships of the gateway are obtained: " +
JSONObject.toJSONString (aResponse) ) ;
// Obtain a list of sub-devices.
try {
ResponseModel<List<DeviceInfo>> response = JSONObject.parseObject (aResp
onse.data.toString (), new TypeReference<ResponseModel<List<DeviceInfo>>>() {
}.getType()) ;
// TODO. Write code based on your actual application scenario.
} catch (Exception e) {

e.printStackTrace () ;

}
@Override
public void onFailure (ARequest request, AError error) {
ALog.i (TAG, "Failed to obtain the topological relationships of the gateway:
" + JSONObject.toJSONString (error)) ;
}
1) i
}
/**
* Dynamically register the sub-device to obtain a DeviceSecret for the sub-device. If
the gateway has obtained the certificate of the sub-device, skip this step.

* When vou create the sub-device in IoT Platform, set the deviceName parameter to the
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serial number or MAC address of the sub-device.

*/
private void gatewaySubDevicRegister () {
List<BaseInfo> subDevices = new ArrayList<>();
BaseInfo baseInfol = new BaseInfo();
baseInfol.productKey = "alj7SyR*x***kxxkxxis
baseInfol.deviceName = "testl23****xkixxn,
subDevices.add (baseInfol) ;

LinkKit.getInstance () .getGateway () .gatewaySubDevicRegister (subDevices, new IConnect

SendListener () {

@Override
public void onResponse (ARequest request, AResponse response) {
ALog.i (TAG, "The sub-device is registered: " + JSONObject.toJSONString (resp

onse)) ;
}
@override
public void onFailure (ARequest request, AError error) {
ALog.i (TAG, "Failed to register the sub-device: " + JSONObject.toJSONString
(error)) ;
}
}) i
}
/**
* Specify the information about the sub-device for which you want to add a topological
relationship.
*/

private void gatewayAddSubDevice () {

BaseInfo baseInfol = new BaseInfol();

baseInfol.productKey = "alj7Sy*****xxxkxkxixn,
baseInfol.deviceName = "safasdx*x*xxxxm;
String deviceSecret = "T71zCIIWHMGE*** %%k kxkhkkkxn;

LinkKit.getInstance () .getGateway () .gatewayAddSubDevice (baseInfol, new ISubDeviceCon

nectListener () {

//

@override

public String getSignMethod() {
// The signature method that you use to sign the request.
return "hmacshal";

}

@Override

public String getSignValue () {
// Generate a signature based on the DeviceSecret.
Map<String, String> signMap = new HashMap<>();
signMap.put ("productKey", baselInfol.productKey) ;
signMap.put ("deviceName", baseInfol.deviceName) ;

signMap.put ("timestamp", String.valueOf (System.currentTimeMillis()));

signMap.put ("clientId", getClientId());
return SignUtils.hmacSign (signMap, deviceSecret) ;

}

@0override

public String getClientId() {
// Set the clientId parameter as needed.
return "id";

}

@Override

> Document Version: 20220624 195



Best Practices-Device management MIBEMTE

public Map<String, Object> getSignExtraData () {
return null;
}
@Override
public void onConnectResult (boolean isSuccess, ISubDeviceChannel iSubDeviceChan
nel, AError aError) {
// Handle the result of the operation for adding the topological relationsh
ip between the sub-device and the gateway.
if (isSuccess) {
// After the topological relationship is added, you can use the gateway
to connect the sub-device to IoT Platform.
ALog.i (TAG, "The topological relationship is added: " + JSONObject.todS
ONString (iSubDeviceChannel)) ;
// Connect the sub-device to IoT Platform by using the gateway.
gatewaySubDeviceLogin () ;
} else {
ALog.i(TAG, "Failed to add the topological relationship: " + JSONObject
.toJSONString (aError)) ;
}
}
@Override
public void onDataPush (String s, AMessage aMessage) {
}
}):
}
public void gatewayDeleteSubDevice () {
BaseInfo baseInfol = new BaseInfo();
baseInfol.productKey = "alj7S****xxkxskxdxsxn,
baseInfol.deviceName = "saf***xxkxxin;
LinkKit.getInstance () .getGateway () .gatewayDeleteSubDevice (baseInfol, new ISubDevice
Removelistener () {
@Ooverride
public void onSuceess () {
// The sub-device is deleted. You can disconnect the sub-device before you

delete it.
}
@Override
public void onFailed (AError aError) {
// The sub-device failed to be deleted.
}
}) i
}
/**

* Before you call an API operation to connect the sub-device to IoT Platform, make sur
e that a topological relationship is added between the sub-device and the gateway. After th
e gateway discovers a connected sub-device, the gateway reports the information about the s
ub-device to IoT Platform.
* After the sub-device is connected to IoT Platform, the gateway can subscribe to topi
cs and publish messages for the sub-device.
Y
public void gatewaySubDeviceLogin () {
BaseInfo baseInfol = new BaselInfo();
baseInfol.productKey = "alj7SyR***xkxkxkxsim,

baseInfol.deviceName = "safa*****x*x*xxn;
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LinkKit.getInstance () .getGateway () .gatewaySubDeviceLogin (baseInfol, new ISubDeviceA

ctionListener () {
@Ooverride
public void onSuccess () {
// The gateway connects the sub-device to IoT Platform.
// The gateway can subscribe to topics or publish messages for the sub-devi
ce. The gateway can also delete or disable the sub-device.
// subDevDisable (null) ;
// subDevDelete (null) ;

}

@Override
public void onFailed (AError aError) {
ALog.d(TAG, "onFailed() called with: aError = [" + aError + "1");

> Document Version: 20220624 197



Best Practices-Maintenance and Mo
nitoring

MEXNE S

4.Maintenance and Monitoring

4.1. Use CloudMonitor to monitor loT

resources
4.1.1. Overview

You can use CloudMonitorto monitor IoT resources based on events and thresholds. Event monitoring
and alerting are performed based on the throttling rules of IoT Platform. Threshold monitoring and
alerting are performed based on the metric values that you have specified.

Context

Scenario

A total of 5,000 temperature sensors are deployed in an area that is designed to store hazardous
goods. These devices communicate with IoT Platform by using the MQTT protocol. Every time the
temperature fluctuates by 0.1°C, the temperature sensor sends the real-time temperature to loT
Platform. When the temperature exceeds 25°C, IoT Platform forwards the temperature data to
Function Compute for subsequent processing.

Temperature data is an important factor that must be constantly monitored to ensure the safety of
the storage area. The control room needs to obtain the temperature fluctuation data at each
detection point in real time and respond in a timely manner. Therefore, the temperature sensors must
be online 24 hours a day. If a large number of devices are offline at the same time, or the devices are
unstable (repeatedly switching between online and offline), repair the devices and networks. A quick
rise in temperature may pose a significant number of security risks that require an immediate response.

The temperature sensors at each detection point must be online 24 hours a day. Make sure that the
data reported by the sensors can reach Function Compute and monitor the usage of loT Platform
resources under the current account. This helps to prevent throttling and ensure that loT Platformcan
receive temperature data in a timely manner.

Project design

Before using CloudMonitorto monitor loT Platform resources, create alert rules for loT Platforminthe
CloudMonitor console.

Set the following events to trigger alerts:

e The number of connection requests that a device sends per minute reaches the maximum limit.

e The number of connection requests that the current account sends to IoT Platform per second
reaches the maximum limit.

e The number of requests that the current account publishes per second reaches the maximum limit.
e The number of messages that a device sends per second reaches the maximum limit.

e The number of requests that the current account sends to the rules engine per second reaches the
maximum limit.

Set the following thresholds to trigger alerts:

e The number of online devices (The MQTT protocol is used to connect the devices to loT Platform).

e The number of property reporting failures.
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e The number of messages that the rule engine forwards to Function Compute (FC).

Procedure for configuring alert rules
Create a product and devices

Configure alert contacts

Create event-triggered alert rules

Create threshold-triggered alert rules

4.1.2. Create a product and devices

In this best practice, temperature sensors are monitored. This article describes how to create a
temperature sensor product and devices in the loT Platform console. This topic also describes how to
define a Thing Specification Language (TSL) model and create a data forwarding rule.

Procedure
1. Logontothe loT Platformconsole.
2.

3. Inthe left-side navigation pane, choose Devices > Products. On the page that appears, click
Create Product to create a product. For more information, see Create a product.
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Create a product (device model)

Product Infarmation (Device TSL)

* Product Mame

Thermaorneter

* Category
Standard Category ® Custom Category

¥ Mode Type

w3 1 .

[~ 0, 2
Direcths C..) Gateway .. Gateway ..

Metwaorking and Data Format

* Metwork Connection Method

WYIF

* Data Type
ICA Standard Data Format (Alink JSOM)

* Authentication Mode

Cevice Secret

4. Define afeature.

i. Onthe Product Details page, clickthe Define Feature tab. ClickEdit Draft and then Add

Self-defined Feature to define a temperature property forthe product.
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Editself-Defined Feature

* Feature Type:
Froperties
* Feature Mame:

temperature

* [dentifier;

temperature

¥ Data Type:

intaz e

*Walue Range:

-4l ~ 100

* Step Sire:
1

LInit;

* FHegdnirite:
Readitrite (® Read-only

Description:

ii. Afterthe feature is added, click Release online to publish the TSL model.

5. Inthe left-side navigation pane, choose Devices > Devices. On the page that appears, click Batch
Add to add multiple devices.

In this example, you need to add 5,000 devices. You can add a maximum of 1,000 devices at a time.
Therefore, you must add devices a minimum of five times. For more information, see Create multiple
devices at a time.

6. Inthe left-side navigation pane, choose Rules > Data Forwarding. On the page that appears,
create a data forwarding rule to allow forwarding of the temperature data reported by the
temperature sensor to Function Compute.
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i. Click Create Rule to create a rule that processes JSON-formatted data.

ii. ClickView to go to the details page of the rule and write an SQL statement to process data.

The SQL statement in this example filters data fromthe reported property data. The SQL
statement returns the values of the deviceName and Temperature fields when the
temperature is higher than 25°C. The two fields are forwarded to Function Compute.

Write Sl *

Fule Query Expression:

SELEC deviceMame() as deviceMame, itemns.temperature.value

T
FROM "fsysfs +/thing/event/property/post"
WHER  ternperature=23
E

e Field:

deviceMame as deviceMame, items temperature valu

® Topic :
TSL Data Reporting R
Thermuometer A
All eguipment (+) 7
thing/eventipropertypost R

» Conditions {(Optional)

temperature=2%5

Cancel
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ii. Add a data forwarding operation and set the data forwarding destination to Function
Compute.

Add Qperation e

i Ifthe target cloud service does not function properly, the data forwarding
may fail. 10T Platform retries the data forwarding after one second, three
seconds, and ten secands. The retry strategy may change. IFall retry atte
mpts fail, the data will be discarded. Ifyou want to increase the data reli
ability wau can add remedial actions to forward the data that failed to he f
orwarded during retry atternpts to other cloud services. [fthe data still ca
nnot be forvarded, the system does not attempt mare retries.

Select Operation:

Send to Function Compute N
* Region:

China (Shanghai) R
* Serice:

loTweather! | Create Service
* Function:

weather_gqueny | Create Function

* Authorization:

AlivunlOTACcessingFCRole | Create RAM Role

Cancel

iv. Afterthe rule configurationis complete, return to the Data Forwarding page and click Start
to enable the rule.

For more information, see Configure a data forwarding rule.

What's next

Configure alert contacts
Create event-triggered alert rules

Create threshold-triggered alert rules

4.1.3. Configure alert contacts

If Cloud Monitor detects an exception, it sends an alert notification to an alert group by using an email
or DingTalk chatbot message. You must create an alert contact and add the contact to the alert
group. When you create an alert rule, select the alert group to receive alert notifications.

Prerequisites

To receive alerts by using a DingT alk chatbot, you must create a DingT alk chatbot (an intelligent
assistant for a DingTalk group) in the DingT alk application. For more information, see Receive alert
notifications from a DingTalk group.
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Procedure

1. Create an alert contact. For more information, see Create an alert contact.

2. Create an alert group and add the alert contact to the alert group. For more information, see
Create an alert contact group.

You can also add alert contacts to an existing alert group. For more information, see Add multiple
alert contactsto an alert contact group at a time.

What's next

Create event-triggered alert rules

Create threshold-triggered alert rules

4.1.4. Create event-triggered alert rules

loT Platformimposes limits on the frequency of connection requests, the frequency of upstreamand
downstream communication, and the frequency of message forwarding. When the limits are reached,
throttling is triggered, and this will have an adverse effect on the daily operation of your business. With
the monitoring and alerting functions of CloudMonitor, you can receive alert notifications to perform
corresponding business adjustments in a timely manner.

Context

For loT Platform usage restrictions, see Limits.

Procedure

1. Log onto the CloudMonitor console.

2. Inthe left-side navigation pane, choose Alarms > Alarm Rules.

3. Onthe Alarm Rules page, choose Event Alarm > Create Event Alert.
4

. Inthe Create/Modify Event Alert dialog box that appears on the right side of the page, entera
rule name, configure an alert rule, and then select an alert group and a notification method. Click
OK.

The following table describes how to configure an event-triggered alert rule.

Parameter Description

Alarm Rule Name Follow the instructions to set a valid rule name.
Event Type Select System Event.

Product Type Select IoT Platform.

Event Type Select All types.

Event Level Select All Levels.
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Parameter Description
Select the events that you want to monitor.
o Account_Connect_QPS_Limit
o Device_Connect_QPM_Limit
Event Name o Account_Uplink_QPS_Limit
o Device_Uplink_QPS_Limit
o Account_RuleEngine_DataForward_QPS_Limit
Resource Range Select All Resources.
Alarm Type Select Alert Notification. Select an alert group and a notification method.

5. Test the alert rule.

i. Onthe Alarm Rules page, find the alert rule and clicktest inthe Actions column.

ii. Inthe Create event test dialog box that appears on the right side of the page, select an
event name, modify the alert notification content, and then click OK to run a test onthe alert
rule.

Afteryou select an event name, the JSON-formatted alert notification content is displayed in
the text box below. You can modify the notification content.

iii. Checkthat the contacts of the alert group can receive the modified alert notification.

For example, members in a DingT alk group will receive a message that is similarto the
following.

What's next

Create threshold-triggered alert rules

4.1.5. Create threshold-triggered alert rules

You can create threshold-triggered alert rules in CloudMonitor to monitor loT resources, and send alert
notifications to specific contacts by using the specified method. You can monitor the number of online
devices that are under a specific product, the number of TSL model communication failures, and the
number of times that data is forwarded by the rule engine.

Procedure

1.

vk wN

Log onto the CloudMonitor console.

In the left-side navigation pane, choose Alarms > Alarm Rules.

Onthe Threshold Value Alarm tab of the Alarm Rules page, click Create Alarm Rule.
Select IoT Platform as the related resource and specify the product to be monitored.

Set alert rules. Add the required alert rules.

In this example, three threshold-triggered alert rules are set, and the alert mute period is set to 10
minutes. (If an alert is not cleared 10 minutes after the alert is triggered, the alert notification will
be sent again.)
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o Set Alarm Rules
Event alarm has been moved to event monitoring, Wiew the Detail
Al
A DeviceEventReportError

Rule:
Rule ) ' )

L DeviceEventRepartErraor = 15Minute - || 3 periods - || Murmber | == - {100
Description:
Alarmn Delete
RLiE: MessageCountForwarded Through
Rule ) )

. MessageCountForwarded Throuot | IMinute = || 3 periods = Mumber = == = 110000
Description:
Alarmn Delete

OrlimeDevicesCount_MOTT

Rule:
Rule ) ) ) ) )

. OrlirneDevicesCount_MOTT = |SMinute = || 3 periods = || deviceMurn | | = - 4800
Description:

+2dd Alarm Rule

Mute for: 24 h - @
Bffective  [opon < Tac[2358 -
Period:

The following table describes the rules shown in the preceding figure.

Rule name Rule description

The statistical period is 15 minutes.

) An alert is triggered if a minimum of

DevicePropertyReportE 99 . .

100 property reporting failures are
rror .

detected for three consecutive

statistical periods.

The statistical period is T minute. An
MessageCountForward alert is triggered if a minimum of

edThroughRuleEngine_

FC

OnlineDevicesCount_M

QTT

10,000 messages are forwarded to
Function Compute for three
consecutive statistical periods.

The statistical period is 5 minutes.
An alert is triggered if less than
4,800 devices are online for three
consecutive statistical periods.

Description

This rule is used to monitor the
property reporting status of all
devices under the temperature-
based sensory product. If a large
number of consecutive property
reporting failures occur, you must
check the devices and network
status.

According to the design, when the
temperature reported by a device is
higher than 25°C, the rules engine
forwards the temperature data to
Function Compute. If 10,000
messages are forwarded, a large
number of devices have reported
more than two temperatures that
are above 25°C within 1 minute. We
recommend that you monitor the
temperature change and perform
early troubleshooting of potential
safety risks.

A large number of devices are
offline at the same time. The
devices and network status must be
checked.
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6. Set the alert notification method. Select an alert group and a notification method. You can specify
or configure the otherfields.

7. Click Confirm to complete rule creation.

Result

After a threshold-triggered alert rule is created, CloudMonitor continuously monitors loT Platform
resources according to the rule. When an alert rule is triggered, CloudMonitor sends alert notifications
by using the specified method.

4.2. Configure OTA updates for

devices
4.2.1. Overview

Over-the-Air Technology (OTA) is a basic feature of IoT Platform. OTA allows you to update the
firmware of loT devices worldwide. This chapter uses an example to describe the OTA update process.
Sample codes are also provided for configuring OT A updates on devices.

OTA update process for device firmware

loT Platform

Device OTA Server
Console

1 Report the current version

Jota/device/inform/$ {YourProductKey} /$ {VourDeviceName}

mMaQTT
protocol
Add the update package in the console
3  sendthe update package URL to the device 2 and initiate the update request
Jota/device/upgrade/§ [YourProductEev} /§ (YourDeviceName}
4 Download the package using HTTPS protocol Display the update progress in the console
5 Report the update progress
/ota/device/progress/§ {YourProductEey} /§ (YourDeviceName}

mMaQTT
protocol

Update completed. Report the latest version Display that the update is successful in the console
6
Jota/devicefinform/$ {YourProductKev} /8 {YourDeviceName}

1. (Optional) The device reports the current firmware versionto the topic: /ota/device/inform/${Yo

urProductKey}/${YourDeviceName }
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Wielg 1,
"params": {

"version": "1-0-0"

2. The device subscribesto the topic: /ota/device/upgrade/${YourProductKey}/${YourDeviceName}
where loT Platform pushes OTA notifications.

The format of update notifications:

"code":"1000",
"data": {
"size":11472299,
"sign":"83254ac9%6el4dlaffb8aad2cbfecIFxF*",
"version":"2-0-0",
"url":"https://iotx-ota.oss-cn-shanghai.aliyuncs.com/ota/dbab6f742ae389040db88f
c2500b**** /ck0g51yav00003i7hezxe****  zip?Expires=1568951190&0SSAccessKeyId=cS8uRRy54Rsz
*rxxgSignature=nkO0sogaxtyp7dYvKZnjNQ$2BZ8Q9****",
"signMethod":"Md5",
"md5" :"83254ac96eldlaffb8aad2chbfeco**x*"
}o
"id":1568864790381,

"message" :"success"

3. The device downloads the firmware package fromthe URL that is provided in the update
notification and performs a local update.

4. The device reports the update progress to the topic: /ota/device/progress/${YourProductKey}/$

{YourDeviceName }

The format of report messages:

llid"- 1

. ’

"params": {
"step":"1",
"desc":" xxxxxxxx "

5. The device reports the updated firmware versionto the topic: /ota/device/inform/${YourProduc

tKey}/S${YourDeviceName }

The format of report messages:

"id": 1,
"params": {

"version": "2-0-0"
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4.2.2. Configure OTA update for devices

You must enable over-the-air (OTA) update when you develop devices. When you prepare an update

file, you can update the original firmware configurations and compile the update file into a file format
that is supported by loT Platform. This article provides the sample code that shows how to configure
OTA update for a device.

Prerequisites

A product and devices are created inthe IoT Platform console. The device certificate is obtained.

Context

In this example, Link SDK V3.x for C provided by Alibaba Cloud is used to develop devices. For more
information about how to download the SDK demo, visit

In the SDK demo, fotaindicates OTA update.

Connect a device to 10T Platform

1. Runthe make menuconfig command to go to the compilation settings page. In compilation
settings, select FEATURE_OTA_ENABLED (NEW) to enable OTA update for the device.

.config - Main Menu

Main Menu 7
Arrow keys navigate the menu. <Enter> selects submenus -—-—> {or empty
submenus ——-). Highlighted letters are hotkeys. Pressing <Y>
includes, <N> excludes, <H> modularizes features. Press <Esc><Esc> to
exit, <?> for Help, </> for Search. Legend: [=] built-in [ 1

[«] FEATURE_INFRA_LOG (NEW)
Log Configurations ---—>

[=]1 FEATURE MQTT COMM_ENABLED (NEW)
MOTT Configurations -——>

[ 1 FEATURE_DYNAMIC_REGISTER (MHEM)

[«] FEATURE_DEVICE_MODEL_ENABLED (NEW)
Device Model Configurations —>

[ FEATURE_SUPPORT_TLS (NEW)

[ FEATURE ATH ENABLED {MNEW)

[+]1 FEATURE OTA_ENABLED (NEW)

[ FEATURE _COAP COMM_ENABLED {NEW)

<Select> RGNS

2. Gotothe src/dev_model/examples directory and open the linkkit_example_solo.c sample file.

The sample file contains the following code for OTA update.
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/** fota event handler **/
static int user fota event handler (int type, const char *version)

{

char buffer[128] = {0};

int buffer length = 128;

/* 0 - new firmware exist, query the new firmware */
if (type == 0) {

EXAMPLE TRACE ("New Firmware Version: %s", version);
I0OT Linkkit Query (EXAMPLE MASTER DEVID, ITM MSG QUERY FOTA DATA, (unsigned char
*)buffer, buffer length);
}

return 0;

3. Edit the device information in the linkkit_example_solo.cfile.

char g product key[IOTX PRODUCT KEY LEN + 1] = "alGOLGy****";

char g product secret[IOTX PRODUCT SECRET LEN + 1] = "UdW1LOv7QiMm****";

char g device name[IOTX DEVICE NAME LEN + 1] = "test01l";

char g device secret[IOTX DEVICE SECRET LEN + 1] = "rtpyII8e9HO7CT7BGizYQs010htRx***";

4. Runthe programto connect the device to loT Platform.

Update firmware configurations

1. Edit the linkkit_example_solo.cfile to update the configurations based on your workload
requirements.

For more information about the update file in this example, see the sample update file.
2. Compile the updated linkkit_example solo.cfile and save the compiled BIN file.
In this example, the saved BIN file is named gpp_70017.

In Push firmware files to devices, you need to add an update package in the IoT Platform console and
upload the BIN file.

Sample update file

/ *
* Copyright (C) 2015-2018 Alibaba Group Holding Limited
*/
#include "infra config.h"
#include <stdio.h>
#include <string.h>
#include <stdlib.h>
#ifdef  UBUNTU SDK DEMO
#include <unistd.h>
#endif
#include "infra types.h"
#include "infra defs.h"
#include "infra compat.h"
#ifdef INFRA MEM STATS
#include "infra mem stats.h"
#endif
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#include "dev model api.h"
#include "wrappers.h"
#include "cJSON.h"
#ifdef ATM ENABLED
#include "at api.h"
#endif
//#include "bind api.h"
char g product key[IOTX PRODUCT KEY LEN + 1] = "alGOLGy****";
char g product secret[IOTX PRODUCT SECRET LEN + 1] = "UdW1LOv7QiMm****";
char g_device_name[IOTX_DEVICE_NAME_LEN + 1] = "teset01";
char g device secret[IOTX DEVICE SECRET LEN + 1] = "rtpyII8e9HI7CT7BGizYQsO010htRx****";
#define EXAMPLE TRACE(...) \
do { \
HAL Printf("\033[1;32;40m%s.%d: ", func , LINE ); \
HAL Printf( VA ARGS ); \
HAL Printf ("\033[0m\r\n"); \

} while (0)
void run ubuntu wifi provision example ()
{
#ifdef  UBUNTU SDK DEMO
#if defined(WIFI_PROVISION_ENABLED)
"linkkit";
{0};

char *wifi name
char buffer[128]

int ret;

extern int awss config press();
extern int awss start();

memset (buffer, 0, 128);

snprintf (buffer, 128, "nmcli connection down %s", wifi name);
ret = system(buffer);

memset (buffer, 0, 128);

snprintf (buffer, 128, "nmcli connection delete %s", wifi name);

ret
sleep (15);
awss_config press();

system (buffer) ;

awss_start();

#endif
#endif
}
#define EXAMPLE MASTER DEVID (0)
#define EXAMPLE YTIELD TIMEOUT MS (200)
typedef struct {

int master devid;

int cloud connected;

int master initialized;
} user example ctx t;
static user example ctx t g user example ctx;
static user example ctx t *user example get ctx(void)
{
return &g user example ctx;
}
void user post raw data(void)
{
int res = 0;

user example ctx t *user example ctx

user_ example get ctx();
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unsigned char raw_data[2] = {0x01, 0x02};
res = IOT Linkkit Report (user example ctx->master devid, ITM MSG POST RAW DATA,
raw_data, 7);

EXAMPLE TRACE ("Post Raw Data Message ID: %d", res);
}
static int user down raw data arrived event handler (const int devid, const unsigned char *p
ayload,

const int payload len)

EXAMPLE TRACE ("Down Raw Message, Devid: %d, Payload Length: %d", devid, payload len);
// user post raw data();
return 0;
}
/** cloud connected event callback */
static int user connected event handler (void)
{
EXAMPLE TRACE ("Cloud Connected") ;
g_user example ctx.cloud connected = 1;
return 0;
}
/** cloud disconnected event callback */
static int user disconnected event handler (void)
{
EXAMPLE TRACE ("Cloud Disconnected");
g _user example ctx.cloud connected = 0;
return 0;
}
/* device initialized event callback */
static int user initialized(const int devid)
{
EXAMPLE TRACE ("Device Initialized");
g user example ctx.master initialized = 1;
return 0;
}
/** recv property post response message from cloud **/
static int user report reply event handler(const int devid, const int msgid, const int code
, const char *reply,

const int reply len)

EXAMPLE TRACE ("Message Post Reply Received, Message ID: %d, Code: %d, Reply: %.*s", msg
id, code,
reply len,
(reply == NULL) ? ("NULL") : (reply)):
return 0;
}
/** recv event post response message from cloud **/
static int user trigger event reply event handler(const int devid, const int msgid, const i
nt code, const char *eventid,

const int eventid len, const char *message, const int message len)

EXAMPLE TRACE ("Trigger Event Reply Received, Message ID: %d, Code: %d, EventID: %.*s, M
essage: %.*s",
msgid, code,

eventid len,
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eventid, message len, message);
return 0;

}

/** recv property setting message from cloud **/

static int user property set event handler(const int devid, const char *request, const int

request len)
{
int res = 0;
EXAMPLE TRACE ("Property Set Received, Request: %s", request);

res = IOT Linkkit Report (EXAMPLE MASTER DEVID, ITM MSG POST PROPERTY,

(unsigned char *)request, request len);
EXAMPLE TRACE ("Post Property Message ID: %d", res);
return O;

}

static int user service request event handler(const int devid, const char *serviceid, const

int serviceid len,
const char *request, const int request len,

char **response, int *response len)

int add result = 0;
cJSON *root = NULL, *item number a = NULL, *item number b = NULL;
const char *response fmt = "{\"Result\": %d}";
EXAMPLE TRACE ("Service Request Received, Service ID: %.*s, Payload:
serviceid, request);
/* Parse Root */
root = cJSON Parse (request);
if (root == NULL || ! cJSON IsObject (root)) {
EXAMPLE TRACE ("JSON Parse Error");
return -1;

}

%$s", serviceid len,

if (strlen("Operation Service") == serviceid len && memcmp ("Operation Service", service

id, serviceid len) == 0) {
/* Parse NumberA */
item number a = cJSON GetObjectItem(root, "NumberA");

if (item number a == NULL || ! cJSON_ IsNumber (item number a)) {

cJSON Delete (root) ;
return -1;
}
EXAMPLE TRACE ("NumberA = %d", item number a->valueint);
/* Parse NumberB */
item number b = cJSON GetObjectItem(root, "NumberB");

if (item number b == NULL || ! cJSON IsNumber (item number b)) {

cJSON_Delete (root) ;
return -1;

}
EXAMPLE TRACE ("NumberB = $d", item number b->valueint);

add result = item number a->valueint + item number b->valueint;

/* Send Service Response To Cloud */
*response len = strlen(response fmt) + 10 + 1;
*response = (char *)HAL Malloc (*response len);
if (*response == NULL) {
EXAMPLE TRACE ("Memory Not Enough");

return -1;

o n . IRV W

> Document Version: 20220624

213



Best Practices-Maintenance and Mo

M5

nitoring

}

lelseL (| ~respolise, U, "Lea‘punse_u;‘u; 12
HAL Snprintf (*response, *response len, response fmt, add result);
*response len = strlen (*response);

}

cJSON_Delete (root) ;

return 0;

static int user timestamp reply event handler (const char *timestamp)

{

}

EXAMPLE TRACE ("Current Timestamp: %s", timestamp);

return 0;

/** fota event handler **/

static int user fota event handler (int type, const char *version)

{

char buffer([128] = {0};

int buffer length = 128;

/* 0 - new firmware exist, query the new firmware */
if (type == 0) {

EXAMPLE TRACE ("New Firmware Version: %s", version);
IOT Linkkit Query (EXAMPLE MASTER DEVID, ITM MSG QUERY FOTA DATA, (unsigned char *)b

uffer, buffer length);

}

}

return 0;

/* cota event handler */

static int user cota event handler(int type, const char *config id, int config size, const

char *get type,

rl)

{

const char *sign, const char *sign method, const char *u

char buffer[128] = {0};
int buffer length = 128;
/* type = 0, new config exist, query the new config */
if (type == 0) {
EXAMPLE TRACE ("New Config ID: %s", config id);
EXAMPLE TRACE ("New Config Size: %d", config size);
EXAMPLE TRACE ("New Config Type: %s", get type);
EXAMPLE TRACE ("New Config Sign: %s", sign);
EXAMPLE TRACE ("New Config Sign Method: %s", sign method) ;
EXAMPLE_TRACE ("New Config URL: %s", url);
IOT Linkkit Query (EXAMPLE MASTER DEVID, ITM MSG QUERY COTA DATA, (unsigned char *)b

uffer, buffer length);

}

}

return 0O;

void user post property (void)

{

static int cnt = 0;
int res = 0;
char property payload[30] = {0};
HAL Snprintf (property payload, sizeof (property payload), "{\"Counter\": %d}", cnt++);
res = IOT Linkkit Report (EXAMPLE MASTER DEVID, ITM MSG POST PROPERTY,

(unsigned char *)property payload, strlen(property payload));
FEXAMPT.E. TRACFE ("Post Probertv Messaace TD: %d". res):
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void user post event (void)
{
int res = 0;
char *event id = "HardwareError";
char *event payload = "{\"ErrorCode\": 0}";

res = IOT Linkkit TriggerEvent (EXAMPLE MASTER DEVID, event id, strlen(event id),
event payload, strlen(event payload)) ;
EXAMPLE TRACE ("Post Event Message ID: %d", res);
}
void user deviceinfo update (void)
{
int res = 0;
char *device info update = "[{\"attrKey\":\"abc\",\"attrvalue\":\"hello,world\"}]";
res = IOT Linkkit Report (EXAMPLE MASTER DEVID, ITM MSG DEVICEINFO UPDATE,
(unsigned char *)device info update, strlen(device info update
)) i
EXAMPLE TRACE ("Device Info Update Message ID: %d", res);
}
void user deviceinfo delete (void)
{
int res = 0;
char *device info delete = "[{\"attrKey\":\"abc\"}]";
res = IOT Linkkit Report (EXAMPLE MASTER DEVID, ITM MSG DEVICEINFO DELETE,
(unsigned char *)device info delete, strlen(device info delete
));
EXAMPLE TRACE ("Device Info Delete Message ID: %d", res);
}
static int user cloud error handler (const int code, const char *data, const char *detail)
{
EXAMPLE TRACE ("code =%d ,data=%s, detail=%s", code, data, detail);
return O;
}
static int dynreg device secret (const char *device secret)
{
EXAMPLE TRACE ("device secret: %s", device secret);
return 0;
}
static int user sdk state dump (int ev, const char *msg)
{
printf ("received state: -0x%04X(%s)\n", -ev, msg);
return 0;
}
int main(int argc, char **argv)
{
int res = 0;
int cnt = 0;
int auto quit = 0;
iotx linkkit dev meta info t master meta info;
int domain type = 0, dynamic register = 0, post reply need = 0, fota timeout = 30;
#ifdef ATM ENABLED
if (IOT _ATM Init() < 0) {
EXAMPLE TRACE ("IOT ATM init failed! \n") ;

return -1;
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}
#fendif
if (argc >= 2 && ! strcmp("auto quit", argv[1l])) {

auto quit = 1;

cnt = 0;
}
memset (&g user example ctx, 0, sizeof (user example ctx t));
memset (émaster meta info, 0, sizeof (iotx linkkit dev meta info t));
memcpy (master meta info.product key, g product key, strlen(g product key));
memcpy (master meta info.product secret, g product secret, strlen(g product secret));
memcpy (master meta info.device name, g device name, strlen(g device name));
memcpy (master meta info.device secret, g device secret, strlen(g device secret));
IOT SetLogLevel (IOT LOG DEBUG) ;
/*

* if the following conditions are met:

* 1) wifi provision is enabled,

u 2) current OS is Ubuntu,

* 3) a wireless card is inserted,

* 4) g ifname in HAL AWSS linux.c has been set to be the wireless card's name accor

ding to ifconfig,

& for example, the output of command "ifconfig" is like:

B wlx00259ce0**** Link encap:Ethernet HWaddr 00:25:9c:eQ:**:*x*
b UP BROADCAST PROMISC MULTICAST MTU:1500 Metric:1

w RX packets:8709 errors:0 dropped:27 overruns:0 frame:0

w3 TX packets:2457 errors:0 dropped:0 overruns:0 carrier:0

u collisions:0 txqueuelen:1000

w RX bytes:2940097 (2.9 MB) TX bytes:382827 (382.8 KB)

* then set g ifname = "00259ceQ****"

& 5) the linkkit-example-solo is running with sudo permission.

* Then you can run wifi-provision example in Ubuntu, just to uncomment the following
line.
*/
/* Register Callback */
IOT RegisterCallback (ITE STATE EVERYTHING, user sdk state dump);
IOT RegisterCallback (ITE CONNECT SUCC, user connected event handler);
IOT RegisterCallback (ITE DISCONNECTED, user disconnected event handler);
IOT RegisterCallback (ITE SERVICE REQUEST, user service request event handler);
IOT RegisterCallback (ITE PROPERTY SET, user property set event handler);
IOT RegisterCallback (ITE REPORT REPLY, user report reply event handler);
IOT RegisterCallback (ITE TRIGGER EVENT REPLY, user trigger event reply event handler);
IOT RegisterCallback (ITE TIMESTAMP REPLY, user timestamp reply event handler);
IOT RegisterCallback (ITE INITIALIZE COMPLETED, user initialized);
IOT RegisterCallback (ITE FOTA, user fota event handler);
IOT RegisterCallback (ITE COTA, user cota event handler);
IOT RegisterCallback (ITE CLOUD ERROR, user cloud error handler);
IOT RegisterCallback (ITE DYNREG DEVICE SECRET, dynreg device secret);
IOT RegisterCallback (ITE RAWDATA ARRIVED, user down raw data arrived event handler);
domain type = IOTX CLOUD REGION SHANGHAT;
IOT Toctl (IOTX IOCTL SET DOMAIN, (void *)&domain type);
/* Choose Login Method */
dynamic register = 0;
IOT Toctl (IOTX IOCTL SET DYNAMIC REGISTER, (void *)&dynamic register);
/* post reply doesn't need */
post reply need = 1;
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IOT Toctl (IOTX IOCTL RECV_EVENT REPLY, (void *)é&post reply need);
IOT Toctl(IOTX IOCTL FOTA TIMEOUT MS, (void *)&fota timeout);
do {
g_user example ctx.master devid = IOT Linkkit Open (IOTX LINKKIT DEV_TYPE MASTER, &m
aster meta info);
if (g user example ctx.master devid >= 0) {
break;
}
EXAMPLE TRACE ("IOT Linkkit Open failed! retry after %d ms\n", 2000);
HAL SleepMs (2000) ;
} while (1);
/* run ubuntu wifi provision example(); */
do {
res = IOT Linkkit Connect (g user example ctx.master devid);
if (res >= 0) {
break;
}
EXAMPLE TRACE ("IOT Linkkit Connect failed! retry after %d ms\n", 5000);
HAL SleepMs (5000) ;
} while (1);
while (1) {
IOT Linkkit Yield(EXAMPLE YIELD TIMEOUT MS);
/* Post Proprety Example */
if ((cnt % 2) == 0) {
/* user post property(); */
}
/* Post Event Example */

if ((cnt % 10) == 0) {

// user post event();
}
cnt++;

if ((cnt % 20)==0)
{

// IOT Bind Reset();
}
if (auto quit == 1 && cnt > 3600) {
break;

}

IOT Linkkit Close(g_user example ctx.master devid);
IOT DumpMemoryStats (IOT LOG DEBUG) ;

IOT SetLogLevel (IOT LOG NONE) ;

return 0;

4.2.3. Push firmware files to devices

This article describes how to push firmware files to devices by using the IoT Platformconsole. To
complete the process, you must performthe following operations: add an update package, verify the
update package, and start a batch update.
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Prerequisites
e The Perform OTA updates feature is supported on the devices to be updated.

Only devices for which the OTA service is enabled can report firmware versions, receive update
messages from loT Platform, download firmware, and perform OTA update operations.

e A firmware file is generated based on your business requirements. For more information about
generation methods and sample files, see Configure OTA update for devices.

Procedure

1. Logontothe loT Platformconsole.

2. Inthe left-side navigation pane, choose Maintenance > OTA Update.

3. Onthe OTA Update page, clickAdd Update Package.

4. Set the required parameters, upload the firmware file as the update package, and then click OK.

The following table describes some parameters. For more information about how to set other
parameters, see Overview.

Parameter Value
Types of Update Packages Full
Update Package Module default
Update Package Version 2-0-0
Signature Algorithm MD5

5. Onthe Update Package tab, click Verify in the Actions column of the update package. loT
Platform verifies the update package by using a device. For more information, see Overview.
If the device is updated, it indicates that the verification succeeds. Then, the Batch Update
button becomes available.

6. ClickBatch Update, configure the required update scope and update policy, and then click OK to
push update notifications to devices in batches. For more information, see Overview.

View device logs

AfterloT Platform pushes OTA update notifications, you can view the information about the OTA
update fromthe logs of the devices. The logs include the notifications, processing details, firmware
information, update progress, and reporting time.

e The following log example includes an update notification that is received by a device.
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e The following log example includes the information of a new firmware version. The log example also
includes the details about how a device connects to the download link of the firmware.

OTA target firmware version: 2.0.0@, size: 15025 Bytes

starting download thread in 2 seconds

core_sysdep_network_establish host iotx- -aliyuncs.com port 443, type @

establish tcp connection with server(host="iotx- .aliyuncs.com’, port=[443])

success to establish tcp, fd=4

local port: 58968

[1638984619.566] [LK-1868] |establish mbedtls connection with server(host="io 1liyuncs.com®, port=[443])

[1638984619.622] [LK-1888] |success to establish mbedtls connection, (cest 47168 bytes in total, max used 49856 bytes)

[1638984619.62: = > GET /ota/bl 9.bin2Expires=16 780SSAccessKeyId=LT]
[16308984619.62: - > Host: iotx- aliyuncs.com

[1630984619.622][ > Accept: text/html, application/xhtmlixml, application/xml;q-0.9, */*;g-0.8

[1630084610.622] [LK-840B] |> Range: bytes-@-

[1630084610.622] [LK-84@B] |> Content-Length: @

[1638984619.622] [LK-848B] >

e The following log example includes the details about how a device downloads a firmware file and
reports the progress.
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[1638984619.

[LK-838A] >
[LK-830A] >
[LK-838A] >
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download @854% done, +8192
[1638984619.
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[LK-838A] > 22 3A 7B 22 73 74 65 78 22 3A 22 35 34 22 2C 22 || ":{"step”:"54","
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T 1/SDevicel

|| esc™:""}}

HTTP/1.1 286 Partial Content

Server: Aliyun0SS

Date: Tue, 87 Sep 2821 83:16:59 GMT
Content-Type: applicationfoctet-stream
Content-Length: 15825

Connection: keep-alive

X-o0ss-request-id: 6136D9AB3731FB36345F2350
Content-Range: bytes 8-15824/15825
Accept-Ranges: bytes

ETag: "9EA5E [~
Last-Modified: Tue, @7 Sep 2821 82:47:82 GMT
X-o0s55-object-type: Normal
x-o0ss-hash-crcedecma: 1317
x-oss-storage-class: Standard

Content-MD5: rweE 1
X-o0ss-server-time: 16

bytes

pub:| fota/device/progress/gl

[/SDevicel

[1638984619.644][LK-8981] digest matched
download 188% done, +6833 bytes

[1638984619.644][LK-83@9] pub:|/ota/device/progress/g

[Lk-838A] > 7B 22 69 64 22 3A 34 2C 28 22 7@ 61 72 61 6D 73|| {"id":4, "params
[LK-@38A] > 22 3A 7B 22 73 74 65 78 22 3A 22 31 3@ 38
[LK-838A] > 22 64 65 73 63 22 3A 22 22 7D 7D

download completed

m I/SDevicel

20 22 78 61 72 61 6D 73 || {"id":2, “params
22 3A 22 3@ 22 2C 22 64 || ":{"step™:"@","d

{"id":3, "params

22 2C|| ":{"step™:"1e@8",
I |ldesc|l:|l|l}-}-
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5.Data forwarding

5.1. Use the Alibaba Cloud big data
platform to create a dashboard to
monitor devices

This topic describes how to integrate loT Platform with the Alibaba Cloud big data platform. This way,
you can use the Alibaba Cloud big data platformto compute and analyze device data, collect the
statistics of devices, and display device datg, statistics, and analysis results in real time.

Prerequisites

e The related Alibaba Cloud services are activated and the required instances and computing resources
are purchased. When you use the Alibaba Cloud big data platformto process the device data of IoT
Platform, you may need to use multiple Alibaba Cloud services, such as ApsarabDB RDS for MySQL and
loT Platform.

e You are familiar with the configuration procedure and usage notes for the Alibaba Cloud services.

Context

e Scenario: Use a DataV dashboard to display the data of the devices of an loT Platform product in
real time.

e Process:
i. IoT Platform collects device data.
ii. IoT Platformforwards device data of a product to DataHub by using the rules engine.

iii. DataHub sends the device data to Realtime Compute for Apache Flink for processing and writes
the processed data to ApsaraDB RDS for MySQL. If the device data does not need to be
processed, you can synchronize the data from DataHub to ApsaraDB RDS for MySQL by using
DataConnector.

iv. DataV uses an ApsaraDB RDS for MySQL database table as a data source and displays device
datainthe database table in real time.

Procedure

1. Create an ApsaraDB RDS for MySQL database to store device data.
For more information, see ApsaraDB RDS for MySQL.
i. Logonto the ApsaraDB RDS console.

ii. OnthelInstances page, clickCreate Instance to purchase an ApsaraDB RDS for MySQL
instance.

@ Note The region where the ApsaraDB RDS for MySQL instance resides must be the
same as the region where your IoT Platform devices and DataHub project reside.

ii. Onthe Instances page, find the purchased instance and clickManage in the Actions column.
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iv.

Vi.

Vii.

viii.

In the left-side navigation pane, click Accounts. On the Accounts page, click Create Account
and configure the parameters.

In the left-side navigation pane, click Databases. On the Databases page, click Create
Database and configure the parameters.

In the left-side navigation pane, click Data Security. On the Data Security page, click Create
Whitelist to configure an IP address whitelist for the ApsaraDB RDS for MySQL instance. For
more information, see Configure an IP address whitelist for an ApsaraDB RDS for MySQL instance.

In the left-side navigation pane, click Basic Information to view the basic information about
the instance.

If you want to synchronize data to DataHub, DataV, or Realtime Compute for Apache Flink, the
instance information is required.

In the top navigation bar of the Basic Information page, clickLog On to Database. Inthe
Login instance dialog box, enter the information about an account to log onto the database.

. Tables are created in the databases. In this example, a database table named mytable is

created. The database table contains two fields. The following table describes the fields.

mytable
Field Type Description
d_data varchar(32) The time.
device_num int The number of active devices.

2. Inthe IoT Platform console, create a product, a device, and a data forwarding rule.

Vi.

Vii.

Logontothe loT Platformconsole.

In the left-side navigation pane, choose Devices > Products. On the Products page, click
Create Product and configure the parameters. For more information, see Create a product.

Afteryou create the product, you can go to the Product Details page of the product and
configure the product based on your business requirements. For example, you can create a
topic category or define a Thing Specification Language (TSL) model. For more information,
see What is a topic? or What is a TSL model?

In the left-side navigation pane, choose Devices > Devices. On the Devices page, click Add
Device and configure the parameters. For more information, see Create a device.

In the left-side navigation pane, choose Rules > Data Forwarding. On the Data Forwarding
page, click Create Rule and configure the parameters.

On the Data Forwarding page, find the rule and click View in the Actions column.
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vii. Inthe Data Processing section of the Data Forwarding Rule page, click Write SQL. Inthe
Write SQL dialog box, write SQL statements for the rule. Then, debug the SQL statements. For
more information, see SQL statements.

Write SQL Statement -

Cmim iy mememm mmpp mm e

SELECT items.temperature.value as temperature, items.humidit
y.value as humidity, deviceName() as deviceName timest

amp() as time
FROM " Devicel/thing/event/property/post”

WHERE

® Field

items.temperature.value as temperature, items.humidity.value as humidi

® Topic
TSL Data Reporting hdl
homeThermostat ¢
Devicel e
thing/event/property/post hd

iX. Inthe Data Forwarding section, click Add Operation. Inthe Add Operation dialog box,
configure the parameters. The operation is used to forward device data to a topic in DataHub.
For more information, see Configure a data forwarding rule.

X. Afterthe configurationis complete, go to the Data Forwarding page. Find the rule and click
Start inthe Actions column to enable the rule.

Afteryou enable the rule, use a simulated device to send a message and check whether the
message can be forwarded to DataHub. On the Device Log page, you can view the logs of the
simulated device. On the DataHub console, you can view the changes in the data size of the shards
of the topic to which device data is forwarded. You can also use the data sampling feature to view
the message content in the shards.

3. Configure a device and connect the device to IoT Platform.

This example shows how to use Link SDK for Java to configure the device. Click Demo SDK for Java to
download the sample code.

Afteryou develop the device SDK, install the device SDK on the physical device. After you power
onthe device and connect the device to IoT Platform, the device can report datato IoT Platform.
loT Platform forwards the data to DataHub by using the rules engine. After Realtime Compute for
Apache Flink processes the data, the processed data is written to ApsaraDB RDS for MySQL.

4. Performatest. After the configuration is complete, the number of active devices is updated in real
time on the dashboard each time a device connects to IoT Platform and sends messages.
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5.2. Push device data to DingTalk
groups

This article describes how to push the data that is submitted by a device to a DingTalk group by using a
data forwarding rule. A thermo-hygrometer is used in this example.

Scenario

Push the data that is submitted by thermo-hygrometers in office rooms to DingT alk chatbots.

Process

e S . Function
loT Platform ) e
—_— —
Rules engine Script
Thermometer Alibaba Cloud DingTalk robot

Step 1: Create a product and a device

1. Logontothe loT Platformconsole.

2. Inthe left-side navigation pane, choose Devices > Products and create a thermo-hygrometer
product. When you create the product, set Node Type to Directly Connected Device.

Use default values for other parameters. For more information, see Create a product.

3. ClickCreate TSL. Onthe Define Feature tab, click Edit Draft. Inthe Def ault Module section,
add customfeatures to the product.

In this example, add the temperature and humidity properties to the product. For more information,
see Add a TSL feature.

4. Inthe left-side navigation pane, choose Devices > Devices . Create a device named TH_sensor
under the product. For more information, see Create a device.

Inthe The devices have been added dialog box, click Learn More to obtain the device
certificate (ProductKey, DeviceName, and DeviceSecret). You must secure the device certificate.
The certificate is a key credential for subsequent communication between the device and loT
Platform.

5. Onthe Devices tab, find the device and click View in the Actions column. The Device Det ails
page appears. Inthe Tag Information section, click Edit to add tags to the device.

In this example, add the following two tags. For more information, see T ags.
Key Value Description

Room 00XS, Floor F, Building X, YY
Town

tag The location of the device.

devicelSN T20180102X The serial number (SN) of the device.
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Step 2: Configure Function Compute

Function Compute is an event-driven, fully managed computing service. The programming languages
that are supported by Function Compute include Java, Node.js, and Python.For more information, see
How to use Function Compute.

1. Specify the webhook URL of a DingTalk chatbot.
i. Log onto DingTalk on your PC.

ii. Inthe DingTalk chat window, clickthe 5 icon. Onthe panel that appears, click Group

Assistant.

ii. ClickAdd Robot, andthenclickthe — icon.

iv. Click Custom, and then click Add.

v. Specify the Chatbot name and Security Settings parameters, select | have read and
accepted { DingTalk Custom Robot Service Terms of Service)) , and then click Finished.

vi. Click Copy to save the webhook URL on your PC.

2. Write a Function Compute script.

In this example, the Node.js runtime environment is used. The function obtains device data from loT
Platform, processes the data based on the specified DingT alk message format, and then sends the
data the webhook URL of the specified DingT alk chatbot by using the HTTPS POST method. The
device data includes the device location, device SN, real-time temperature and humidity data, and
the time when the device submits the data to loT Platform.

After you write the script, name the script file as index.js, and then compress it into the index.zjp
file. The following sample code can be used.

You must replace accessToken with the value of the access_token parameter in the webhook URL.
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const https = require('https');
const accessToken = 'Specify the value of the access token parameter in the webhook URL

module.exports.handler = function(event, context, callback) {
var eventJson = JSON.parse (event.toString());

// DingTalk message format

const postData = JSON.stringify ({

"msgtype": "markdown",

"markdown": {

"title": "Thermo-hygrometer",

"text": "#### Submit data\n" +

"> Device location: " + eventJson.tag + "\n\n" +

"> Device SN: " + eventdson.isn+ "\n\n" +

"> Temperature: " + eventJson.temperature + "°C\n\n" +
"> Humidity: " + eventJson.humidity + "%\n\n" +

"> ##444# " + eventJson.time + " published by [IoT Platform] (https://www.aliyun.com/pro
duct/iot) \n"

by

"at": |

"isAtAll": false

}

}) i

const options = {

hostname: 'oapi.dingtalk.com',

port: 443,

path: '/robot/send?access token=' + accessToken,
method: 'POST',

headers: {

'Content-Type': 'application/json',
'Content-Length': Buffer.bytelength (postData)
}

}i

const req = https.request (options, (res) => {
res.setEncoding ('utf8');

res.on('data', (chunk) => {});

res.on('end', () => {

callback(null, 'success');

1) i

17

// Return an error.

reqg.on('error', (e) => {

callback (e) ;

}) i

// Write the data.

req.write (postData) ;

reqg.end () ;

bi

3. Create a service and a function.

i. Forinformation about how to activate Alibaba Cloud Function Compute, see Activate Function
Compute.

i. Logontothe Function Compute console. Inthe left-side navigation pane, click Services and
Functions.
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iii. ClickCreate Service, set Service Name to /oT_Service, and then click Submit.
iv. Onthe Services tab, find loT_Service and click Create Function.
v. Move the pointer over Event Function and click Configure and Deploy.

vi. Set the parameters of the function. Use the default values for other parameters, and then

click Create.
Parameter Description
Function Name Enter pushData2DingTalk.
Select Node.JS 6.x and set Upload Code to Upload Zip File. Click
Runtime Upload Code next to Upload Zip File and upload the /index.zjp file that is

created in Step 2.

Step 3: Forward data to Function Compute

Configure a data forwarding rule to forward the temperature and humidity data submitted by the
TH_sensor device to the pushData2DingT alk function.

1.

Logonto the loT Platform console.ln the left-side navigation pane, choose Rules > Data
Forwarding . On the Data Forwarding page, click Create Rule. Set the parameters and click OK.

. Onthe Data Forwarding Rule page, click Write SQL to edit an SQL statement.

In this example, specify the following fields to filter data:
o The fields that indicate the device information: deviceName, tag, and devicelSN.

o The fields that indicate the submitted payloads: temperature, and humidity.

The following script shows the sample SQL statement:

SELECT

deviceName () as deviceName,

attribute('tag') as tag, attribute('deviceISN') as isn,
items.temperature.value as temperature, items.humidity.value as humidity,
timestamp ('yyyy-MM-dd HH:mm:ss') as time

FROM

"/g5j30***/TH sensorthing/event/property/post"

3. Onthe Data Forwarding Rule page, click Add Operation to forward data to Function Compute.

In this example, select the created IoT_Service service and pushData2DingT alk function. For
more information, see Forward data to Function Compute.

4. Onthe Data Forwarding page, find the rule and click Start in the Actions column to enable the rule.

Step 4: Connect the thermo-hygrometer device to IoT Platform and

submit temperature and humidity data

Connect the device to loT Platform over MQTT by using the device certificate. Then, simulate the
submission of temperature and humidity data.

1.

Download and install Node.js on the Windows or Linux operating system. In this example, the
Windows operating system s used.

node --version

2. Create aJavaScript file such as iot_device.js on your PCto store the Node.js sample code.
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The following Node.js sample code can be used:

const mgtt = require('aliyun-iot-mgtt');
// 1. Specify the device identity information
var options = {
productKey: "al***",
deviceName: "TH sensor",
deviceSecret: "9JtvE***",
regionId: 'cn-shanghai'
}i
// 1. Create a connection
const client = mgtt.getAliyunIotMgttClient (options) ;
// 2. Configure a listener to receive downstream commands
client.subscribe (" /${options.productKey}/${options.deviceName}/user/get")
client.on ('message', function (topic, message) {
console.log ("topic " + topic)
console.log("message " + message)
b
setInterval (function () {
// 3.Submit data
client.publish (" /sys/${options.productKey}/${options.deviceName}/thing/event/proper
ty/post’, getPostData(), { gos: 0 });
}, 6 * 1000);
function getPostData () {
const payloadJdson = {
id: Date.now (),
version: "1.0",
params: {
Temperature: Math.floor ((Math.random() * 20) + 10),
Humidity: Math.floor ((Math.random() * 20) + 10)
3y
method: "thing.event.property.post"
}
console.log ("payloaddson " + JSON.stringify (payloadJdson))
return JSON.stringify (payloadJdson) ;

Parameter Example Description

The ProductKey of the product to which the
device belongs. You can view the ProductKey on
the Device Details page of the IoT Platform
console.

productKey a1

The DeviceName of the device. You can view the
deviceName TH_sensor DeviceName on the Device Details page of the loT
Platform console.

The DeviceSecret of the device. You can view the
deviceSecret 9JtvE*** DeviceSecret on the Device Details page of the loT
Platform console.
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Parameter Example Description

The ID of the region where the MQTT device
regionlid cn-shanghai resides. For more information about region IDs,
see Regions and zones.

3. Openthe command-Lline interface and runthe c<ca command to go to the directory where the
iot_device.js file resides. In this directory, run the NPM command to download the aliyun-iot-mqtt
library.

npm install aliyun-iot-mgtt -S
The following figure shows the downloaded library file.

node_modules
(2] iot_device
| package-lock.json 2020/

4. Inthe command-line interface, enter the following command to run the iot_device.js file. T his way,
the device is enabled and data is submitted.

node iot device.js

Result

The following figure shows the result.

The following figure shows the message that is received by the DingTalk chatbot.

@ Temperature and humidity details

Location
Device SN T20180102XnbKjmc
Temperature: 18 C
Humidity 63%
lot Platform
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